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must not be misrepresented as being the original software. (3) The following notice may not be removed or 
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(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the 
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of 
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distribution. (3) Neither the component name nor the names of the copyright holders and contributors may be 
used to endorse or promote products derived from the software without specific prior written permission.
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Copyright© 1995-2006 Sun Microsystems, Inc. All Rights Reserved.

Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the 
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the disclaimer below in the documentation and/or other materials provided with the 
distribution. (3) Neither the component name nor the name of Sun Microsystems, Inc. and contributors may 
be used to endorse or promote products derived from the software without specific prior written permission. 
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NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. (“SUN”) AND ITS 
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IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT 
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PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF 
LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF 
SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

License: Tom Wu

Module: jsbn library

Copyright © 2003-2005 Tom Wu. All rights reserved

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the 
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the disclaimer below in the documentation and/or other materials provided with the 
distribution.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, 
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL TOM 
WU BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES 
OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY 
THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE.
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Chapter 1
Overview

This chapter provides an overview of the web-enabled Oracle Utilities Billing Component 
application (Oracle Utilities Billing Component Web), including:

• What is Oracle Utilities Billing Component?

• The Billing Process

• How Do You Work with Oracle Utilities Billing Component?

• What is this book?

• International and Multiple Currency Support

• Oracle Utilities Billing Component Components and Documentation
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What is Oracle Utilities Billing Component?
Oracle Utilities Billing Component provides access to Oracle Utilities Billing Component 
functionality via an Intranet/Internet using Microsoft Internet Explorer. Because all Oracle 
Utilities web applications share a common framework, users can switch between different Oracle 
Utilities web applications (such as the Oracle Utilities Quotations Management and Oracle 
Utilities Meter Data Management) without having to open multiple applications.

Oracle Utilities Billing Component provides functionality in four primary areas:

• Billing

• Contract Management

• Receivables Management

• Workflow Management

Billing
The billing functionality of Oracle Utilities Billing Component allows users to process billing 
calculations and run billing-related reports for customer and accounts. SeeThe Billing Process 
on page 1-3 for more information about billing using Oracle Utilities Billing Component. The 
billing functionality of Oracle Utilities Billing Component is described in more detail in Part One: 
Billing.

Contract Management
The contract management functionality of Oracle Utilities Billing Component allows users to 
create and maintain contracts with accounts. These contracts can define the terms, prices, and 
other data used in billing calculations and other operations. The contract management 
functionality of Oracle Utilities Billing Component is described in Part Two: Contract 
Management.

Receivables Management
The receivables management functionality of Oracle Utilities Billing Component (also referred to 
as Oracle Utilities Receivables Component) extends the billing functionality to include tracking of 
financial transactions related to billing. Specific receivables management functionality includes 
tracking charges and maintaining accounts receivables for accounts, receiving and tracking 
payments against those charges, handling adjustments, rolling up financial transactions to 
corporate general ledger accounts, and collections processing. The receivables management 
functionality of Oracle Utilities Billing Component is described in Part Three: Receivables 
Management - Oracle Utilities Receivables Component.

Workflow Management
The workflow management functionality of Oracle Utilities Billing Component (also referred to as 
Workflow Management) provides the ability to create and run processes (defined as a series of 
activities performed in a predetermined sequence relating to a specific operation). Workflow 
Management is used specifically to process collections activities for customers that are overdue on 
their payments. The workflow management functionality of Oracle Utilities Billing Component is 
described in Part Four: Workflow Management.
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The Billing Process
The primary function of Oracle Utilities Billing Component is to calculate customer charges, 
regardless of their complexity, and pass the results to either a CIS system that issues and records 
the actual bills, or to a stand-alone billing system.

While the specifics will vary at your facility, depending upon your goals, policies, and the types of 
hardware and software with which the system must interface, a typical billing process with Oracle 
Utilities Billing Component runs something like this.

Each business day, usage data is collected for a portion of your power billing customers. The 
customers are grouped according to billing cycles or specific bill dates. The bill date is noted in the 
Billing Cycles table in the Oracle Utilities Data Repository and used as a “trigger” for initiating the 
billing process.

There are two types of usage data that can be used to measure and bill a customer’s energy 
consumption:

• Billing determinants: A billing determinant is typically a scalar measure of a customer’s 
electricity or gas consumption that is represented by one value for a given bill period—for 
example, a customer might have used a total of 230 kWh of energy during a given month, and 
its highest demand during that month might have been 10 kW. Both 230 kWh and 10 kW are 
potentially scalar values for bill determinants that could be used to calculate the customer’s 
bill for April.

• Interval data: Interval data (also called “time-series data”) measures a quantity such as 
demand, energy, voltage, or temperature at regular intervals — such as every 5, 10, 15, or 60 
minutes. So, rather than having just one value for a determinant for given period, there can be 
many values. For example, a 31-day month of 15-minute interval data consists of 2,976 values. 
Interval data is important because it can measure the demand that the customer places on the 
system at any given moment — and therefore provides a much more accurate picture of how 
much it actually costs to serve the customer.

Interval data is recorded at a customer’s location by a special interval data recorder, which 
has one or more data recording channels. The utility assigns each channel to measure a 
different end use or other quantity of interest. A record that contains the interval values for 
one recorder-channel for one recording period is called a cut. The end of a cut is its read date 
and time; its beginning is the end of the previous cut. The boundaries of a cut are also 
referred to as the cut’s start-date and -time, and stop-date and -time. Cuts for the same 
account but from different recorders may have different stop dates and times, and the periods 
covered by the cuts may or may not correspond to the dates of the bill period. However, once 
set up properly, Oracle Utilities Billing Component automatically determines the correct 
interval values and if they are available, synchronizes them to the bill period.

A customer may be billed using just interval data, or just billing determinants, or a combination of 
both, depending upon its rate code or contract with the utility.

Every time billing is triggered, Oracle Utilities Billing Component checks the Oracle Utilities Data 
Repository for accounts that are ready to be billed. The system uses the following criteria for 
“billable” accounts:

• First, Oracle Utilities Billing Component gathers a list of all accounts that are eligible for 
billing. An account is “eligible” if the scheduled read date falls within a user-defined window 
of time that extends some number of days before and after the account's scheduled read date. 
An account’s scheduled meter read date is specified by the Billing Cycle date in its Account 
History record in the Oracle Utilities Data Repository. The default time window is defined 
using the “Prewindow” and “Postwindow” settings in Oracle Utilities Billing Component 
Default Billing Options. It is also possible to specify the size of the Prewindow and 
Postwindow for rate codes or even individual accounts or recorders in the Oracle Utilities 
Data Repository.
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• If an account is deemed eligible, Oracle Utilities Billing Component then determines whether 
or not it is available. An account is “available” if all data required to compute its bill for the 
current bill period is ready. Oracle Utilities Billing Component checks for three types of data 
— bill determinant values, interval data, and special events values and dates.

• Bill Determinants: Oracle Utilities Billing Component checks the account’s Bill 
Determinant Use record(s) to find which, if any, bill determinants are required for computing 
the bill. For each bill determinant that is required, Oracle Utilities Billing Component looks in 
the account’s Bill History record for a value for the current scheduled read date.

• Interval Data: Oracle Utilities Billing Component also checks each account’s Channel 
History records to find whether any recorder-channels assigned to measure interval data for 
the account are to be used for billing. For each channel assigned to measure billable interval 
data, Oracle Utilities Billing Component looks for a cut with a stop-date and stop-time that 
falls within the corresponding recorder’s eligibility window around the scheduled read date.

• Special Events: An account may have agreed with the utility to pay a different rate for the 
energy that it consumes during a “special event” — for example, a standby period, 
maintenance period, system peak, and so on. For every eligible account, Oracle Utilities 
Billing Component checks its Account Override Use records in the Oracle Utilities Data 
Repository to determine whether the account might be subject to any special events pricing. 
If any special events are potentially applicable to the account and require validation, Oracle 
Utilities Billing Component checks the account’s Override Ready record to ensure that a 
Billing Analyst has input the actual dates and values for each event that did occur during the 
bill period, or (alternatively) specified that no events occurred.

If Oracle Utilities Billing Component finds that any required data is still missing for an eligible 
account on the day after the post-window, the system puts a “system rejected” note in the 
account’s Account Note record in the Oracle Utilities Data Repository. Nothing further happens 
until a billing analyst reviews and corrects the problems.

If all the data required to bill an account is ready, Oracle Utilities Billing Component calculates the 
bill. The system first finds the applicable rate schedule (associated with the account via the rate 
code stored in the Account Rate Code History record). The system then calculates the account’s 
charges for the bill period by applying the appropriate tariffs (encoded in rate forms using the 
Oracle Utilities Rules Language) and any special event overrides to the account’s usage data.

After Oracle Utilities Billing Component calculates the charges, it writes the results to a file that 
has a user-specified name and location. As Oracle Utilities Billing Component continues to 
process bills for customers, it appends each new “transaction record” to the end of the file. 
Periodically, this file can be processed by other applications. Typically when this happens, the file is 
renamed. When Oracle Utilities Billing Component finds that the file it had been using no longer 
exists, it creates a new one with the original name, and resumes writing transaction records to it.

If specified in the rate form, Oracle Utilities Billing Component also saves the data to the Oracle 
Utilities Data Repository.

Important Note
Before you can use this versions of Oracle Utilities Billing Component, you must ensure that 
appropriate data and records have been created in the Oracle Utilities Data Repository. The 
instructions in this user guide assume that these records exist. For more information about 
creating, updating, or editing records, see the Data Manager User’s Guide.
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How Do You Work with Oracle Utilities Billing Component?
Much of the billing process can occur automatically without user intervention. However, to ensure 
that bills are produced accurately and on time, and to accommodate the unique needs of special 
customers, Oracle Utilities Billing Component requires some manual data entry and monitoring, 
and allows for customer’s whose bills require manual review.

The following describes the tasks that billing analysts would typically perform every day with 
Oracle Utilities Billing Component:

Review Billing Checklist
As described in the previous section, Oracle Utilities Billing Component requires three sets of 
values that change from month to month to determine a bill—interval data, bill determinant 
values, and special events times and values. Since accurate data does not always come from the 
field as expected, it is recommended that you make it a part of your daily routine to apply Oracle 
Utilities Billing Component’s Billing Checklist module to one day’s set of eligible accounts. This 
report pinpoints any problems with the required data, such as a missing or incomplete cut. To 
ensure that bills are produced on time, you should apply the checklists one or two days prior to the 
accounts’ actual bill date. In that way, you have some time to correct any problems before the bills 
are due to be issued. See Billing Checklist on page 10-2 for more information.

Enter Special Events
 Required. As described earlier, Oracle Utilities Billing Component computes billing charges by 
applying the tariffs encoded in rate forms (using the Oracle Utilities Rules Language) to the 
customer’s usage data. There can be circumstances (e.g., “special events”) when other billing rules 
and values should override the standard tariffs. Before Oracle Utilities Billing Component can 
calculate an account’s charges for a bill period, a billing analyst must manually enter the dates and 
values for each special event that applied to the account during the bill period. Even if no special 
events took place, the billing analyst must still make a note to that effect in the account’s Override 
Ready record. Chapter 6: Setting Up and Applying Overrides and Special Events in the Oracle 
Utilities Billing Component Installation and Configuration Guide, Volume 1 explains how to define a special 
event in the Oracle Utilities Data Repository, and how to add the actual dates and values for each 
occurrence.

Process Customer/Account Bills
Oracle Utilities Billing Component offers several different ways of processing customer/account 
bills. Each is briefly described below.

Automatic Billing
Some accounts and customers can be billed in “automatic” mode, meaning that once Automatic 
Billing is activated, the program scans the database for these accounts and determines if they are 
“ready” to be billed (see The Billing Process on page 1-3). Accounts that are ready to be billed 
are processed automatically, and if billing is successful, their transaction records are automatically 
written to the CIS file. See Chapter 6: Automatic Billing for more information.

Note: In most cases, Automatic Billing is configured to run on a scheduled 
basis on either a dedicated machine or an application server.

Approval Required
In some cases (such as accounts that have especially complex tariffs or other special needs) it may 
be advisable for a Billing Analyst to review the results of the successful bill calculations before the 
transactions records are passed to the output file. These accounts are flagged “Approval Required” 
and are processed using Approval Required billing.
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Approval Required billing applies the same concepts of “eligible” and “available” and performs 
the calculations according to the Billing Cycle schedule as described in The Billing Process on 
page 1-3. However, unlike Automatic Billing which runs continuously without user intervention, 
you must explicitly start Approval Required billing. Also, it does not automatically write the 
transaction records or update the Bill History records when the calculations are complete. Instead, 
Oracle Utilities Billing Component displays an on-screen bill report that enables you to review the 
calculations and accept or reject the results. When you’ve approved the bills they are passed to the 
output file and updated in the Bill History records. See Chapter 5: Approval Required Billing 
for more information.

 Current/Final Bill
Current/Final Bill gives you greater flexibility in the billing process by allowing you to override 
some of the rules built into the automatic and approval required modes. Specifically, you can issue 
a bill:

• on-demand — that is, on a date other than its normal, automatic issue date (billing cycle 
date). This is particularly useful for creating preliminary bills for a customer’s approval prior 
to issuing the actual bill.

• despite missing data.

• for a user-specified period of time.

You can also specify that a bill is a final bill—in which case Oracle Utilities Billing Component 
automatically writes a stop date to the Account Table in the Oracle Utilities Data Repository when 
the bill is approved. This effectively closes the account as far as Oracle Utilities Billing Component 
is concerned. See Chapter 9: Trial Calculation for more information.

Bill Correction
In case a billing analyst or customer finds a problem with a previously-issued bill, this feature 
enables you either to cancel the old bill and issue a new one in its place, or to address the problem 
by adjusting the current bill. See Chapter 7: Bill Corrections for more information.

Late Bills
This report tracks interest lost on bills that were issued late, or are pending and will be late. See 
Late Billing on page 10-10 for more information.

Mass Billing
This allows you to process bills for accounts that are eligible for mass billing. See Mass Billing on 
page 8-18 in the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 1 for 
more information.

Review Billing Exceptions
Each day, a billing analyst should run the Billing Exceptions and Rejections report to verify that all 
accounts (in particular “automatic” accounts) processed as expected. This report lists any 
accounts that were not billed, and why. See Billing Exceptions on page 10-5 for more 
information.

Reports
In addition to the various billing modules, Oracle Utilities Billing Component features several 
reports that you can use to examine billing data in the Oracle Utilities Data Repository. They 
include the Special Events, Bill History, Late Billing, Top Accounts, and Rider Summary reports, 
as well as other reports customized for your utility. See Chapter 10: Billing Reports for more 
information.
1-6 Billing Component User’s Guide



What is this book?
What is this book?
The Oracle Utilities Billing Component Web User’s Guide describes the functionality of Oracle Utilities 
Billing Component, including the following:

• Chapter 1: Overview provides an overview of the Oracle Utilities Billing Component web 
application and the documentation provided with it.

• Chapter 2: Working with the Oracle Utilities Energy Information Platform describes 
how users work with the Energy Information Platform web interface, including information 
about general navigation, common controls, and running and viewing reports.

• Chapter 3: Viewing Billing Data describes how users view account-related billing data.

• Chapter 4: General, Billing, and Report Options describes how users view and set 
general, billing, and report options used with Oracle Utilities Billing Component.

• Chapter 5: Approval Required Billing describes how to process billing in approval required 
mode.

• Chapter 6: Automatic Billing describes how to process billing in automatic mode.

• Chapter 7: Bill Corrections describes how to process bill corrections.

• Chapter 8: Current/Final Bill describes how to process current and/or final bills.

• Chapter 9: Trial Calculation describes how to process trial bills.

• Chapter 10: Billing Reports describes how to run and view the results of a number of 
billing reports.

• Chapter 11: Contract Management Overview provides an overview of the contract 
management functionality of Oracle Utilities Billing Component.

• Chapter 12: Setting Up Contract Terms, Contract Products, and Contract Types 
describes how to set up contract type, contract products, and contract terms for use with the 
contract management functionality of Oracle Utilities Billing Component.

• Chapter 13: Working with Contracts describes how to create and maintain contracts for use 
with the contract management functionality of Oracle Utilities Billing Component.

• Chapter 14: Oracle Utilities Receivables Component Overview provides an overview of 
the receivables management functionality of Oracle Utilities Billing Component.

• Chapter 15: Viewing Financial and Collections Data describes how users view account-
based financial and collections data related to the receivables management functionality of 
Oracle Utilities Billing Component.

• Chapter 16: Managing Financial Transactions with Oracle Utilities Receivables 
Component describes how to work with financial transactions using Oracle Utilities 
Receivables Component.

• Chapter 17: Receivables Management Work Queues describes how the work queues 
functionality of Oracle Utilities Receivables Component.

• Chapter 18: Receivables Management Controls describes how to view control data used 
by Oracle Utilities Receivables Component.

• Chapter 19: Collections describes how to work with the collections functionality of Oracle 
Utilities Receivables Component.

• Chapter 20: Viewing Oracle Utilities Receivables Component Reports describes how to 
run and view Oracle Utilities Receivables Component reports.

• Chapter 21: Oracle Utilities Billing Component - Workflow Management Overview 
provides an overview of the workflow management functionality of Oracle Utilities Billing 
Component.
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• Chapter 22: Working with Workflow Management describes in general terms how users 
work with the workflow management functionality of Oracle Utilities Billing Component.

• Chapter 23: Workflow Activity Implementations describes how to create and maintain 
activity implementations used by the workflow management functionality of Oracle Utilities 
Billing Component.

• Chapter 24: Workflow Processes and Process Versions describes how to create and 
maintain processes and process versions used by the workflow management functionality of 
Oracle Utilities Billing Component.

• Chapter 25: Workflow Process Activities describes how to create and maintain process 
activities used by the workflow management functionality of Oracle Utilities Billing 
Component

• Chapter 26: Workflow Management Work Queues describes the work queue functionality 
of the Workflow Management.

• Chapter 27: Workflow Management Process Controls describes the process control 
functionality of the Workflow Management.
1-8 Billing Component User’s Guide



International and Multiple Currency Support
International and Multiple Currency Support
This section outlines international and multiple currency support in the Oracle Utilities Energy 
Information Platform, including:

• Locales and Languages

• Date and Numeric Presentation

• Currency Presentation

• Multiple Currency Support

• File Formats

• Database Support

Locales and Languages
Two fundamental concepts underlying international support in Oracle Utilities applications are 
languages and locales. Languages determine the specific language in which text labels and 
controls of an application appear. Locales determine the specific region or country in which the 
user is working. Specifically, locales are used to specify display and input formatting for:

• Date/time and numeric presentation, and

• Currency presentation

How a user selects a language and/or locale is determined by the type of application being used.

Web-enabled Products
For web-enabled products, a user’s locale and language are selected from the Locales tab of the 
Set Preferences screen. The selected locale and language are stored in the user’s security 
properties. The available locales on this screen are specified in the LOCALES.CFG.XML 
configuration file (see Chapter 2: Configuration Files in the Oracle Utilities Energy Information 
Platform Configuration Guide for more information). Locales included in the LOCALES.CFG.XML 
file must also be installed on the web server and be accessible from the Regional Settings Control 
Panel. If a selected locale is not installed on the web server, currency formatting and presentation 
may be incorrect.

If a user does not select a locale (or selects a locale of “None”), the default locale is the Server 
System Locale (defined by the operating system installed on the web server). Oracle Utilities 
recommends that all users specify a locale before using internationalized applications.

Client/Server Products
For client/server products, the user’s locale is determined by the Regional Settings of the client 
and/or application server machine.

Languages
The language for client/server products is specified using a command line switch and/or a 
parameter in the LODESTAR.CFG file. See Oracle Utilities Application Command Line 
Parameters on page 4-11 in the Oracle Utilities Energy Information Platform Installation Guide for more 
information about command line parameters. See LODESTAR.CFG on page 2-2 in the Oracle 
Utilities Energy Information Platform Configuration Guide for more information about the 
LODESTAR.CFG file. At this time, available languages include English, French, German, and 
Italian.
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Reports
For client/server applications, the locale for reports is determined by the Regional Settings of the 
machine on which the report is run.

For web-enabled applications, the locale for reports is based on the Server System Locale (defined 
by the operating system installed on the web server)

Languages
For client/server applications, the language that appears on reports is determined by the language 
of the application that generated the report, specified either by a command line parameter or a 
configuration file parameter.

For web-enabled applications, the language is specified by the Regional Settings  of the machine 
on which the report is run, unless overridden by the LANGUAGE parameter in the 
LODESTAR.CFG file.

Date and Numeric Presentation
The display and input of dates and numbers is based on the selected locale.

Web-enabled products
Display formatting of both numbers and date/times is based on the user's selected locale.

Copy, cut, and paste operations are supported for all input controls. Required fields are identified 
by asterisks. Null values are represented by blank (empty) controls. Moving the mouse pointer 
over an input area displays sample formatting for that field.

Number input controls only accept formatting based on the user's selected locale. The only 
allowable characters include digits, decimal separator, and minus sign. Any other characters are 
filtered from input.

Date input controls only accept formatting based on the user's selected locale. Dates can either be 
keyed in or selected from a pop-up calendar control. All times are keyed in and based on 24 hour 
format (no AM or PM indicator).

Input validation occurs upon data entry.

Client/Server Products
Formatting for numbers and date/times is based on the locale determined by the regional settings 
of the client and/or application server machine. Date/time formatting can be overridden from the 
General Options tab of the Default Options dialog.

Reports
Display formatting of both numbers and date/times for reports is based on the Server System 
Locale on the machine on which the reports are run.

Currency Presentation
Currency information is stored in the LSCurrency table in the Oracle Utilities Data Repository. 
This table contains one or more currencies, each defined by a currency code, currency symbol, and 
formatting rules (such as the number of decimal places). Currency codes in this table use ISO-
4217 codes. The LSCurrency table also indicates the Default currency for the database. See 
LSCurrency on page 3-3 in the Oracle Utilities Energy Information Platform Configuration Guide for 
more information about setting up the LSCurrency table.

Note: Although records in the LSCurrency table are not required, Oracle Utilities strongly 
recommends that at least one record with all properties specified be created and set as “Default”. 
This will ensure consistent display of currency information.
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Currency Presentation in Oracle Utilities Receivables Component and Oracle 
Utilities Quotations Management

Currency input and display is identical to that for numbers with two exceptions: 

• A currency indicator is also displayed next to currency input controls and currency displays. 
The specific currency symbol displayed and the manner in which currency is formatted are 
determined in the following order:

a. The currency associated with the account being viewed (from the LSCurrency field in 
the Account table).

b. The default currency in the LSCurrency table. If there is no default currency, the first 
record in the LSCurrency table (sorted alpha-numerically by Currency Code).

b. If the LSCurrency table is not present or does not contain any records, the currency and 
formatting of the Server System Locale (defined by the operating system installed on the 
web server),specified in the HKEY_USERS\.DEFAULT\Control 
Panel\International key in the Windows Registry on the web server.

• Currency formatting rules for the user's selected locale are overridden if specific formatting 
rules for the currency are stored in the LSCurrency table. Typically, the only formatting rules 
that would be overridden at the currency level would be the ISO code, symbol, and number 
of decimal places. This applies to Oracle Utilities Receivables Component reports as well, 
except that the initial locale formatting rules come from the regional settings of the machine 
on which the report is run.

Currency Presentation in Other Web-enabled Products
Currently, other web-enabled products do not require input of currency values.

Display of currencies is based on the formatting of the selected locale and of the default currency 
in the database (currency specific formatting always overrides locale specific formatting).

Enabling Display of International Currency Symbols
Display of international currency symbols requires the appropriate Encoding option is selected on 
Internet Explorer.

How to select encoding options:

1. Select View-›Encoding from the Internet Explorer menu bar.

2. Select the appropriate option from the list. For example, to enable displaying of the Euro 
symbol and other Western European currency symbols, select the Western European 
(Windows) option.

Currency Presentation in Client/Server Products
Client/server products do not require input of currency values.

Display of currencies is based on the formatting of the client machine's regional settings and of 
the default currency in the database. Currency specific formatting always overrides locale specific 
formatting. If the default currency in the database does not specify any formatting, the currency 
symbol is used for formatting. If the currency table does not exist or does not contain any records 
then the default currency is determined by the Regional Settings on the client/server machine. 
This applies to reports as well.
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Multiple Currency Support
Multiple Currency Support allows for accounts with different associated currencies. This is 
accomplished through the presence of the Currency Code column on the Account, Journal 
Account, and Checking Account tables in the Oracle Utilities Data Repository. This column 
references records in the LSCurrency table

Multiple Currency and Oracle Utilities Receivables Component
All input screens which have amount fields on them indicate what currency type is expected as 
input.

All elements that represent a currency in Oracle Utilities Receivables Component XML structures 
have a CURRENCY attribute that indicates the corresponding currency type for the amount. The 
string values used for this attribute are the same as the Currency Code values in the LSCurrency 
table. On output, the CURRENCY attribute is set for the account as specified in the database. If 
the account's currency type is not specified in the database, the default currency is used.

A CURRENCY attribute (using the standard stem.tail notation) is supported for Oracle Utilities 
Receivables Component transaction identifiers to specify the currency type for the account.

On input, the CURRENCY attribute of all Oracle Utilities Receivables Component transactions is 
checked against the currency value of the account against which the transaction is being posted 
using the following rules:

1. If a currency type is specified for the account in the database, the transaction must indicate 
the same currency type or it is an error.

2. If a currency type is not specified for the account in the database, the transaction must 
indicate either no specific currency type or the default currency type for the database or it is 
an error.

All transactions that involve two or more accounts (such as Payment and Balance Transfers) 
validate that the currency types are the same for each account (no currency translation will occur). 
The credit/debit account pairs for each journal translation record are validated to ensure that they 
both have the same currency type. Only journal translation records that have credit/debit 
accounts with the same currency type as the account against which the transaction is being posted 
are used. Additional currency validations occur for payment files and refund checks.

Multiple Currency and Oracle Utilities Receivables Component Reports
Where applicable, Oracle Utilities Receivables Component reports are grouped by Currency Code.

Multiple Currency and Other Oracle Utilities Products
Oracle Utilities Billing Component, Oracle Utilities Rate Management and Data Manager reports 
display the Currency Code associated with each account where applicable. Reports that contain 
multiple currency types do not include the Summary Results page.

In Oracle Utilities Rate Management - Revenue Forecasting, the default currency type is used for 
all presentation of currency amounts, regardless of whether or not a specific currency has been 
indicated in the database for any accounts.
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File Formats

Input/Output File Formats
Numbers and date/times in input and output files (such as files used with the PLIMPORT 
program) are independent from locale settings.

Non-English characters are supported in input/output files.

XML Formats
All dates, times, and numbers contained in XML files are represented using the standard 
formatting rules as defined by the W3C XML Schema Recommendation. For backward 
compatibility, previously accepted formats for dates and times will continue to be accepted on 
input, however, all output will use the XML Schema representation.

Note: XML files created by the SAVE TO XML Rules Language statement are  
an exception. The date, time, and number formats in Rules Language generated 
XML files are based on the Rules Language configuration used to create them.

Non-English characters are supported in XML files

Database Support
In addition to the LSCurrency table and related columns in the Account, Journal Account, and 
Checking Account tables, database support for internationalization includes the addition of the 
COUNTRY column in the Address table and the change from ZIP Code to Postal Code on user 
interfaces.
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Oracle Utilities Billing Component Components and Documenta-
tion

Oracle Utilities Billing Component Web comprises the following application components and 
documentation.

Oracle Utilities Billing Component Web
This is the web-enabled Oracle Utilities Billing Component application.

The Oracle Utilities Billing Component Web User’s Guide (this book) describes how to use this 
application.

The Oracle Utilities Billing Component Installation and Configuration Guide, Volume 1 describes how to 
install and configure Oracle Utilities Billing Component, including database installation, setting up 
database records, setting up billing to run in batch mode, and configuration of contract 
management functionality.

The Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2 describes how to 
configure Oracle Utilities Receivables Component and Workflow Management, including setting 
up database records, other configuration tasks.

Oracle Utilities Energy Information Platform
The Oracle Utilities Energy Information Platform is the name of the features and functions 
shared by Oracle Utilities applications including Oracle Utilities Billing Component, Oracle 
Utilities Meter Data Management, Oracle Utilities Quotations Management, and others.

The Oracle Utilities Energy Information Platform User’s Guide contains describes how you work with the 
Oracle Utilities Energy Information Platform web -user interface.

Data Manager
Data Manager is the tool you use to view, edit, and update records in the Oracle Utilities Data 
Repository.

The Data Manager User’s Guide explains how to use Data Manager to view and maintain data in the 
Oracle Utilities Data Repository. 

Oracle Utilities Rules Language
The Oracle Utilities Rules Language is a powerful command language that defines business rules 
and specific items such as rate tariffs.

The Oracle Utilities Rules Language User’s Guide and Oracle Utilities Rules Language Reference Guide 
describe the Oracle Utilities Rules Language and how it is used with Oracle Utilities products.

Oracle Utilities Energy Information Platform Installation Guide
The Oracle Utilities Energy Information Platform Installation Guide contains installation information 
related to the Oracle Utilities Energy Information Platform.

Oracle Utilities Energy Information Platform Configuration Guide
The Oracle Utilities Energy Information Platform Configuration Guide contains configuration and system 
administration information related to the Oracle Utilities Energy Information Platform.
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Chapter 2
Working with the Oracle Utilities Energy

Information Platform

This chapter describes how you work with the Oracle Utilities Energy Information Platform 
applications. This includes:

• Starting the Application and Logging In

• Navigating the Oracle Utilities Energy Information Platform

• Searching, Viewing, and Entering Data in the Oracle Utilities Energy Information 
Platform

• Run Reports

• View Reports
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Starting the Application and Logging In

You log on to Energy Information Platform using Microsoft Internet Explorer.

How to log in:

1. Start the application by double-clicking the shortcut icon, or entering the URL for the Oracle 
Utilities Energy Information Platform in the Address field on the Internet Explorer window.

Note: Contact your system administrator for the URL for the Oracle Utilities Energy 
Information Platform.

2. The Login screen appears.

3. Enter your user ID in the User ID field, enter your password in the Password field, and click 
Login. The Energy Information Platform home dashboard screen appears in the browser.
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Navigating the Oracle Utilities Energy Information Platform
This section describes the framework of the Oracle Utilities Energy Information Platform and 
how to use the menus and icons to navigate between functions including:

• Framework

• Menus

• Navigation

Framework
The Energy Information Platform is a web-based framework, consisting of the Top menu, the 
Left menu, and the Main Workspace.

Top Menu
The Top menu displays a number of menu items, including:

• Home: Returns the user to the home dashboard screen.

• Help: Expands to display the following:

• Content and Index: Opens Online Help window for the current option or function (if 
applicable).

• Online Support: Opens the Oracle Utilities website in the Main Workspace.

• About: Opens the About dialog, which displays the user’s current preferences and the 
software version installed.

• Logout: Logs the user out of the Energy Information Platform, ends the current session, and 
returns the user to the Login screen.

Left Menu
The Left menu displays menu options available to the user. This menu can be set to one of two 
modes: the Main menu or the Data menu. The bottom of the Left menu displays a number of 
icons. The meanings of these icons are as follows:

Icon Description

Default Menu: Changes the Left menu from the Main Menu to 
the Data Menu.

Default Menu: Changes the Left menu from the Data Menu to 
the Main Menu.

Current Data Base: Opens the Set Preferences screen. When 
you hover the mouse over this icon, a tool tip opens, displaying 
currently selected data source.

Security Administration: Opens the Security Administration 
screen.

Home: Returns the user to the home dashboard screen.

Change Theme: Opens the Change Theme dialog.
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Main Menu
The Main menu opens by default, and lists the functions available from the Energy Information 
Platform. Clicking on a menu item displays the corresponding screen in the Main Workspace on 
the right. A down-pointing arrow at the left of a menu choice indicates that the choice has 
associated submenu items below it. To open the submenu list, click on the arrow. The arrow 
becomes a right-pointing arrow, and the submenu options are displayed below the menu item.

Note: The options that appear on the Main menu are dependent on the 
specific set of products licensed and installed.

Data Menu
The Data menu lists database tables accessible via the Data Navigator, which allows users to 
search, add, view, and edit database records and tables in the Oracle Utilities Data Repository. See 
Chapter 8: Searching and Viewing Data in the Oracle Utilities Data Repository in the Oracle 
Utilities Energy Information Platform User’s Guide for more information about Data Navigator.

Main Workspace
The center of the window is occupied by the Main Workspace, which holds the screen 
corresponding to the selected function.

Menus
As noted above, the Main menu includes a number of submenus, each relating to a specific activity 
or product.Oracle Utilities Billing Component uses the following menus:

Billing Menu
The Billing menu includes the following options:

• Calculations: Expands to display the Calculations menu, which includes the following 
reports:

• Approval Required: Opens the Approval Required Billing screen.

• Automatic Billing: Opens the Automatic Billing screen.

• Bill Correction: Opens the Bill Corrections screen.

• Current/Final Bill: Opens the Current/Final Bill screen.

• Trial Calculation: Opens the Trial Calculation screen.

• Reports: Expands to display the Billing Reports menu, which includes the following 
reports:

• Billing Checklist: Opens the Billing Checklist screen.

• Billing Exceptions: Opens the Billing Exceptions screen.

• Billing History: Opens the Billing History screen.

• Late Billing: Opens the Late Billing screen.

• Rider Summary: Opens the Rider Summary screen.

• Special Events: Opens the Special Events screen.

• Top Accounts: Opens the Top Accounts screen.

• WQ Items: Opens the Work Queue Item Search Result screen displaying open work 
queue items with a Product code of “BE” (Billing).

• My WQ Items: Opens the My Work Queue screen (Groups tab).

• Run Reports: Opens the Run Reports screen, displaying reports associated with Billing 
(Product code “BE”).
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• View Reports: Opens the View Reports screen, listing previously run reports associated 
with Billing (Product code “BE”).

Contracts Menu
The Contracts menu includes the following options:

• Contracts: Opens Contracts screen, from which users can search and add contracts.

• Contract Setup: expands to display the following options.

• Contract Types: Opens the Contract Type screen.

• Contract Products: Opens the Contract Product screen.

• Terms: Opens the Term screen.

• Term Categories: Opens the Term Category screen.

• Templates: Opens the Template screen.

• Term Templates: Opens the Term GUI XSD screen.

• Run Reports: Opens the Run Reports screen, displaying reports associated with Contract 
Management (Product code “CM”).

• View Reports: Opens the View Reports screen, listing previously run reports associated 
with Contract Management (Product code “CM”).

Financials Menu
The Financials menu includes the following options:

• Collections: Expands to display the Collections menu, which includes the following:

• Collection Arrangements: Opens the Collection Arrangements screen.

• Exemptions: Opens the Collections Exemptions screen.

• Collection Work Queue: Opens the Collections Work Queue screen.

• Manual Submission: Opens the Manual Submission screen.

• Transactions: Expands to display the Transactions menu, which includes the following:[

• Installment Plans: Opens the Installment Plans screen.

• Deposits: Opens the Deposits screen.

• Payments: Opens the Payments screen.

• Adjustments: Opens the Adjustments screen.

• Refunds: Opens the Refunds screen.

• Writeoffs: Opens the Write Offs screen.

• Balance Transfers: Opens the Balance Transfers screen.

• Work Queue: Opens the Receivables Management Work Queues screen.

• Controls: Opens the Receivables Management Controls screen.
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• Work Flow: Expands to display the Work Flow menu, which includes the following:

• Activity Types: Opens the Activity Implementations screen.

• Process Versions: Opens the Processes and Process Versions screens.

• Work Queue: Opens the Work Queues screen.

• Process Controls: Opens the Process Controls screen.

• Manual Submission: Opens the Manual Submission screen.

• Run Reports: Opens the Run Reports screen, displaying reports associated with Financials 
(Product code “FME”).

• View Reports: Opens the View Reports screen, listing previously run reports associated 
with Financials (Product code “FME”).

Navigation
Oracle Utilities recommends using links and menu options when moving between screens in the 
Energy Information Platform. Use of the Internet Explorer Forward and Back buttons can 
produce unexpected results.
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Searching, Viewing, and Entering Data in the Oracle Utilities 
Energy Information Platform

This section describes how users search, view, and enter data in the Energy Information Platform, 
and includes:

• Searching and Viewing Data

• Entering Data

Searching and Viewing Data
This section provides specific information about searching and viewing data in the Energy 
Information Platform, including:

Searching
When searching records, users enter data in each of the fields they wish to use in their search. See 
Entering Data below for more information about how to enter specific types of data. If a search 
returns only one record, the record itself is displayed instead of the list screen.

Specifying How Results are Sorted
To specify how search results are sorted, click the Sort by plus (“+”) sign. This opens a pop-up 
window that lists the fields that can be used to sort the search results.

To sort by a specific field(s), check the corresponding checkbox(s). By default, records are sorted 
in ascending order (denoted by the  arrow). To sort records in descending order, click the 
arrow. The  arrow will be replaced by the  arrow.

To change the order by which the search results are sorted, click on the  area and move the 
field to the appropriate position in the list.

After specifying how the results are to be sorted, click the Sort by minus (“-”) sign to close the list.

For example, if a user were searching accounts and wanted to sort the results first by Customer ID 
in ascending order, and then by Start Time in descending order, the user would first check the 
Customer ID checkbox, then check the Start Time checkbox and click the  arrow. 

Note that sorting settings are reset each time you perform a search.

Viewing Search Results
Search results appear on a list screen that displays the records that match the search criteria. Each 
item on the list contains the entire record. Use the horizontal scroll bar to view columns that 
appear to the right of the list screen.

Sorting Search Results
Search results are sorted as specified by the user (see Specifying How Results are Sorted 
above). The direction (ascending or descending) in which each column is sorted is displayed at the 
top of each column.

Columns sorted in ascending order display a blue arrow pointing up.

Columns sorted in descending order display a red arrow pointing down.

To change the direction in which the results are sorted, click the up (ascending) or down 
(descending) arrow at the top of the appropriate column on the list screen.
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To continue the above example, if a user had searched accounts and sorted the results first by 
Customer ID in ascending order, and then by Start Time in descending order, the Customer ID 
column would display a blue arrow pointing up ( ) and the Start Time column would display a 
red arrow pointing down ( ).

Locking Columns
Some columns on search results list screens can be locked, or “pinned” in place, keeping the 
identity of the search results visible at all times. As the user scrolls to the right using the horizontal 
scroll bar, locked columns remain in place, while non locked columns scroll “beneath” the locked 
column(s).

Columns that can be locked have a pin button ( ) on them.

To lock a column, click the pin button ( ). This rotates the pin button, indicating that the column 
is locked.

To unlock a column, click the pin button ( ) again.

Entering Data
This section provides specific information about entering data in the Energy Information 
Platform screens, including:

• Entering Date and Date/Time Values

• Entering Lookup Values

• Selecting Values from Drop-Down Lists

• Specific Data Formats

Entering Date and Date/Time Values
Date and Date/Time fields store dates and/or datetimes, such as Start Date, Start Time, and Bill 
Month values. To enter date/time values, either type the date and time manually, or click the arrow 

button ( ) to the right of the field and select the date using the calendar control.

The calendar control displays the current month when opened. Click the appropriate day to select 
it. To change the month, click the arrows on either side of the month displayed. To change the 
year, click the arrows on either side of the year displayed. To select the current date, click Today. 
To clear the date value, click Clear.

Note: When entering dates manually, use the four digit format (i.e. “2004”).

Note: When you select a date using the calendar control, the time defaults to 
00:00:00.

Entering Lookup Values
Lookup values are references to records in other tables in the Oracle Utilities Data Repository, 
including both lookup records such as Operating Company and Jurisdiction records, and parent 
records such as Customer or Account records. When populated, lookup fields display the identity 

of the referenced record. To select a lookup, click the Browse button ( ). This opens a dialog 

window that lists all the records in the corresponding table in the Oracle Utilities Data Repository.

If there is more than one page of records, you can move between pages using the  and . 

buttons. Use the  button to return the first page, and the   button to navigate to the last 
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page. To change the number of results that appears on each page, enter the number in the Rows 
field and press the Enter key.

To search for a specific record, click Search. The dialog displays a search screen.

Enter the appropriate parameters for your search and click Search. The dialog will display a list of 
records that match the search criteria.

Click the [...] link to select the appropriate record. The lookup field is automatically populated.

Selecting Values from Drop-Down Lists
Drop-down lists allow users to select a value from a pre-populated list, and can contain either pre-
set values or values from tables in the Oracle Utilities Data Repository.

To select a value from a drop-down list, click the arrow next to the field. This opens a lists that 
includes all the values available.

If one or more of the values is longer than the default size of the list, click the lower right corner 
of the list and resize the list as necessary.

Specific Data Formats
Some fields on some screens of the Energy Information Platform require that data be entered in a 
specific format. This most often applies to currency and date fields, but can also apply to other 
number fields and other types of data. Moving the mouse pointer over the icon displays a tooltip 
that contains the correct format for the field.

If data is entered in an incorrect format, the border of the field turns red indicating that there is an 
error in the data in the field. Moving the mouse pointer over the field displays a tooltip that 
describes the correct format for the field.

Required Fields
Fields that are required are indicated by an asterisk (*).

Currency Fields
Currency fields are indicated by a currency symbol to the left of the field.
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Run Reports
The Run Reports option displays reports available through the Energy Information Platform 
Reporting Framework. From this screen, users can select and run reports. Each product has its 
own Run Reports option that displays reports associated with that product. For example, the 
Oracle Utilities Billing Component list displays billing reports, while the Oracle Utilities 
Receivables Component reports list displays it’s reports.

How to run reports:

1. Select the Run Reports option from the appropriate menu (Tools and Utilities, Work 
Queues, Billing, Financials, etc.). The Run Reports screen opens.

The Run Reports screen displays the following information for each report:

• Report Name: The name of the report.

• Description: A description of the report.

• Priority: The priority of the report (High, Medium, or Low).

• Type: The type of report (PLBX, LSRate (Oracle Utilities Rules Language), Active, or 
BIPublisher).

• Output Format: The output format for the report (applies to reports of type 
“BIPublisher” only).

• Creation Date: The date the report template was created.

• User: The User ID who created the report template.

• Generate ASP: A flag that indicates if the report framework generates an ASP 
parameters page for the report.

2. Select the report you wish to run by clicking the Report Name link from the list.

The Enter Report Parameters screen opens displaying the report parameters for the 
selected report.

3. Enter the parameters for the report as appropriate.

The Report Title field is the title that appears on the View Reports screen when the report 
is run.

4. Select the Priority for the report. This determines the priority (High, Medium, or Low) in 
which the report will be generated.

5. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

6. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports below, for more information). When the 
report is complete, the report opens in the appropriate viewer (Active, etc.). In addition, the 
report is also listed on the View Reports screen.

How to search reports:

1. Click New Search on the Run Reports screen. The Run Reports search screen appears.

You can search based on the Report Name, Report Type, User ID (who created the report or 
who last updated the report), Output Format, Creation Date, Priority, Report Category, 
Product, or the report Description.

You can search for reports whose creation dates are Less Than (<), Greater Than (>), Less 
Than or Equal To (<=), or Greater Than or Equal To (>=) the supplied date by selecting the 
appropriate operand from the drop-down list.
2-10 Billing Component User’s Guide



Run Reports
You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
text fields. For instance, if you want to search for all reports whose name begins with the 
letter G, you could enter “G%” in the Name field. You can use this wildcard before or after 
specified letters or numbers (i.e. you would use %t to search for all reports whose names end 
with the letter t, etc.).

Note that account Report Names, User IDs, and Descriptions are case-insensitive. For 
example, there is no difference between the “WQAging” and “wqaging” report names.

2. Specify how the search results are displayed.

• Select the manner in which the results are sorted from the Sort By: drop-down list. You 
can sort the results by Creation Date, Description, Report Name, Report Type, or User 
ID. 

• Specify how many results should appear on each page in the Page Length field.

3. Click Search to perform the search. To clear all the search fields, click Reset.

4. The search results appear on the Run Reports screen.

Scheduling Reports
The Schedule Process screen allows users to define a schedule for running processes unattended.

How to schedule a process:

1. Click Schedule (or Schedule Report). The Schedule Process screen opens.

2. Enter the Start Time for the scheduled process by entering the date and time manually or 
clicking the arrow and select the date using the calendar control and typing the time manually. 
See Entering Date and Date/Time Values on page 2-8 for more information about using 
the calendar control.

Note: The Server Time displayed above the Start Time field is the current time of the web 
server running the scheduler, including both the location and Time Zone where the server is 
located. Scheduled processes run based on the server time, not the time on the client 
machine.

3. Select a Recurrence Pattern for the scheduled process. You can select one of the following:

None: The scheduled process runs only once at the specified start time. Note: Scheduled 
processes with a recurrence pattern of None ignore Business Calendars and will run on non-
business days.

Intra Daily: The scheduled process runs multiple times, from as frequent as once every 15 
minutes to once every several hours. To base the recurrence on a number of minutes, select 
the Every x minutes radio button and select the number from the Minutes drop-down list. 
To base the recurrence on a number of hours, select the Every x hours radio button and 
enter the number of hours in the text box. Intra Daily processes may run throughout a single 
day or may span multiple days.

Daily: The scheduled process runs once per day or once per number of days. To base the 
recurrence on a number of days, select the Every x days radio button and enter the number 
of days in the text box. To set the scheduled process to run every weekday, check the Every 
weekday radio button.

Weekly: The scheduled process runs once or more per week (or number of weeks) on 
specified days. Enter the number of weeks in the Recur every x week(s) on text box, and 
check the specific days of the week on which the process should run. For example, to 
schedule a process to run on Monday and Wednesday every two weeks, you would enter 2 in 
the Recur every x week(s) on text box and check the Monday and Wednesday checkboxes.

Monthly: The scheduled process runs once per month or once per number of months. A 
monthly recurrence can be based on either a specific day of the month (such as the the 10th 
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day of the month), or a specific type of day (such as the 2nd Friday of the month). To base the 
recurrence on a specific day, select the Day x of every x month(s) radio button and enter the 
specific day and number of months in the text boxes. To base the recurrence on a specific 
type of day, select the The x x of every x month(s) radio button and select the appropriate 
number (First, Second, Third, Fourth, or Last) and day (Sunday through Saturday) from the 
drop-down lists and enter the number of months in the text box.

Important Note: Each execution of a recurring scheduled process uses the original 
parameters entered for the process.

4. Set the Range of Recurrence for the scheduled process. This specifies how many times the 
scheduled process will run (based on the specified recurrence pattern). There are three 
options:

• No end date: To specify no ending date for the recurrence, select the No end date 
radio button.

• End after occurence: To specify that the recurrence ends after a predetermined 
number, select the End after occurrence radio button and enter the number of 
recurrences in the text box.

• End by: To specify a date on which to end the recurrences, select the End by radio 
button and enter the date and time by which the recurrence should end. Enter the date 
and time manually or click the arrow and select the date using the calendar control and 
type the time manually. See Entering Date and Date/Time Values on page 2-8 for 
more information about using the calendar control.

5. Set any applicable Recurrence Exceptions for the scheduled process. Recurrence 
exceptions define which business calendar, if any, is used in scheduling and how to handle 
processes scheduled to run on non-business days. There are two options:

• Business Calendar: To schedule the process using a business calendar, click the Browse 

button ( ). This opens a dialog window that lists all the available Business Calendars. 
Click the [...] link to select the appropriate calendar. The field is automatically populated.

• Roll to next business day: Check this checkbox to specify that a process scheduled to 
run on a non-business day is rolled forward to the next business day. If the process is 
already scheduled to run on the next business day, a new process is NOT scheduled.

Note: When using a Business Calendar, if the Start Time entered for a process is later than 
the last date in the Business Calendar, an error will be returned. Also, for scheduled processes 
with the No End Date option selected, occurrences that would have occurred on dates later 
than the last date in the Business Calendar will not occur, and do not appear on the View 
Reports screen.
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View Reports
The View Reports option displays previously run reports available through the Energy 
Information Platform Reporting Framework, including other processes such as uploading data via 
the Upload Usage option. From this screen, users can view and delete reports. Each product has 
its own View Reports option that displays reports associated with that product. For example, the 
Oracle Utilities Billing Component View Reports screen displays billing reports, while the Oracle 
Utilities Receivables Component View Reports screen displays it’s reports.

How to view reports:

1. Select the View Reports option from the appropriate product menu (Tools and Utilities, 
Work Queues, Billing, Financials, etc.) The View Reports screen opens.

The View Reports screen displays the following information for each report:

• Status Icon: An icon that displays the status of the report. If an output format was 
specified for the report, the icon indicates the output format. See Report Icons for 
more information.

• Run/Schedule Time: The time the report was run or is scheduled to run.

• Report Title: The title of the report, specified when the report was run. For LSRate 
(Oracle Utilities Rules Language) reports, this column will display the name of the 
Report Template used to generate the report, unless specified using the 
SETREPORTTITLE Rules Language function.

• Priority: The priority of the report (High, Medium, or Low).

• Type: The type of report (PLBX (Oracle Utilities Billing Component), LSRate (Oracle 
Utilities Rules Language), Active, or BIPublisher).

• User: The user ID of the user who ran the report.

• Progress: The current percentage of the report instance that has been generated, from 0 
to 100 percent.

• Shared: A flag that indicates if the report is shared by all users or is accessible only by 
the user who ran the report.

• Base: A flag that indicates if the report is provided by Oracle Utilities or is a custom 
report.

• Process: The (machine) name of the server on which the report was executed.

• Account Name: The name of the account associated with the report, if applicable.

• Account ID: The ID of the account associated with the report, if applicable.

2. To view a specific report, click the Report Title link for the report. The selected report 
opens in the appropriate viewer.

3. To refresh the contents of the screen, click Refresh Periodically. To have the screen 
continually refresh its contents, check the Refresh Periodically checkbox.

Note: The current state of the Refresh Periodically checkbox (selected or not) is stored in the 
user’s settings, and is used as the default setting when subsequently opening this screen.

How to delete reports: 

1. Check the checkbox next to the reports(s) to delete. To select all reports, check the top check 
box.

2. Click Delete.

How to search reports:

1. Click New Search on the View Reports screen. The View Reports search screen appears.
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You can search based on the Report Title, Report Type, User ID (who created the report), 
Output Format, Creation Date, Report Category, or Product.

You can search for reports whose creation dates are Less Than (<), Greater Than (>), Less 
Than or Equal To (<=), or Greater Than or Equal To (>=) the supplied date by selecting the 
appropriate operand from the drop-down list.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
text fields. For instance, if you want to search for all reports whose name begins with the 
letter G, you could enter “G%” in the Name field. You can use this wildcard before or after 
specified letters or numbers (i.e. you would use %t to search for all reports whose names end 
with the letter t, etc.).

Note that account Report Titles, User IDs, and Descriptions are case-insensitive. 

2. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 for more information.

• Specify how many results should appear on each page in the Page Length field.

3. Click Search to perform the search. To clear all the search fields, click Reset.

4. The search results appear on the View Reports screen.

Report Icons
The icon listed next to each report indicates the status of the report. The meanings of these icons 
are as follows:

Icon Description

Report Starting: Report processing is starting.

Report in Process: Report processing

Report Complete: Report processing is complete.

Report Complete (Adobe Acrobat format): Report processing is 
complete.

Report Complete (Microsoft Excel format): Report processing is 
complete.

Report Complete (Microsoft Word format): Report processing is 
complete.

Report Complete (Rich Text format): Report processing is com-
plete.

Report Complete (Comma Separated Values format): Report pro-
cessing is complete.

Report Scheduled: Report is scheduled to run at a future time. To 

view scheduling details, click the  arrow in the far right column. 
To edit the schedule, click Edit.

Report Reminder: Indicates that a scheduled report is due to run 
in 15 minutes or less.
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Viewing Oracle BI Publisher Reports
When you select an Oracle BI Publisher Report, the report opens in a viewer based on the output 
format defined for the report. For the default output formats, this includes:

• Adobe Acrobat

• Microsoft Excel

• Microsoft Word (for MS Word and Rich Text Format reports. If Microsoft Word is not 
installed, Rich Text Format reports open in the installed application (if any) associated with 
the *.rtf file extension).

Viewing Oracle Utilities Rules Language Reports
When you select a Oracle Utilities Rules Language Report (one with a Type of LSRate), the report 
opens in the Report view screen.

The State section above the top left corner of the report displays the state of the report, including 
the number of Errors, the number of Pages expected and ready, and the elapsed time (in seconds) 
it took for the report to run.

The From: and To: fields above the top right corner of the report show the current pages 

displayed. The From: field displays the current page. The  and  buttons and the field 
between them are used to navigate the report. The field between the buttons defines how many 
pages display in the report window at a time. The default is 1. To display more than one page at a 
time, enter the number of pages you wish to view in the field.

Emailing Reports
You can also email reports from the View Reports screen. This allows users to distribute reports 
to other parties via email.

Note: The Send Email function requires the presence of the LSRELAY.CFG.XML file in the 
C:\LODESTAR\CFG directory on the web server computer. Contact your system administrator 
for more information about this file.

How to email a report:

1. Select the report (or reports) you wish to send via email and click Send Email on the View 
Reports screen.

The Send Email screen opens.

2. Select a From address from the drop-down list. This list is based on available records in the 
From Addresses table. If there are no available records in the From Addresses table, the 
current user’s email address is populated (if provided on the User Overview screen on the 
Security Adminstration user interface).

3. Enter an email address in the To field, or click Address Book (or the “+” sign) to add a 
contact or group name. See Using the Address Book on page 2-16 for more information 
about using the Address Book.

Report Error: One or more errors or warnings associated with the 
report. To view the error, click the Error icon.

Icon Description
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4. Optional. Enter an email address in the CC field, or click Address Book (or the “+” sign) to 
add a contact or group name. See Using the Address Book on page 2-16 for more 
information about using the Address Book.

To remove the CC field, click Remove CC.

5. Optional. To add the BCC field, click Add BCC, and enter an email address in the BCC field, 
or click Address Book (or the “+” sign). See Using the Address Book on page 2-16 for 
more information about using the Address Book.

6. Enter a subject for the email in the Subject field.

7. Enter the email message in the Message field.

8. To send the email, click Send. To clear all the fields, click Reset.

A message will appear at the top of the View Reports screen after your email has been sent.

Using the Address Book
In addition to entering email addresses manually, you can use the Address Book feature to select 
email recipients from those defined in the Oracle Utilities Data Repository. The Address Book 
contains listings of:

• Contacts

• Groups

Contacts
Contacts are specific individuals related to parties (such as Service Points or Market Participants) 
defined in the Oracle Utilities Data Repository.

How to select an existing contact from the Address Book:

1. Click Address Book (or the “+” sign) on the Send Email screen.

The Address Book dialog opens on the Contacts tab.

2. Enter the search criteria for the contacts you wish to send email to. You can search by Last 
Name, First Name, Middle Name, or Company.

3. Specify how the search criteria are to be combined by selecting the appropriate Combine 
with option (AND or OR), located in the upper right corner of the search screen. The 
default combine option is AND.

4. Specify whether or not the search is Case-sensitive by checking or unchecking the Case-
sensitive checkbox, located in the upper right corner of the search screen. The default setting 
is case-sensitive.

5. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 for more information.

• Specify how many results should appear on each page in the Page Length field.

6. Click Search to perform the search. To reset the search fields to their previous values, click 
Reset. To clear all the search fields, click Clear. To add a new contact to the Address Book, 
click Add.

7. The search results appear on the Address Book dialog.
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8. Select the contact(s) you wish to send the email to and click To. The selected contact(s) will 
appear in the To field on the Send Email screen.

To remove a contact from the To, CC, or BCC field, select the contact and click the Delete 
Key, or click the right mouse, and select Remove.

9. Optional. To add a contact to the CC (or BCC) field, select the contact(s) you wish to send the 
email to and click CC (or BCC as appropriate). The selected contact(s) will appear in the CC 
(or BCC) field on the Send Email screen.

How to add a contact using the Address Book:

1. Click Add on the Contacts tab of the Address Book dialog.

The Edit Contact screen opens.

2. Enter personal information for the contact (First, Middle, and Last Names, Title, etc.) in the 
Personal Information pane.

3. Enter contact methods (phone numbers, email addresses, etc.) for the contact in the Contact 
Method pane.

4. Enter optional address(es) for the contact in the Address Information pane.

5. Click Save to save the contact.

6. Click Return to Email to return to the Send Email screen and Address Book dialog.

7. Select the new contact and click To, CC, or BCC to add the contact to the appropriate field.

See Contacts on page 7-2 in the Oracle Utilities Energy Information Platform User’s Guide for more 
information about creating contacts.

Groups
Groups are groupings of contacts in the Oracle Utilities Data Repository.

How to select an existing group from the Address Book:

1. Click Address Book (or the “+” sign) on the Send Email screen.

The Address Book dialog opens on the Contacts tab. Click the Groups tab.

2. Enter the search criteria for the contacts you wish to send email to. You can search by Group 
Name or Desciption.

3. Specify how the search criteria are to be combined by selecting the appropriate Combine 
with option (AND or OR), located in the upper right corner of the search screen. The 
default combine option is AND.

4. Specify whether or not the search is Case-sensitive by checking or unchecking the Case-
sensitive checkbox, located in the upper right corner of the search screen. The default setting 
is case-sensitive.

5. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 for more information.

• Specify how many results should appear on each page in the Page Length field.

6. Click Search to perform the search. To reset the search fields to their previous values, click 
Reset. To clear all the search fields, click Clear. To add a new group to the Address Book, 
click Add.

7. The search results appear on the Address Book dialog.

8. Select the group(s) you wish to send the email to and click To. The selected group(s) will 
appear in the To field on the Send Email screen.
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To remove a group name from the To, CC, or BCC field, select the group name and press the 
Delete key, or click the right mouse, and select Remove.

9. Optional. To add a group to the CC (or BCC) field, select the group(s) you wish to send the 
email to and click CC (or BCC as appropriate). The selected group(s) will appear in the CC 
(or BCC) field on the Send Email screen.

How to add a group using the Address Book:

1. Click Add on the Groups tab of the Address Book dialog.

The Edit Group screen opens.

2. Enter a name for the group in the Group Name field.

3. Enter a description of the group in the Description field.

4. Optional. Check the Is Private checkbox to indicate that the group is private. Private groups 
can be only be viewed by the user who created the group. Public groups (Is Private 
unchecked) can be viewed by all users.

5. To add a contact to the group, click Add on the Membership title bar, and select the contact 
from the Contact ID drop-down list. Repeat this step for each contact you wish to add to the 
group.

6. Click Save to save the group.

7. Click Return to Email to return to the Send Email screen and Address Book dialog.

8. Select the new group and click To, CC, or BCC to add the group to the appropriate field.

See Groups on page 7-5 in the Oracle Utilities Energy Information Platform User’s Guide for more 
information about creating contact groups.
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Part One
Billing

Part One describes the billing functions of Oracle Utilities Billing Component, and contains the 
following chapters:

• Chapter 3: Viewing Billing Data

• Chapter 4: General, Billing, and Report Options

• Chapter 5: Approval Required Billing

• Chapter 6: Automatic Billing

• Chapter 7: Bill Corrections

• Chapter 8: Current/Final Bill

• Chapter 9: Trial Calculation

• Chapter 10: Billing Reports





Chapter 3
Viewing Billing Data

The Oracle Utilities Energy Information Platform allows users to search for and view information 
about selected customers and accounts. When Oracle Utilities Billing Component is installed, this 
information includes account-specific billing data. This chapter describes how to view billing data 
from the Account Summary screen, and includes the following:

• Viewing Billing Data
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The Account Billing clip on the Account dashboard displays the Bill Month, Start time, and Stop 
Time for the five earliest bill periods associated with the account. If there are more than five 
billing periods for the account, the number of pages (each comprising five records) appears at the 
bottom of the clip. To view the 2nd (or other page), click the page number.

To view more detailed billing data, click the number in parentheses. The Billing screen opens, 
displaying billing data for the most recent bill period. To view a specific billing period, click the Bill 
Month link for billing period you wish to view. The Billing screen opens for the selected billing 
period.

The Billing screen allows users to view Bill History, Bill History Value, Override History records, 
and financial transactions for the account. The Billing screen displays the following information 
for each bill period:

• Bill Period: A drop-down list containing all bill periods for the account. To change the 
record being displayed, select the bill period from the drop-down list.

• Start Time: Start time for the bill period.

• Stop Time: Stop time for the bill period.

• Bill Month: The bill month for the bill period.

• Bill Time: The time at which the account was billed for this bill period.

• Read Date: The date of the meter read for the bill period.

• User Specified Stop: A flag that indicates if the stop time for the bill period is user-specified 
or calculated.

• Billing Code: Billing code associated with this account for this bill period.

• KWH: The energy usage, in kilowatt hours, for the bill period.

• Bill Determinants: A list of Bill Determinants (Bill History Value records) for the selected 
bill period. You can choose to display either Bill Determinants (Bill History Value records) or 
Special Events (Account Override History records). When the Bill View tab opens, it initially 
displays Bill Determinants.

• Special Events: A list of Special Events (Override History records) for the selected bill 
period. To view all Override History records for the account, check the Show All Records 
checkbox.

• Transactions: A list of financial transactions (Transaction records) for the selected bill 
period.

How to edit a bill period:

1. Select the bill period to edit from the Bill Period drop-down list. The selected bill period (and 
related Bill Determinants and Special Events) will display on the Billing screen.

2. Click the Edit link. The edit screen opens displaying the selected bill period.

3. Update the Start Time, Stop Time, Bill Month, Bill Time, and Read Date either by typing 
the date manually, or by clicking the drop-down arrow to the right of the date field. This 
opens a calendar dialog that you can use to select the appropriate date. Update the time for 
the Start Time, Stop Time, and Bill Time by typing the time manually.

4. Select the User Specified Stop flag from the drop-down list.

5. Update the KWH value as appropriate.

6. Update the (optional) Bill Code by clicking the Browse button ( ). This button opens a 

dialog window that lists all the Bill Codes available. Click the [...] link for the appropriate Bill 
Code. The field is automatically populated.
3-2 Billing Component User’s Guide



Viewing Billing Data
7. Select the Profile Status flag from the drop-down list.

8. Click Save to save your changes. To delete the record, click Delete. To close the window 
without making any changes, click Cancel.

How to add a bill period:

1. Click the Add link. A blank screen opens.

2. Enter the Start Time, Stop Time, Bill Month, Bill Time, and Read Date either by typing 
the date manually, or by clicking the drop-down arrow to the right of the date field. This 
opens a calendar dialog that you can use to select the appropriate date. Update the time for 
the Start Time, Stop Time, and Bill Time by typing the time manually.

3. Select the User Specified Stop flag from the drop-down list.

4. Enter the KWH value as appropriate.

5. Enter the (optional) Bill Code by clicking the Browse button ( ). This button opens a 

dialog window that lists all the Bill Codes available. Click the [...] link for the appropriate Bill 
Code. The field is automatically populated.

6. Select the Profile Status flag from the drop-down list.

7. Click Save to save your changes. To close the window without making any changes, click 
Cancel.

How to edit Bill Determinants (Bill History Value records): 

1. Click the [...] link for the record you wish to edit in the Bill Determinants section. The edit 
screen opens displaying the selected record.

2. Select the Bill Determinant by clicking the Browse button ( ). This button opens a dialog 

window that lists all the Bill Determinants available. Click the [...] link for the appropriate Bill 
Determinant. The field is automatically populated.

3. Update the Value field for the record as appropriate.

4. Click Save to save your changes. To delete the record, click Delete. To close the window 
without making any changes, click Cancel.

How to add Bill Determinants (Bill History Value records): 

1. Click the Add link. A blank record opens.

2. Select the Bill Determinant by clicking the Browse button ( ). This button opens a dialog 

window that lists all the Bill Determinants available. Click the [...] link for the appropriate Bill 
Determinant. The field is automatically populated.

3. Enter the Value in the Value field.

4. Click Save to save your changes. To close the window without making any changes, click 
Cancel.

How to edit Special Events (Account Override History records): 

1. Click the [...] link for the record you wish to edit in the Special Events section. The Edit 
screen opens displaying the selected record.

2. Select the Override Code by clicking the Browse button ( ). This button opens a dialog 

window that lists all the Override codes available. Click the [...] link for the appropriate 
Override. The field is automatically populated.

3. Update the Start Time and Stop Time either by typing the date manually, or by clicking the 
drop-down arrow to the right of the date field. This opens a calendar dialog that you can use 
to select the appropriate date. Update the time for the Start Time and Stop Time by typing 
the time manually.
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4. Update the Value and String Value as appropriate.

5. Click Save to save your changes. To delete the record, click Delete. To close the window 
without making any changes, click Cancel.

How to add Special Events (Account Override History records): 

1. Click the Add link. A blank record opens.

2. Enter the information for the record as appropriate. Be sure to fill the two required fields 
(Override Code and Start Time).

3. Select the Override Code by clicking the Browse button ( ). This button opens a dialog 

window that lists all the Override codes available. Click the [...] link for the appropriate 
Override. The field is automatically populated.

4. Enter the Start Time and Stop Time either by typing the date manually, or by clicking the 
drop-down arrow to the right of the date field. This opens a calendar dialog that you can use 
to select the appropriate date. Update the time for the Start Time and Stop Time by typing 
the time manually.

5. Enter the Value in the Value field.

6. Enter the String Value in the String Value field.

7. Click Save to save your changes. To close the window without making any changes, click 
Cancel.
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Chapter 4
General, Billing, and Report Options

This chapter describes how to set different types of options for use with Oracle Utilities Billing 
Component, including:

• General Options

• Billing Options

• Report Options
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General Options
The General Options feature allows you to set your own default values for several frequently used 
parameters. These defaults are stored in the Oracle Utilities Data Repository. Whenever you start a 
Oracle Utilities application, these values are automatically supplied—saving you the time and 
effort of defining them each and every time.

Available General Options include:

• Scope Options

• Report Formatting Options

• Interval Data Options

• Error Handling Options

• User Files Options

• Rate Analysis Options

How to set general options:

1. Click the Options: General button on one of the Billing screens (Approval Required, 
Automatic Billing, etc.) or Report screens (Billing Checklist, Billing Exceptions, etc.).

General options can be viewed and saved at three different levels:

• Job: Settings used for the billing calculation or report to be run.

• Session: Settings used for the current user session.

• Default: Settings used as defaults unless specifically overridden for a Session or Job.

2. Select the level you wish to view and/or edit from the View drop-down list.

3. Set your options on each tab as desired.

4.  When you have completed the tabs as desired, select the level at which you wish to save your 
settings from the Save as drop-down list and click Save. To reset the values to the previously 
saved settings, click Reset.

The next several pages contain detailed information about the General Options tabs.

Scope Options
The Scope tab specifies a number of default values used by the system.

Operating Company: The default operating company used when searching accounts.

Jurisdiction: The default jurisdiction used when searching accounts.

Account ID: The default account ID for bill calculations and rate analyses.
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Report Formatting Options
The Report Formatting tab specifies formatting preferences used by the system.

Printer:

Default to landscape printing after this many characters: If a single line in a report 
contains this many characters, the report will default to landscape printing. The default setting 
is 133 characters.

Minimum printed line width: The minimum number of characters to be presented on a 
single line. The default setting is 80 characters.

Decimal Places:

Round Revenue ID to X: Specifies the precision of revenue values in reports. This setting 
affects only values that have been assigned to revenue identifiers via an Assignment, All, or Block statement in 
the applicable rate form. A value of 0 (zero) means don’t round, -1 means round to dollars, -2 
means round to tens of dollars, 1 to tens of cents, 2 to cents, and so on. The default setting is 
0.

Currency displayed to X: Specifies the number of decimal places shown in reports for 
dollar values. It is usually set to be consistent with your choice for Round Revenue. A value of 
0 (zero) means use the default (display cents), 1 means display tens of cents, 2 means display 
cents, 3 means display tenths of cents, 4 means display hundredths of cents, and so on. The 
default setting is 2.

Display Format:

Display calculation time/date on each page: The date is displayed on every page of every 
report. If this option is checked, the time is also displayed with the date.

Display midnight as 00:00:00 rather than blank: Specifies whether or not a value 
(00:00:00) is displayed and printed when the time is midnight.

Interval Data Options
The Interval Data tab specifies the source of interval data used by the system, and how interval 
data is loaded and processed by the system.

Source:

File: Specify a Btrieve file with a fully justified path. The Browse button below becomes 
active when this option is selected. This is the default setting.

Default: Specifies that the default Interval Data Database identified in the 
LODESTAR.CFG File be used. See the Oracle Utilities Energy Information Platform Configuration 
Guide for more information about setting a default Interval Data Database.

Customer Database: Specifies that interval data stored in the Oracle Utilities Data 
Repository be used. This the default setting.

Export:

Records Overwritten by SAVE to File: This option saves interval data cuts to an export file 
before they are overwritten by new cuts created by a Rules Language SAVE Statement. The 
full path and name of the file (including a valid extension) must be specified. This option 
appends new cuts to the same file without overwriting previously exported cuts.

Intervals:

Exclude intervals with quality less than: Specify a quality level that the interval data must 
meet or exceed in order to be included in calculations. All interval values with a code less than 
your selection will be ignored by the applications.

The meaning of the codes is utility-specific. If your utility uses the Oracle Utilities Load 
Analysis, the quality is expressed using the Oracle Utilities Load Analysis status codes shown 
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below (Oracle Utilities Load Analysis automatically attaches one of these codes to each 
interval in a cut). The codes are listed in order of decreasing quality—alpha codes generally 
indicate that the data is acceptable; numeric codes indicate that the data is suspect and should 
be corrected. Along with the Oracle Utilities Load Analysis codes, your facility may add its 
own codes.

Use in all day calculations: Check this box if you want the Day Start time to apply to all 
date calculations that round to a full day or higher.

Day Start: Specify the time that your facility considers the beginning of the day—8:00 am or 
midnight. This setting pertains to the ROUNDATE Rules Language function.

Display interval end time: Specifies whether the start- or end-times of intervals are 
displayed for the MAXDATE values in INTDVALUE and INTDTOUVALUE functions. If 
checked, the end-time is displayed. If unchecked, the start-time is displayed.

Status Code  Classification of interval data

(blank) Normal

A Normal, alternate-recorded (e.g., hand-entered)

J Data inserted by Oracle Utilities Load Analysis to correct outage

L Default for data modified by Oracle Utilities Load Analysis Load 
Data Editor

M Splice peak interval (estimated value)

N Interruptible or curtailable load

P Inserted outage

Q Corrected outage

X Cuts resulting from merging invalid data or from unrecognized 
status codes

Y Reserved

1 Uncorrected outage

2 Non-normal (usually timing-pulse defects)

5 Aggregated interval used in rolling format with partially missing 
or unavailable data

7 Aggregated or transformed interval with partially missing data

9 Missing
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Add Fall DST (Daylight Savings Time) value to Energy requests: The Oracle Utilities 
Data Repository stores energy in a 24-hour format. As such, the system must compensate for 
the extra hour of interval data that is left over on the day in October when the clocks are 
turned back for Daylight Savings Time. To do this, the system automatically takes each 
account’s interval data values for the two 2:00 a.m. hours and averages them together for a 
single hour. This option enables you to specify how Oracle Utilities applications handle the 
“leftover” hour when calculating energy from interval data. If this option is checked, the 
system doubles the averaged value. If the option is unchecked, it uses just the single, averaged 
value.

Error Handling Options
The Error Handling tab specifies how errors are handled by the system.

Upon Rules Language Interval Data Error:

• Stop: Stop processing bill in any billing mode.

• Log Message: Complete processing of bill; include warning message in error log, but 
not in bill report.

• Continue: Complete processing of bill; do not issue any messages.

• Issue Warning Message: In the Automatic Billing mode, stop processing the bill. In 
the Automatic or Approval Required modes, complete processing, but issue a warning 
message in the bill report.

• Issue Information Message: Complete processing of bill; include informational 
message in bill report.

Info Errors:

Display error messages: If checked, the program will display the number of errors (if any) it 
encountered during the job run.

Stop analysis after ## errors: The number of errors to allow when running an analysis or 
bill.

User Files Options
The User Files tab specifies where files created by the user are stored by the system.

Default User Directory: If there is a value in this field it will override the USERDIR setting 
in the configuration file (after the database is opened). Files put in the user directory before 
the database is opened - such as .log files - will still be placed in the USERDIR directory. 

Use last path as default in next browse: If this checkbox is checked, the path used in the 
last open or save operation will be the default path for the next open and save operation. 
When the application starts it uses the Default User Directory/USERDIR path in the first 
open or save.
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Rate Analysis Options
The Rate Analysis tab specifies default values for processing rate schedules.

Default:

Rate Schedule: The default rate schedule for calculations.

Season Schedule: The default season schedule for calculations.

Note: If when running an analysis or calculation, the input rate form includes a statement 
that assigns a value to the SEASON_SCHEDULE_NAME identifier, the value in the rate 
form takes precedence over the Options selection.

Analysis:

Test Period: Can be any period, one month or greater.
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Billing Options allow users to specify default global options that apply to all accounts in the 
system. These options apply to all billing types (Approval Required, Automatic Billing, etc.) and to 
all Oracle Utilities Billing Component users, unlike the user-specific General Options. However, 
you can override any of these settings for specific rate schedules, rate codes, or accounts in the 
Oracle Utilities Data Repository.

How to set and save billing options:

1. Under the Tools and Utilities menu, expand the Options sub-menu and select Billing 
Options. The Billing Options screen appears.

2. Set options as appropriate on the Billing Options, Billing Rules, Report Options, 
Summary Options, Multiple Bill History Records, and Check Options tabs.

3. To set the current settings as the settings for the DEFAULTUSER (the default settings for all 
new users), check the Set DEFAULTUSER Options checkbox.

4. Click Save to save the changes. To reset the options, click Reset. To close the Billing Options 
dialog without saving changes, click Cancel.

Billing Options
The Billing Options tab is used to define global defaults that apply to all accounts for all users.

Default Billing Mode
The Default Billing Mode specifies the mode that Oracle Utilities Billing Component applies to 
accounts that have not otherwise been assigned a billing mode. If you select Automatic Billing, 
Oracle Utilities Billing Component calculates the bills, updates the Oracle Utilities Data 
Repository, and issues transaction records—all without review and approval by a user. If you select 
Approval Required, Oracle Utilities Billing Component puts the results of its bill calculations in a 
bill report which you must approve before the software issues any transaction records or updates 
the bill history record in the Oracle Utilities Data Repository.

Note: Any billing mode flags set for individual rate schedules, rate codes, or 
accounts in the Oracle Utilities Data Repository records automatically override 
this setting.

Default Eligibility Pre- and Post-Windows
Pre- and Post-Windows specify the number of days before an account’s scheduled read date (the 
Pre-Window) and the number of days after an account’s scheduled read date (the Post-Window) 
that defines the “eligibility” window. You can supply any value from 0 to 28 for either. In the 
Automatic Billing and Approval Required modes, Oracle Utilities Billing Component uses this 
window to identify “eligible” accounts. That is, if today’s date falls within this window, Oracle 
Utilities Billing Component begins scanning for the data required to bill the account and continues 
scanning until it comes in or the window for the account passes today.

Note: If you set the Post Window to 0, the data must be available by the end of 
the read date, or it is considered missing. You can override the eligibility 
window setting for individual accounts and recorder types.

Special Event Pre Window
The Special Event Pre Window specifies the number of days prior to the billing date within which 
a Billing Analyst must approve an account’s Special Events information in order for the account to 
be billed. You can enter any value from 0 to 28.

This feature is designed to ensure that all Special Events are included in a bill. For example, 
suppose that the Billing Analyst approved an account’s Special Event information on schedule, but 
for some reason the account’s meter could not be read until seven days after the scheduled date. 
That would mean there would be seven days during which a Special Event could occur but not be 
included in the current bill. However, if you set the Special Event Pre Window to some number 
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less than 7, Oracle Utilities Billing Component would flag the account as “ineligible” and the 
billing analyst would have to update the special events information.

Billing Rules
The Billing Rules tab defines specific rules that are applied to billing.

Effective Date is
The Effective Date is the date used to determine Rate Form versions, factor values, and the 
default for determining the season. There are five options:

• Bill Stop

• Bill Start

• 1st of Bill Month

• Scheduled Read Date

• Governing Date.

Allow Saves without SAVE TO CIS statement
Normally output records are created as part of a bill calculation. These records are used with non-
Oracle Utilities Billing Component systems such as printing, accounts receivable, and so on. 
Oracle Utilities Billing Component verifies that at least one output record has been created before 
saving any data to the Oracle Utilities Data Repository. Check this box to turn this verification off, 
allowing you to save to the database without creating an output record.

You must Approve a bill to save it to the Oracle Utilities Data Repository. When you Approve the 
bill, data is saved and the Bill Time (BILLTIME) column in the Bill History is set.

Retrieve all Account Determinants
Normally, to improve performance, Oracle Utilities Billing Component loads only the 
determinants that are explicitly used in the Rate Schedule. However, if your rate schedules use 
indirect identifiers (the @ operator) to retrieve determinant values you need to turn this option 
on. Oracle Utilities Billing Component then loads all determinants in the account’s Bill History 
records.

Report Options
The Report Options tab is used to define global defaults for report options. These defaults apply 
to all reports generated by Oracle Utilities Billing Component. These can be overridden for a 
single report by selecting Options: Report from the report window. See Report Options on 
page 4-12 for more information.

Print Detail
The Print Detail option determines the level of detail included in the bill reports, transaction 
records, and bill faxes or E-mail. Select one of the following:

• None: Effective revenue only.

• Normal: Effective revenue, plus any charges assigned to a revenue identifier and any values 
assigned to a Report Statement in the applicable rate form.

• All: Effective revenue, plus revenue identifiers, plus the values associated with the Rules 
Language Label and Report statements in the rate form.

Show Bill History Problems/Resolutions in Bill Reports
If checked, this option specifies that any problems or resolutions that a Billing Analyst has entered 
into the Bill History Problem record for the current bill period appear near the top of the bill 
report (in the header section, just after the customer and account information). This option 
applies to all bill reports produced by Oracle Utilities Billing Component.
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Summary Options
The Summary Options tab is used to define how accounts with multiple rates and customer 
summary rate schedules are processed.

Compute Multiple Rates per Account
This option specifies whether all effective rates, or only the most recent rate is used for billing. 
The options available include:

• No: Oracle Utilities Billing Component calculates each account’s bill using just the most 
recent rate specified in the Account Rate Code History Table for that account.

• Throughout Bill Period: Compute multiple rates using all rates in effect for that account 
throughout the Bill Period, as specified in the Account Rate Code History Table. When 
computing multiple rates, Oracle Utilities Billing Component executes the rates in reverse 
order starting with the record with the most recent Start Time.

• On Effective Date: Compute multiple rates using all rates in effect for that account on the 
Effective Date, as specified in the Account Rate Code History Table.

Note: If you use either of the latter two options, be sure that all inactive rate 
codes have a stop time in the Account Rate Code History Table; otherwise they 
will be included in the calculations.

Enable Customer SUMMARY Rate Schedules
If this is checked, Oracle Utilities Billing Component can process Summary rate schedules.

Multiple Bill History Records
The Multiple Bill History Records tab is used to define how accounts with multiple Bill History 
records per bill period are processed.

Allow Multiple Bill History Records per Bill Period/Read Date
Normally, Oracle Utilities Billing Component uses the billing cycle’s scheduled meter read dates to 
match an account’s Bill History records with the correct bill periods. However, this may not suffice 
in all cases, either because the metered data does not come in from the field on a reliable schedule, 
or because the metering and billing schedule at your company is more complex. This tab enables 
you to choose the action that Oracle Utilities Billing Component takes when it encounters two or 
more account Bill History records associated with the same read date. The option you choose 
depends upon the metering and billing policies of your company. This setting applies to Automatic 
Billing, Approval Required, and Current/Final Bill.

• No: Oracle Utilities Billing Component rejects all Bill History records for the specified 
account that have the same read date. It does not process the bills, and issues an error 
message instead.

• Bill Individually - Allow Out of Order Bill Periods: This option is designed primarily for 
situations in which metered data comes in from the field irregularly—for example, readings 
for bill periods arrive out of sequence, and/or scheduled read dates are missed altogether.

If you select this option, Oracle Utilities Billing Component treats any account Bill History 
records that have the same read date as valid records, and processes them as separate and 
complete bills. It retrieves and bills the previously unbilled Bill History records for the 
account (Bill Time value equals NULL), in sequence, from oldest to most recent. To 
determine the bill period that the Bill History record actually belongs to, it looks at the Bill 
History record’s Start Date/Time for the metered data and processes the bill accordingly. If 
the applicable rate form includes any SAVE statements, the computed values are saved to the 
Bill History record for the correct bill period.

• Bill Individually - Monthly Merge Historical Values: This option is designed primarily 
for companies whose bill calculations require determinant values for sub-periods within the 
current bill period (e.g., weekly kWh), as well as values for entire historical bill periods (e.g., 
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maximum kW for the past 12 bill months). In this case, multiple sub-period records (e.g., 
records with different start- and stop-dates) may be associated with a single scheduled read 
date.

If you select this option, Oracle Utilities Billing Component assumes that multiple bill history 
records with the same read date for one account are in fact sub-period records. To perform 
the calculations (depending upon the rate schedule), Oracle Utilities Billing Component first 
aggregates historical sub-period values and start- and stop-dates to find values for entire 
historical bill periods. It then bills each sub-period for the bill period (same scheduled read 
date), from oldest through most recent.
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Check Options
The Check Options tab is used to define how Oracle Utilities Billing Component performs several 
checks before billing an account. In some billing systems, some of these checks are unnecessary. 
Use these options to turn off the unneeded checks, to improve performance.

Do not use Interval Data
This option turns off all support for Interval Data during billing.

Do not use Interval Data to Compute Start/Stop
This option disables use of interval data cuts to compute the bill start and stop, and do not verify 
that all the account’s interval data is ready. If neither Interval Data check is turned off and Multiple 
Bill History Records are allowed, only the verification is performed.

Do not check for Interval Data gaps
This option turns off checking for gaps between cuts. The rate schedule should then check for 
missing data (status code ‘9’) to validate the data. If this is not checked, a Warning will be reported 
if there are gaps between the interval data cuts. 

Do not check Account Notes
This option disables checks for Account Notes/Work Queue Items that stop billing in Automatic 
Billing or Approval Required. Do not write Account Notes/Work Queue Items from Automatic 
Billing or Approval Required.

Do not check Override Ready
This option disables checks that Special Events or Overrides are Ready.

Do not check Bill Determinant Use
This option disables checks of the account’s Bill Determinants’ Use.

Do not check Account’s Meter Values
This option disables verification that an account’s scalar data is in the Meter Value Table.

Do not check Rate Code Flags
This option disables use of the BILLINGMODEFLAG, PRINTDETAIL or FULLDAYBILL 
values in the RATECODE Table. If this is checked, it also turns off the same flags in the Rate 
Forms (RATEFORM) Table. 

Do not check Rate Schedule Flags
This option disables use of the BILLINGMODEFLAG, PRINTDETAIL or FULLDAYBILL 
values in the RATEFORM Table, independent of the RATECODE Table.

Use MDM schema for Billing
When this option is checked, Oracle Utilities Billing Component checks the Oracle Utilities Meter 
Data Management (Oracle Utilities Meter Data Management) tables, specifically the Meter Data 
Channel Cut table, for interval data when billing accounts.

Checking this option also automatically checks the following other options:

• Do not check for Interval Data Gaps

• Do not check Account’s Meter Values

It also disables the following options:

• Do not use Interval Data

• Do not use Interval Data to compute Start/Stop
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Report Options
Report options allow users to customize the contents of a report, including the report 
presentation, the print detail level, and the problem determination options.

Note: Changes to report options as described in this section apply only to the 
report currently being run.

Users access the Report Options via tabs at the top of the Report Options dialog. Clicking on 
these tabs allows users to navigate between types of report options, including:

• Presentation

• Print Detail

• Problem Determination

• Results Columns

 The current active tab is white. Inactive tabs are gray.

Note: Not all tabs and/or report options are available for all reports. If a tab/ 
option is not available, it is not displayed or greyed out.

How to set and save report options:

1. Click the Options: Report button in the input dialog box for the report you’re creating. The 
Report Options dialog appears.

2. Make any appropriate changes on the Presentation, Print Detail, Problem Determination, 
and Results Columns tabs.

3. Click Save to save the changes. To reset the Print Options, click Reset. To close the Print 
Options dialog without saving changes, click Cancel.

Presentation
The Presentation tab allows users to customize the presentation of a report.

Report Titles
To add optional titles to a report, enter the title in one of the three optional title fields.

Other Options
To disable graphing for the report, check the “Disable graphing of data” checkbox.

To display only summaries for the report, check the “Display summaries only” checkbox.

To keep the report data for CSV/XML exporting, check the “Keep data” checkbox.

Print Detail
The Print Detail tab allow users to specify the level of detail included in both a bill report and 
transaction record. The information computed and available for reporting is determined by the 
statements used in the applicable rate form. The Print Detail tab enables you to specify how 
much of that available data is included in the reports and transaction records.

Print Detail Options
Default: This option means the program will use the Print Detail setting normally applied to the 
account (via the Account, Rate Code, Rate Schedule, or Global options specified). Alternately, you 
can override the usual setting for just this job by selecting one of the following:

None: This option displays effective revenue only.

Normal Detail: This option displays effective revenue, plus any charges assigned to a revenue 
identifier and any values assigned to a Report Statement in the applicable rate form.
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All Detail: This option displays effective revenue, plus revenue identifiers, plus the values 
associated with the Rules Language Label and Report statements in the rate form.

The table below details how these options apply to specific components of a report and 
transaction record. 

To override the Print Detail Options setting for specific components of a bill report and 
transaction record, select the specific options for each component. For each report component 
type, select one of the following:

• On - Include the component in the report and transaction record.

• Off - Exclude the component from the report and transaction record.

• Print Detail Option - Apply the setting specified under Print Detail Options. The specific 
manner in which these settings affect individual report components is detailed in the table 
above. For example, if you had selected “None” under Print Detail Options, and selected 
Print Detail Option here for Input Values, the input values would not appear in the report.

Following is a brief description of each of the report components.

Customer/Account Detail. Date activated, billing mode, number of days specified for the 
eligibility pre- and post-windows.

Input values. This option reports the parameters specified for the bill calculations: bill start and 
end date; date that the account's meter was scheduled to be read; rate code applied to the account; 
number of days in bill period, and the bill month.

LABELed Identifier Values. This option reports the any identifier values and text strings 
specified using a LABEL Statement in the rate form. LABEL statements are typically used to 
substitute meaningful labels for bill determinant names or other brief and sometimes-cryptic 
identifiers (e.g., LABEL LF “LOAD FACTOR” displays LOAD FACTOR and its value in the 
report). They are often used for column headings or report subtitles.

Note: If a report component type is designated to appear in a report, and it is 
assigned a name using a LABEL Statement, its values will automatically appear 
in the report, with the new label. In other words, it is not necessary in that case 
to apply the LABELed identifier values option to get the label and value to 
appear. For example, the applicable rate form might have the statement 
LABEL $EFFECTIVE_REVENUE “Total Charges”. Because Effective 
Revenue is automatically included in all report types, “Total Charges” will 
appear, no matter what print details options you choose.

Simple report values. This option reports any values that were assigned to an identifier using a 
REPORT Statement in the rate form. REPORT statements are typically used to report values of 
interest that are calculated and/or drawn from the database, such as peak times.

Compound report values. This option reports any values associated with a stem identifier using 
a REPORT Statement in the rate form.

Report Component None Normal All 

Customer/Account Detail X X X

Input Values X X

LABELed Identifier Values X

Simple Report Values X X

Compound Report Values X X
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Problem Determination
The Problem Determination tab allows users to specify the level of problem determination detail 
included in both a bill report and a transaction record.

When problems occur during the processing of a bill, error messages and other information useful 
in determining the cause of the problem are created. The Problem Determination tab option 
enables you to specify how much of that data is included in the reports and transaction records.

Problem Determination Options
Show All Error Messages: This option reports all error messages that occur while processing 
the bill.

Show All Input Options: This option reports all input options used in processing the bill.

Show Bill records to Save (BillHistory, CSS, etc). This option includes the Bill History records 
in the Bill Report. It is typically only used for testing. If you turn this option off, the records are still 
output when you approve a bill, but they are not displayed or printed in the bill report.

Show Rate Schedule Used in Bill Calculation: This option includes the rate schedule used in 
processing the bill on the bill report.

Results Columns
The Results Columns tab allows users to specify the labels of the Bill Calculation Results section 
of a bill report.

The Bill Calculation Results section displays the number of billing units, the distribution of those 
billing units, the charge rate, and revenue for each revenue identifier used in a rate schedule.

Results Columns Options
• To change one or more of the Bill Calculation labels, check the Show all input options 

checkbox and edit the labels as appropriate.

• To omit one or more of the columns from the bill report (except the Revenue column), check 
the Change Bill Calculation Label checkbox and delete the appropriate label.

Billing Units: The label for the Billing Units column. If blank, the column is omitted.

Distribution: The label for the Distribution column. If blank, the column is omitted.

Charge Rate: The label for the Charge Rate column. If blank, the column is omitted.

Revenue: The label for the Revenue column. This column cannot be omitted. If blank, the 
column label is Revenue.
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Chapter 5
Approval Required Billing

Approval Required billing involves calculating bills that must be viewed and approved before the 
transaction records can be issued and the bill history record updated. This chapter describes how 
to process approval required billing, including:

• Running Approval Required Billing

• Viewing Billing Results

Approval Required billing selects “eligible” accounts based on scheduled meter read dates, and 
“available” accounts based on the presence of required billing data (special event overrides, bill 
determinants, and interval data).

Approval Required billing results are usually viewed and approved in order for Oracle Utilities 
Billing Component to issue the transaction records and update the Oracle Utilities Data 
Repository.

When viewing the results, users have the option to reject bills that appear unsatisfactory. If a user 
rejects a bill, Oracle Utilities Billing Component attaches a “USER REJECTED” note to it, and 
from that point the account’s bill for that period can only be issued manually via the Current/Final 
Bill module. If a user skips a bill (neither approving nor rejecting it), Oracle Utilities Billing 
Component will retry the calculations the next time Approval Required billing is run. In general, it 
is recommended that you skip the bill and let Oracle Utilities Billing Component rerun it. 
However, if you want to ensure that it is not approved (by another user, for example), then 
rejecting the bill is the best option.
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Running Approval Required Billing
How to run Approval Required Billing:

1. Select Billing-›Calculations-›Approval Required.

The Approval Required screen appears.

2. Select the customers or accounts to bill.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts to bill.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts to be billed from the drop-down list. If the 
contents of the list have changed since the last time that the associated query was run, 
check the “Refresh list” checkbox. This updates the list for this bill and saves the new 
version of the list to the database, replacing the old version. See the Data Manager User’s 
Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component bills all accounts or 
customers whose scheduled billing date matches the value in the Bill Date: field.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). You can either type the path 
and filename of the file, or click the Browse button to find the file using the Choose 
File dialog. Locate the file you wish to use and click Open. The path and file name of 
the select file appear in the text field.

3. Enter the Bill Date for the bill. This date is compared to the eligibility window dates. 
Typically, this should be today (the current date), but you can use other dates for testing 
purposes.

You can change the Bill Date either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
Bill Date.

4. Select the appropriate Billing Mode to use for the bill. You can select any one or a 
combination of the following options:

Account Level: Only bill accounts that have their billing mode flag set to Approval Required 
in the Account Table.

Rate Schedule/Rate Code Level: Only bill accounts that are on a rate schedule whose 
billing mode flag is set to Approval Required in the Rate Form Table.
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Default Level: Bill accounts that default to Approval Required. This option is only enabled if 
Approval Required is the default billing mode set on the Billing Options tab of the Billing 
Options screen. See Billing Options on page 4-7 for more information.

To bill all accounts that require approval, leave all boxes checked.

Check the “Also show accounts not billed” checkbox to display an explanation of why an 
eligible account was not billed. This option is particularly useful for testing. If the box is 
unchecked, Oracle Utilities Billing Component displays only bills that processed successfully. 

5. Select Approval Options, Accounts Billed, and the Output File for the bill.

Approval Options: Select how bills are to be approved from the following options:

• Do not enable saves of any kind: When this option is selected, Rules Language SAVEs 
do not save and no CIS transactions records are written to the CIS file. This is the option 
you’ll choose most often when testing rate forms.

• Enable user approve/reject of saves: When this option is selected, you can either 
Approve or Reject each set of results. If you approve an account (or an account and all 
its related accounts), the bill will be rerun with Automatic Approval. This second run will 
generate the same results, and will create database and CIS records.

• Automatically save/approve each page if it is OK: If you select this option, the data 
from each non-error page of an account is automatically written, regardless of the errors 
in other pages of the account or other related accounts. 

• Automatically save/approve groups of related pages if all OK: If you select this 
option, accounts (or related accounts, for summary customers) that billed without errors 
are automatically approved, and their database and CIS records are written.

Accounts Billed: Select how to handle summary billing from the following options:

• Include related summary accounts: This option enables you to bill only the accounts 
with read dates near today, ignoring the Summary Bill flag. Usually, all accounts that 
belong to a customer with the Summary Bill flag set to ‘Y’ are billed at the same time.

• Bill all accounts individually: Select this option to bill all accounts individually.

• Bill only non-summary accounts: Select this option to bill only non-summary 
accounts.

• Bill only summary accounts: Select this option to bill only summary accounts.

Output File Name: Specify the name of the file to which Oracle Utilities Billing Component 
writes the transaction record for approved bills. The default is LODESTAR.CIS.

6. If you want to override your default report options for this report, output the bill report to a 
file, or add titles to the report, click the Options: Report button. The Report Options 
dialog opens. See Chapter 4: General, Billing, and Report Options for more information.

7. If you want to change your general options for this report, click the Options: General 
button. The General Options dialog opens. See Chapter 4: General, Billing, and Report 
Options for more information.

8. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The bill will appear as an item on the View Reports screen.
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Viewing Billing Results
To view billing results, click the appropriate link on the View Reports window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Unit pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

Each Customer or Account listed in the Business Units pane includes an icon that indicates the 
status of the report results for that Customer or Account. The meanings of these icons are as 
follows:

How to view billing results: 

1. Click the ID row for the specific Customer or Account to view in the Business Units pane. 
The appropriate report results then display in the Report pane.

2. Optional. Customer and Account IDs appear as links in the Report pane. To view information 
concerning the Customer and/or Account, click the appropriate link.

3. Optional. To detach the report and view it in a separate window, click  Detach. From this 
separate window you can print and/or save the report.

4. Optional. To go back to the Reports List window, click Reports List.

Viewing Manually Approved Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), when you approve an 
account (or an account and all its related accounts), the bill is rerun with Automatic Approval. 
This second run should generate the same results as the initial run. In the rare case of a change in 
billing data between the initial and subsequent run, you can view each set of results.

When you select a Customer or Account ID from the Business Units pane, the original billing 
results are displayed. To view the results of the second run, click Adjusted. To go back to view the 
original results, click the Original button.

Icon Description

Read-Only: Billing results for this Customer/Account are read-
only. Billing results are read-only if they were generated using the 
Do not enable saves of any kind option, or if they have already 
been approved.

Error: Billing results for this Customer/Account contain and 
Error or Warning.

Approving: Billing results for this Customer/Account are in the 
process of being saved and/or exported.

Approved: Billing results for this Customer/Account have been 
saved and/or exported.

Rejecting: Billing results for this Customer/Account are in the 
process of being rejected.

Rejected: Billing results for this Customer/Account have been 
rejected.
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Approving and Rejecting Billing Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), you must review the 
billing results for each Customer or Account and manually Approve or Reject each.

To view billing results, click the appropriate link on the View Reports  window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Units pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

• To approve a bill, click Approve.

• To reject a bill, click Reject..

How to email billing results:

You can also email billing results. To do this, use the following procedure:

1. With the billing results displayed in the Report pane, click the Detach button to open the 
billing results in a separate window.

2. Select Save As... from the Internet Explorer File menu.

3. Enter a file name, select the destination for the file, and click Save.

4. Attached the saved file to an outgoing email using your email application.

Important notes about Approving/Rejecting Bills:
Here are some important points when approving or rejecting a bill:

• Approval/rejection for one month of a period rebill or cancel/rebill approves/rejects 
all months.

• Approval/rejection on one account of a summary bill approves/rejects the summary 
bill and all accounts.

• Once approved or rejected, a bill for an account will not be rerun in Approval Required 
mode for this bill period. Rejected bills must be corrected and issued manually using 
the Current/Final Bill module. 
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Chapter 6
Automatic Billing

Automatic Billing automatically identifies “eligible” and “available” accounts, calculates their bills, 
updates the Bill History records, and puts the results in transaction records that can be 
processed—all without user intervention. This chapter describes how you run automatic billing, 
including:

• Running Automatic Billing

• Viewing Billing Results
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Running Automatic Billing
How to run Automatic Billing:

1. Select Billing-›Calculations-›Automatic Billing.

The Automated Billing screen appears.

2. Enter the Bill Date for the bill. This date is compared to the eligibility window dates. 
Typically, this should be today (the current date), but you can use other dates for testing 
purposes.

You can change the Bill Date either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
Bill Date.

3. Select the appropriate Billing Mode to use for the bill. You can select any one or a 
combination of the following options:

Display only Accounts with Billing Errors/Warnings: This option is checked by default, 
because most accounts should automatically bill successfully. If this option is unchecked, all 
accounts will be displayed.

Display Accounts not billed: If this box is checked, Oracle Utilities Billing Component 
displays why eligible accounts were not billed. If this box is unchecked, Oracle Utilities Billing 
Component displays only successful bills.

4. Select Approval Options, Accounts Billed, Messages, and the output File for the bill.

Approval Options: Select how bills are to be approved from the following options:

• Do not enable saves of any kind: When this option is selected, Rules Language SAVEs 
do not save and no CIS transactions records are written to the CIS file. This is the option 
you’ll choose most often when testing rate forms.

• Automatically save/approve groups of related pages if all OK: If you select this 
option, accounts (or related accounts, for summary customers) that billed without errors 
are automatically approved, and their database and CIS records are written.

Accounts Billed: Select how to handle summary billing from the following options:

• Include related summary accounts: This option enables you to bill only the accounts 
with read dates near today, ignoring the Summary Bill flag. Usually, all accounts that 
belong to a customer with the Summary Bill flag set to ‘Y’ are billed at the same time.

• Bill all accounts individually: Select this option to bill all accounts individually.

• Bill only non-summary accounts: Select this option to bill only non-summary 
accounts.

• Bill only summary accounts: Select this option to bill only summary accounts.

Messages: This field displays error messages based on the parameters set. These alert you to 
any problems that have occurred while attempting to process the bills.

Write to File: Specify the name of the file to which Oracle Utilities Billing Component writes 
the transaction record for approved bills. The default is LODESTAR.CIS.

5. If you want to override your default report options for this report, output the bill report to a 
file, or add titles to the report, click the Options: Report button. The Report Options 
dialog opens. See Chapter 4: General, Billing, and Report Options for more information.

Note: The Automatic Billing report can display only up to 9,999 accounts. This 
limitation only applies to running Automatic Billing from the web user 
interface.
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6. If you want to change your general options for this report, click the Options: General button. 
The General Options dialog opens. See Chapter 4: General, Billing, and Report Options 
for more information.

7. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The bill will appear as an item on the View Reports screen.
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Viewing Billing Results
To view billing results, click the appropriate link on the View Reports window. The selected 
report opens in the Report View window. When the Report View window opens, the report 
displays the first Customer or Account included in the report.

The State section above the top left corner of the report displays the state of the report, including 
the number of Errors, the number of Pages expected and ready, and the elapsed time (in seconds) 
it took for the report to run.

The From: and To: fields above the top right corner of the report show the current pages 

displayed. The From: field displays the current page. The  and  buttons and the field 
between them are used to navigate the report. The field between the buttons defines how many 
pages display in the report window at a time. The default is 1. To display more than one page at a 
time, enter the number of pages you wish to view in the field.

How to view billing results: 

1. The billing results for the first Customer or Account are displayed when the Report View 
window opens.

2. To view the next page(s), click the ‘>>’ button. To view the previous page(s), click the ‘<<’ 
button. To skip ahead/back to a specific page, enter the page number in the From: field and 
the click the ‘<<’ or ‘>>’ button.

To view all Customers or Accounts, click the All button. To refresh the contents of the 
Report View window, click the Refresh button.

Note: The Automatic Billing report can display only up to 9,999 accounts. This 
limitation only applies to running Automatic Billing from the web user 
interface.

3. Optional. To detach the report and view it in a separate window, click Detach.

4. Optional. To go back to the Report List window, click Report List.
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Chapter 7
Bill Corrections

This chapter describes how to process bill corrections, including:

• Running Bill Corrections

• Viewing Billing Results

Bill corrections enable users to cancel previously issued bills and issue either an adjustment or new 
bills. Adjustments can be made to any bill. New bills (rebills) can be issued for the current bill 
period, as well as for any previous bill period.

Bill corrections are useful for fixing problems found by a billing analyst or customer, and for 
responding to customer requests for a change in the application of an override (to waive a peak, 
for example).

Bill correction results are usually viewed and approved in order for Oracle Utilities Billing 
Component to issue the transaction records and update the Oracle Utilities Data Repository.

When viewing the results, users have the option to reject bills that appear unsatisfactory. If a user 
rejects a bill, Oracle Utilities Billing Component attaches a “USER REJECTED” note to it.
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Running Bill Corrections
How to run bill corrections:

1. Select Billing-›Calculations-›Bill Correction.

The Bill Correction screen appears.

2. Select the customers or accounts to bill.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts to bill.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts to be billed from the drop-down list. If the 
contents of the list have changed since the last time that the associated query was run, 
check the “Refresh list” checkbox. This updates the list for this bill and saves the new 
version of the list to the database, replacing the old version. See the Data Manager User’s 
Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component bills all accounts or 
customers whose scheduled billing date matches the value in the Bill Date: field.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). You can either type the path 
and filename of the file, or click the Browse button to find the file using the Choose 
File dialog. Locate the file you wish to use and click Open. The path and file name of 
the select file appear in the text field.

3. Select the type of bill correction and the bill period(s) to correct.

Type: Select the type from the drop-down list:

• Cancel/Rebill: Cancels the previous bill(s) and issues new one(s) in their place. This 
option issues cancel transactions to the output file for the current bill month through the 
oldest month, and Issues Rebill transactions from the oldest month through the current 
month.

• Adjustment: Leaves the old bills in place and adds an adjustment to the new one. 

• Cancel Only: Sends transactions to the output file to cancel bill(s). If there are multiple 
bills, the order of the Cancel transaction records is current bill month through the oldest 
month. WARNING: The system does not ask for a confirmation before issuing the 
cancellations. Note: If you cancel a bill, you must rebill it. The separate Cancel Only and 
Rebill Only options enable you to perform the operation in two steps—if you need some 
time to investigate the rebill, for example. 
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• Rebill Only: Issues a new bill or bills to replace the canceled bill(s). If there are multiple 
bills, the order of the Rebill transaction records is oldest bill month through the current

4. Select the Bill Dates for the bill correction. You can run the bill correction based on either a 
number of previous bill periods, or a specified bill history record. Select the option from the 
drop-down list.

Bill Period(s) to correct: Enter the number of previous bill periods to correct—0 for the 
current bill period, 1 for the current and next most recent bill period, 2 for the current and 
two previous bill periods, and so on. For the current period, Oracle Utilities Billing 
Component uses the account’s most recent Bill History record that does not have a null value 
for Bill Date. The next bill period (in the case of multiple period corrections) is the next most 
recent bill history record, regardless of the value for Bill Date. Note that when you enter 0, 
Oracle Utilities Billing Component actually sends the number 01 to the output file; 1 is sent as 
02, and so on.

From bill history: This option allows you to select a specific bill period for the bill 

correction. Click the Browse button ( ). The Bill History dialog window opens.

To select a Bill History record, click the Start Time link. The Start Time, Stop Time, Bill 
Month, and Read Date values are automatically populated. Note: This option calculates 
adjustments for the selected bill period only, and does not affect any subsequent billing 
periods.

5. Select Check options.

Include Related Summary Accounts: To bill only the account(s) you select, ignoring the 
Summary Bill flag, uncheck this option. Usually, all accounts that belong to a customer with 
the Summary Bill flag set to ‘Y’ are billed at the same time. 

Use Bill History Dates and Times: In the other billing modes there may not be a Bill 
History record for the bill period, and these modes may compute the bill start and stop dates. 
There is always a Bill History record to correct when issuing a Bill Correction. Checking this 
option tells Bill Correction to use the Bill History dates instead of computing them. It should 
almost always be left on. You can uncheck this option if you wish to view computed dates.

Do not use current Bill History determinant values: If the account uses interval data, has 
already been billed, and you want to run the bill correction without using the saved bill 
determinants, check this option. Otherwise the current Bill History values will be used.

6. Select Approval Options, Rebill Reason, and the output File for the bill.

Approval Options: Select how bills are to be approved from the following options:

• Do not enable saves of any kind: When this option is selected, Rules Language SAVEs 
do not save and no CIS transactions records are written to the CIS file. This is the option 
you’ll choose most often when testing rate forms.

• Enable user approve/reject of saves: When this option is selected, you can either 
Approve or Reject each set of results. If you approve an account (or an account and all 
its related accounts), the bill will be rerun with Automatic Approval. This second run will 
generate the same results, and will create database and CIS records.
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• Automatically save/approve each page if it is OK: If you select this option, the data 
from each non-error page of an account is automatically written, regardless of the errors 
in other pages of the account or other related accounts. 

• Automatically save/approve groups of related pages if all OK: If you select this 
option, accounts (or related accounts, for summary customers) that billed without errors 
are automatically approved, and their database and CIS records are written.

Rebill Reason: This option is only available if the Rebill Reason (REBILLREASON) Table 
is present in the Oracle Utilities Data Repository. When available, this option allows you to 
select from a list of Rebill Reason codes when selecting one of the Rebill options (Cancel/
Rebill or Rebill Only).

Write to File: Specify the name of the file to which Oracle Utilities Billing Component writes 
the transaction record for approved bills. The default is LODESTAR.CIS.

7. If you want to override your default report options for this report, output the bill report to a 
file, or add titles to the report, click the Options: Report button. The Report Options 
dialog opens. See Chapter 4: General, Billing, and Report Options for more information.

8. If you want to change your general options for this report, click the Options: General button. 
The General Options dialog opens. See Chapter 4: General, Billing, and Report Options 
for more information.

9. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The bill will appear as an item on the View Reports screen.
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Viewing Billing Results
To view billing results, click the appropriate link on the View Reports window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Unit pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

Each Customer or Account listed in the Business Units pane includes an icon that indicates the 
status of the report results for that Customer or Account. The meanings of these icons are as 
follows:

How to view billing results: 

1. Click the ID row for the specific Customer or Account to view in the Business Units pane. 
The appropriate report results then display in the Report pane.

2. Optional. Customer and Account IDs appear as links in the Report pane. To view information 
concerning the Customer and/or Account, click the appropriate link.

3. Optional. To detach the report and view it in a separate window, click  Detach. From this 
separate window you can print and/or save the report.

4. Optional. To go back to the Reports List window, click Reports List.

Viewing Manually Approved Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), when you approve an 
account (or an account and all its related accounts), the bill is rerun with Automatic Approval. 
This second run should generate the same results as the initial run. In the rare case of a change in 
billing data between the initial and subsequent run, you can view each set of results.

When you select a Customer or Account ID from the Business Units pane, the original billing 
results are displayed. To view the results of the second run, click Adjusted. To go back to view the 
original results, click the Original button.

Icon Description

Read-Only: Billing results for this Customer/Account are read-
only. Billing results are read-only if they were generated using the 
Do not enable saves of any kind option, or if they have already 
been approved.

Error: Billing results for this Customer/Account contain and 
Error or Warning.

Approving: Billing results for this Customer/Account are in the 
process of being saved and/or exported.

Approved: Billing results for this Customer/Account have been 
saved and/or exported.

Rejecting: Billing results for this Customer/Account are in the 
process of being rejected.

Rejected: Billing results for this Customer/Account have been 
rejected.
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Approving and Rejecting Billing Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), you must review the 
billing results for each Customer or Account and manually Approve or Reject each.

To view billing results, click the appropriate link on the View Reports  window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Units pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

• To approve a bill, click Approve.

• To reject a bill, click Reject..

How to email billing results:

You can also email billing results. To do this, use the following procedure:

1. With the billing results displayed in the Report pane, click the Detach button to open the 
billing results in a separate window.

2. Select Save As... from the Internet Explorer File menu.

3. Enter a file name, select the destination for the file, and click Save.

4. Attached the saved file to an outgoing email using your email application.

Important notes about Approving/Rejecting Bills:
Here are some important points when approving or rejecting a bill:

• Approval/rejection for one month of a period rebill or cancel/rebill approves/rejects 
all months.

• Approval/rejection on one account of a summary bill approves/rejects the summary 
bill and all accounts.

• Once approved or rejected, a bill for an account will not be rerun in Approval Required 
mode for this bill period. Rejected bills must be corrected and issued manually using 
the Current/Final Bill module. 
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Chapter 8
Current/Final Bill

This chapter describes how to process current and/or final bills, including:

• Running Current/Final Bill

• Viewing Billing Results

Current/Final Bill enables you to manually initiate bill calculations for a single account for a user-
specified period. After you have examined and approved the results, Oracle Utilities Billing 
Component sends the transaction records to the output file and updates the Bill History records 
in the Oracle Utilities Data Repository.

There are four primary applications for this feature:

• Issue an “approval” copy for the customer’s examination - In some cases, the customer 
may wish to preview a bill before it’s actually issued. You can use Current/Final Bill to create 
a preliminary report for the customer. When the customer has OK’d the bill, you can approve 
the calculations, which in turn creates the transaction records and updates the Bill History 
record.

• Issue a bill that had been Rejected in the Approval Required or Automatic mode - If a 
bill was stopped or rejected in the Approval Required or Automatic mode, you must correct it 
and rerun it using Current/Final Bill. When a bill has been stopped or rejected, it cannot be 
rerun in Approval Required or Automatic mode.

• Issue the current bill for an account, despite missing data - There may be special 
instances when you need to issue a bill for an account, despite the lack of normally-required 
data. For example, an interval data cut for a required recorder may be missing. Current/Final 
Bill enables you to overrule any requirements and calculate the bill using the data that is 
available.

• Issue the final bill for an account - In this mode, Oracle Utilities Billing Component not 
only issues the transaction record with the correct code for a final bill, but also automatically 
closes the account in the Oracle Utilities Data Repository by adding a stop-date and -time to 
the Account Table. Oracle Utilities Billing Component will not bill an account after its stop 
date.
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Running Current/Final Bill
How to run current/final bill:

1. Select Billing-›Calculations-›Current Final Bill.

The Current/Final Bill screen appears.

2. Select the customers or accounts to bill.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts to bill.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts to be billed from the drop-down list. If the 
contents of the list have changed since the last time that the associated query was run, 
check the “Refresh list” checkbox. This updates the list for this bill and saves the new 
version of the list to the database, replacing the old version. See the Data Manager User’s 
Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component bills all accounts or 
customers whose scheduled billing date matches the value in the Bill Date: field.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). You can either type the path 
and filename of the file, or click the Browse button to find the file using the Choose 
File dialog. Locate the file you wish to use and click Open. The path and file name of 
the select file appear in the text field.

3. Enter the Bill To Date and Time: The start date of the bill period is automatically the end 
of the previous bill period (unless the account is new, in which case it is the account’s start 
date). You have two options:

• User specified: You supply the desired stop date and time. Your input here overrides 
any stop dates specified elsewhere, such as the account’s actual read date in its Bill 
History record. You can enter the Bill Date either by typing the date manually, or by 
clicking the drop-down arrow to the right of the date field. This opens a calendar dialog 
that you can use to select the Bill Date.

• Compute: The program determines the end of the current bill period, using the 
following rules:

• If the account is billed using one channel of interval data, Oracle Utilities Billing 
Component uses the stop date and time of the last cut recorded by the channel.
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• If the account is billed using multiple channels of interval data, it uses the earliest 
stop date and time among the multiple cuts.

• If the account is billed using billing determinants only (no interval data), it uses the 
actual read date and time recorded with the billing determinant data in the account’s 
most recent Bill History record.

4. Select the Bill Type:

• Current Bill: Issues a “regular” transaction record.

• Final Bill: Issues a “final bill” transaction record, and puts a stop date and time in the 
Account Table in the Oracle Utilities Data Repository, closing the account.

5. Include Related Summary Accounts: To bill only the account(s) you select, ignoring the 
Summary Bill flag, uncheck this option. Usually, all accounts that belong to a customer with 
the Summary Bill flag set to ‘Y’ are billed at the same time. 

6. Select Approval Options and the output File for the bill.

Approval Options: Select how bills are to be approved from the following options:

• Do not enable saves of any kind: When this option is selected, Rules Language SAVEs 
do not save and no CIS transactions records are written to the CIS file. This is the option 
you’ll choose most often when testing rate forms.

• Enable user approve/reject of saves: When this option is selected, you can either 
Approve or Reject each set of results. If you approve an account (or an account and all 
its related accounts), the bill will be rerun with Automatic Approval. This second run will 
generate the same results, and will create database and CIS records.

• Automatically save/approve each page if it is OK: If you select this option, the data 
from each non-error page of an account is automatically written, regardless of the errors 
in other pages of the account or other related accounts. 

• Automatically save/approve groups of related pages if all OK: If you select this 
option, accounts (or related accounts, for summary customers) that billed without errors 
are automatically approved, and their database and CIS records are written.

Write to File: Specify the name of the file to which Oracle Utilities Billing Component writes 
the transaction record for approved bills. The default is LODESTAR.CIS.

7. If you want to override your default report options for this report, output the bill report to a 
file, or add titles to the report, click the Options: Report button. The Report Options 
dialog opens. See Chapter 4: General, Billing, and Report Options for more information.

8. If you want to change your general options for this report, click the Options: General button. 
The General Options dialog opens. See Chapter 4: General, Billing, and Report Options 
for more information.

9. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The bill will appear as an item on the View Reports screen.
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Viewing Billing Results
To view billing results, click the appropriate link on the View Reports window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Unit pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

Each Customer or Account listed in the Business Units pane includes an icon that indicates the 
status of the report results for that Customer or Account. The meanings of these icons are as 
follows:

How to view billing results: 

1. Click the ID row for the specific Customer or Account to view in the Business Units pane. 
The appropriate report results then display in the Report pane.

2. Optional. Customer and Account IDs appear as links in the Report pane. To view information 
concerning the Customer and/or Account, click the appropriate link.

3. Optional. To detach the report and view it in a separate window, click  Detach. From this 
separate window you can print and/or save the report.

4. Optional. To go back to the Reports List window, click Reports List.

Viewing Manually Approved Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), when you approve an 
account (or an account and all its related accounts), the bill is rerun with Automatic Approval. 
This second run should generate the same results as the initial run. In the rare case of a change in 
billing data between the initial and subsequent run, you can view each set of results.

When you select a Customer or Account ID from the Business Units pane, the original billing 
results are displayed. To view the results of the second run, click Adjusted. To go back to view the 
original results, click the Original button.

Icon Description

Read-Only: Billing results for this Customer/Account are read-
only. Billing results are read-only if they were generated using the 
Do not enable saves of any kind option, or if they have already 
been approved.

Error: Billing results for this Customer/Account contain and 
Error or Warning.

Approving: Billing results for this Customer/Account are in the 
process of being saved and/or exported.

Approved: Billing results for this Customer/Account have been 
saved and/or exported.

Rejecting: Billing results for this Customer/Account are in the 
process of being rejected.

Rejected: Billing results for this Customer/Account have been 
rejected.
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Approving and Rejecting Billing Results
When you select the Enable user approve/reject of saves approval option (available in 
Approval Required Billing, Current/Final Billing, and Bill Corrections), you must review the 
billing results for each Customer or Account and manually Approve or Reject each.

To view billing results, click the appropriate link on the View Reports  window. The selected 
report opens in the Business Units window. The Business Units window consists of two panes: 
the Business Units pane and the Report pane.

The Business Units pane lists all the Customers or Accounts for the report. The Report pane 
displays the report results of the Customer or Account selected in the Business Units pane. When 
the Business Units window opens, the Report pane displays the first Customer or Account listed 
in the Business Units pane.

• To approve a bill, click Approve.

• To reject a bill, click Reject..

How to email billing results:

You can also email billing results. To do this, use the following procedure:

1. With the billing results displayed in the Report pane, click the Detach button to open the 
billing results in a separate window.

2. Select Save As... from the Internet Explorer File menu.

3. Enter a file name, select the destination for the file, and click Save.

4. Attached the saved file to an outgoing email using your email application.

Important notes about Approving/Rejecting Bills:
Here are some important points when approving or rejecting a bill:

• Approval/rejection for one month of a period rebill or cancel/rebill approves/rejects 
all months.

• Approval/rejection on one account of a summary bill approves/rejects the summary 
bill and all accounts.

• Once approved or rejected, a bill for an account will not be rerun in Approval Required 
mode for this bill period. Rejected bills must be corrected and issued manually using 
the Current/Final Bill module. 
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Chapter 9
Trial Calculation

This chapter describes how to run trial bill calculations, including:

• Running A Trial Calculation

• Viewing Billing Results

The Trial Calculation option enables you to create “trial bills” by applying any rate form to any 
account’s historical data over a user-specified date range. Because it is intended for testing and 
analysis, the Trial Calculation option does not permit data to be saved to the Oracle Utilities Data 
Repository, nor does it output results to a CIS file.

This module has several important applications:

• “debugging” new rate forms before they are used in a production mode.

• demonstrating to a customer the potential impact of switching to an alternative rate, or of 
modifying their usage patterns on the same rate.
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Running A Trial Calculation
How to run a trial bill calculation:

1. Select Billing-›Calculations-›Trial Calculation.

The Trial Bill screen appears.

2. Select the customers or accounts to bill.

By: Select Account or Customer from the drop-down list.

Using: Select ID from the drop-down list. Trial calculations can only be run for a single 
Customer or Account ID.

Type the ID of the account or customer in the text box, or click the Browse button ( ). 

This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and . 

buttons. Use the  button to return the first page, and the  button to navigate to the 
last page. To change the number of results that appears on each page, enter the number in the 
Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog will 
display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is automatically 
populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

3. Enter the Bill Period: You have two options:

• Bill Month: To select the bill period for the selected customer or account from the Bill 

History table, click the Browse button ( ). The From Bill History dialog opens. Click 

the Start Time to select the appropriate record.

• Compute: The program determines the end of the most recent bill period for the 
selected account, using the following rules:

• If the account is billed using one channel of interval data, the program uses the stop 
date and time of the last cut recorded by the channel.

• If the account is billed using multiple channels of interval data, it uses the earliest 
stop date and time among the multiple cuts.

• If the account is billed using billing determinants only (no interval data), it uses the 
actual read date and time recorded with the billing determinant data in the account’s 
most recent Bill History record.

4. Select the Billing Rate Schedule to use for the trial calculation using one of the following 
options:

• Use Applicable Rate Schedules: Click this radio button if you want to use the rate 
form that was in effect for the account during the bill month you specified above. If you 
select this option, skip to step 6.

• Select Rate Schedule: Click this radio button, then the Select Rate Schedule button if 
you want to select a rate form from the database. The Select Rate Schedule and 
Optional Rate Code dialog box appears. This box gives you access to all current, 
historical, and trial rate schedules stored in the Oracle Utilities Data Repository. If you 
select this option, go on to step 5.
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5. Optional. Select the rate schedule to use for the calculation on the Select Rate Schedule and 
Optional Rate Code dialog box.

Select an Operating Company, Jurisdiction, and Rate Schedule.

Optional. Select a rate code from the Select Rate Code list. If you do not select a rate code, 
the program will use the customer’s current rate code to determine the correct pricing.

Check the desired Type (Current/Historical or Trial). A list of all of the versions of the 
rate schedule that meet your criteria appears in the Rate Form Version selection box. To 
display all versions of the selected rate schedule, check the Show All checkbox.

Select one rate form version in the Rate Form Version selection box by clicking the 
corresponding radio button. 

Click Save. The selected rate schedule version appears under Billing Rate Schedule. To 
close the dialog, click Close.

6. If you want to override your default report options for this report, output the bill report to a 
file, or add titles to the report, click the Options: Report button. The Report Options 
dialog opens. See Chapter 4: General, Billing, and Report Options for more information.

7. If you want to change your general options for this report, click the Options: General button. 
The General Options dialog opens. See Chapter 4: General, Billing, and Report Options 
for more information.

8. Click the Run link to run the report. See Run Reports on page 2-10 and Scheduling 
Reports on page 2-11 for more information.

The bill will appear as an item on the View Reports screen.
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Viewing Billing Results
To view report results, click the appropriate link on the View Reports window. The selected 
report opens in the Report View window. When the Report View window opens, the report 
displays the first Customer or Account included in the report.

The State section above the top left corner of the report displays the state of the report, including 
the number of Errors, the number of Pages expected and ready, and the elapsed time (in seconds) 
it took for the report to run.

The From: and To: fields above the top right corner of the report show the current pages 

displayed. The From: field displays the current page. The  and  buttons and the field 
between them are used to navigate the report. The field between the buttons defines how many 
pages display in the report window at a time. The default is 1. To display more than one page at a 
time, enter the number of pages you wish to view in the field.

How to view report results: 

1. The report results for the first Customer or Account are displayed when the Report View 
window opens.

2. To view other pages (if applicable), click the ‘>>’ button. To view the previous page(s), click 
the ‘<<’ button. To skip ahead/back to a specific page, enter the page number in the From: 
field and the click the ‘<<’ or ‘>>’ button.

To view all pages of the report, click the All button. To refresh the contents of the Report 
View window, click the Refresh button.

3. Optional. To detach the report and view it in a separate Internet Explorer window, clich the 
Detach button. From this separate window you can print and/or save the report.

4. Optional. To go back to the Report List window, click the Report List button.
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Chapter 10
Billing Reports

This chapter describes the reports available with Oracle Utilities Billing Component, and explains 
how to produce and use them.

The available reports are:

• Billing Checklist

• Billing Exceptions

• Billing History

• Late Billing

• Rider Summary

• Special Events

• Top Accounts.
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Billing Checklist
The Billing Checklist allows users to preview the availability and completeness of required billing 
data for selected accounts and customers. The Billing Checklist report lists any missing data for 
each selected customer and/or account over a specified date range. Missing data can include 
special events, interval data, and bill determinants. Billing Analysts can use this report to track 
down the data required to process bills on time.

How to run the Billing Checklist:

1. Select Billing-›Reports-›Billing Checklist.

The Billing Checklist screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Enter the Read Dates for the report. This is the date range within which each account’s 
scheduled meter read date must fall for its data to be evaluated. The date range initially 
displayed is automatically calculated using the Eligibility Pre-window and Post-window 
Billing Options.

You can change the Read Dates either by typing the date manually, or by clicking the drop-
down arrow to the right of the date field. This opens a calendar dialog that you can use to 
select the correct dates for the report.

4. Select the information to display in the report. If you check Only accounts with missing 
data, you can check any or all three of the checkboxes below it (Special Events, Interval Data, 
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Bill Determinants). If you leave Only accounts with missing data unchecked, the display 
defaults to include all three options on the report.

Check the Ignore bill accounts checkbox to ignore accounts that have been previously 
billed (those that have a non-NULL Bill Time in the Bill History record for the specified bill 
period).

Check the Check Merge and Validation Flags checkbox to check the Merge and Internal 
Validation flags on interval data cuts applicable for the specified bill period. A cut is 
considered valid when the Merge Flag is set to ‘Y’, or the Merge flag is set to ‘N’ but the 
Internal Validation flag is set to ‘Y’.

5. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

6. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

7. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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Tips for Tracking Down Missing Data
The Billing Checklist report lists any missing data based on the specified accounts/customers and 
date range. Following are some tips that can help users track down missing data.

Missing Special Events
Problem: Oracle Utilities Billing Component was unable to locate a Special Event Ready Flag 
required for the account, or a Billing Analyst set the Ready flag, but too many days elapsed 
between the time when the flag was set and the time that all of the account’s other billing data was 
available. The requirement for a Special Event Ready Flag is specified in the Override Use Table. 
The number of days in the Special Events Pre-window is defined in the Default Billing Options 
dialog box.

Solution: Verify that all required special event overrides for the account for the bill period have 
been entered in the Override History and/or Name Override History tables. Once you have 
verified this information, set the Override Ready flag. Reminder: If a special event is recorded in the 
Override Use Table for an account, you must set the Ready flag in the Override Ready Table for the account’s bill 
to be issued, even if the special event did not occur that month.

Missing Interval Data (Channels)
Problem: Oracle Utilities Billing Component was unable to locate a required interval data cut for 
a specific recorder-channel. Either the cut was never entered into the Interval Database or, if it 
was, its stop-time was outside the eligibility window.

Solution: Look for the cut in the Interval Database using the Interval Data Browser (see the Data 
Manager User’s Guide). If the cut is not listed, contact your meter shop to determine whether or not 
there was a problem reading the meter.

If the cut is available in the Interval Database, check its stop-date to make sure that it falls within 
the eligibility window that applies to this cut. If the stop-date and time are outside the window, 
there are two possible solutions that will enable billing the account:

• You can bill the account with the Current/Final Bill module using the cut’s recorded stop-
date. In the Current/Final Bill Input dialog box, select the User Specified option for Bill 
to Date and Time and enter the cut’s actual stop-date and -time.

• If this problem occurs frequently for this account, consider increasing the size of the 
eligibility Pre- or Post-window for the account or its recorder.

Missing Bill Determinants
Problem: Oracle Utilities Billing Component was unable to locate a required bill determinant 
value in the account’s Bill History record.

Solution: Look at the Bill History table on the Account Details tab of the Account screen for the 
account to determine what determinants are missing.
10-4 Billing Component User’s Guide



Billing Exceptions
Billing Exceptions
The Billing Exceptions report allows users to review the status of bills based on information in the 
Account Note Table. This report alerts Billing Analysts to actual or potential problems that 
occurred during the billing process, such as missing data or charges that appear to be too high. 
Account Notes/Work Queue Items can be entered either automatically by Oracle Utilities Billing 
Component or manually by a user. For example, the report shows accounts that should have been 
billed but were not (eligible but not available), or that were rejected by a user upon inspecting the 
results of the calculations.

How to run the Billing Exceptions report:

1. Select Billing-›Reports-›Billing Exceptions.

The Billing Exceptions screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Specify the Account Note Period for the report. The date that an account note was entered 
must fall within this range in order for the note to be included in the report.

You can change the dates either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
correct dates for the report.

4. Specify the Account Note Codes to include in the report. If you check the All checkbox, the 
report includes all Account Note Codes Otherwise, using the checkboxes, you can select the 
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specific account note codes you want included on the report. To ignore previously billed 
accounts for this report, check the Ignore Billed Accounts checkbox.

5. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

6. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

7. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.

Note: If an account has an EXCEPTION or other note that indicates the bill 
will be issued late, be sure to attach a PROBLEM description to it, so that it can 
be tracked using the Late Billing report.

Description of Account Notes/Work Queue Items
Account Notes and/or Work Queue Items can stop an account from being billed in the 
Automatic or Approval Required modes, or they can be informational only. When a bill is 
stopped because of an Account Note/Work Queue Item, it can still be issued automatically if 
corrected before the eligibility window expires. If the eligibility window passes, the bill can only be 
issued manually via the Current/Final Bill module.

Note: When using work queues, exceptions are written to the Work Queue 
Open Item table instead of the Account Notes table. To enable work queues, 
include the USE_WORK_Q_FOR_ACCOUNT_NOTES = 1 parameter in 
the LODESTAR.CFG file.

Below is a list of the standard Account Note/Work Queue Item types, their meaning, and their 
impact on the billing process. Your facility may have more note types. The types in use at your 
facility are stored in the Account Note Type Table/Work Queue Type table in the Oracle Utilities 
Data Repository.

Note: Changing the Stop Billing flag on these Account Notes/Work Queue 
Item types has no effect on the billing process.

Code  Automatic  Appr Req  Meaning

ABORT X  X  An ABORT statement in the rate 
form used for bill calculation.

EXCEPTION X Data missing on day after post-
window.

HOLD X User-requested hold via Browser 
or Account-Centric View.

INFO Informative note supplied by user 
via Browser or Account-Centric 
View.

SYSTEM 
REJECTED

X Invalid data or failure during bill 
calculation.

USER 
REJECTED

X User rejected after review of 
calculations.
10-6 Billing Component User’s Guide



Billing Exceptions
WARNING X A WARNING statement in the 
rate form used for bill calculation.

Code  Automatic  Appr Req  Meaning
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Billing History
The Billing History report is used to examine and compare bill determinant values and other 
billing information for one or more accounts over a user-specified number of bill periods. This 
report also allows you to produce a summary report which totals the data for all accounts.

How to run the Billing History report:

1. Select Billing-›Reports-›Billing History.

The Billing History screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Specify the Test Period for the report, including the beginning and end of the period for the 
report 

You can change the dates either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
correct dates for the report.

4. Optional. Enter a name for the report in the Analysis Name field. This name appears on the 
printed report.

5. Select the number of decimal places to display when displaying Bill Determinants from the 
Displayed to n Decimal Places drop-down list. If the number in the database has more 
decimal places than the number selected, the number displayed on the report is rounded off 
the number of decimals selected. If the number in the database has less decimal places than 
the number selected, the number displayed on the report will have zeros appended to the end 
to display the number of decimals selected. The default setting is 1.
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6. Enter the level of detail to be included in the report. You can check one or both of the 
following options, but you must check at least one:

• Individual Account Report: The report displays a page of information for each 
account in the list.

• Grand Total Summary: The report displays the total data for all accounts in the list. 
This option is always checked.

7. Optional. Add Override Codes: If this checkbox is checked, the report includes the override 
codes in effect for each account and bill period in the report. This option requires the 
Individual Account Report option be selected.

8. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

9. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

10. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10 and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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Late Billing
The Late Bill report allows users to monitor the progress of individual bills, track the interest lost 
due to the billing delays, and summarize all late bills so that you can identify and resolve any 
recurring problems.

There are two situations in which a bill is considered “late” and therefore included in the Late Bill 
report:

• Bills that were issued after their scheduled meter read date – A bill is considered on time 
if it is calculated and sent to the output file on or before the date that its meter was scheduled 
to be read. If Oracle Utilities Billing Component sends the transaction record to the output 
file on any day after the scheduled read date, the bill is considered late. Oracle Utilities Billing 
Component automatically finds late bills by comparing the date that the bill was issued to the 
output file with the account’s scheduled read date. Specifically, the program compares the 
account’s value for Bill Time with its value for Read Date in the Bill History Table. If the 
bill date was any time after the read date, the software automatically includes the account in 
the Late Bill report, even if the bill date was within the account’s post-window for eligibility.

• Unbilled accounts that are both past their read date, and have a manually assigned 
“Problem” description – Oracle Utilities Billing Component automatically attaches an 
EXCEPTION note to any account whose billing data was unavailable by the scheduled read 
date and therefore could not be billed on time. In addition, Oracle Utilities Billing 
Component or a billing analyst can attach other kinds of Account Notes/Work Queue Items 
to an account to indicate a problem. These notes can actually halt the billing process for the 
account’s bill. It is the billing analyst’s responsibility to examine the Billing Exceptions and 
Rejections report for Account Notes/Work Queue Items such as an EXCEPTION, and to 
resolve any problems. If you want to use the Late Bill report to track bills that are being 
delayed in this manner, you must manually attach a “PROBLEM” description to the account. 
If you do not attach a “PROBLEM” description to the account, the account only appears in 
the report after the bill has been issued.

How to run the Late Billing report:

1. Select Billing-›Reports-›Late Billing.

The Late Billing screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.
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• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Specify the date range for the report, including the beginning and end of the period for the 
report. You can change the dates either by typing the date manually, or by clicking the drop-
down arrow to the right of the date field. This opens a calendar dialog that you can use to 
select the correct dates for the report.

You can use either Bill Month or Read Date for this report.

Note: Whether you specify Bill Month or Read Date, the information is reported for bill 
months.

• Bill Month: Enter the month(s) for the report using the mm/yyyy format—for 
example, 10/1997. If you want just one month, enter the same date in both fields.

• Read Date: Enter the beginning and end of the period of interest, using the mm/dd/
yyyy format. Any account with a late bill associated with a read date between those dates 
is included in the report.

4. Specify the Number of Days Late for the report. Enter the range for number of days late to 
be included on the report in the From and To fields.

5. Specify how you want to Sort the report. If you want the resulting report sorted by 
jurisdiction, check the Sort by Jurisdiction checkbox.

You can also sort the report by Account Number, Bill Amount, or Days Late; these three 
options are mutually exclusive. If you select Bill Amount, select the billing determinant that 
will be used to create the report from the the Select Determinant to be used for Bill Amt 
drop-down list.

6. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

7. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

8. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10  and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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Rider Summary
The Rider Summary report lists the tariff riders that were applied to selected customers or 
accounts over a user-specified date range. The results can be organized in either of two ways: you 
can generate a list of riders that were applied to each account, or a list of accounts that were 
subject to each rider.

For purposes of Oracle Utilities Billing Component and the Oracle Utilities Energy Information 
Platform, the term “rider” refers to both:

• A tariff rider that has been explicitly attached to an account by a billing or rate analyst in the 
Rider History Table.

• A generic rider that is included as part of another rate form. This type of rider is simply a set 
of language statements that perform a common function used in several rate schedules, such 
as calculating a determinant value. These riders are created and stored separately like a library 
of “standard text,” so that the rate analyst can quickly incorporate them into another rate 
form without having to re-write them from scratch every time.

The Rider Summary reports only tariff riders.

How to run the Rider Summary report:

1. Select Billing-›Reports-›Rider Summary.

The Rider Summary screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.
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3. Specify the Rider Summary Period for the report.

You can change the dates either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
correct dates for the report.

4. Specify how you wish to Sort the report. You can select either Rider or Account Number.

5. Select Rider Options for the report. To use all of the existing Rider Options for this report, 
check the All checkbox. To specify riders for the report, check the riders to use. 

6. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

7. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

8. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10  and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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Special Events
The Special Events report summarizes all of the overrides that have been applied to an account 
over a user-specified date range. 

How to run the Special Events report:

1. Select Billing-›Reports-›Special Events.

The Special Events screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select ID, List, All, or File from the drop-down list. This indicates how you specify 
the accounts for the report.

• ID: Type the ID of the account or customer in the text box, or click the Browse button 

( ). This opens the Accounts (or Customers) dialog.

If there is more than one page of records, you can move between pages using the  and 

. buttons. Use the  button to return the first page, and the   button to 
navigate to the last page. To change the number of results that appears on each page, 
enter the number in the Rows field.

To search for a specific account (or customer), click Search. The dialog displays a search 
screen. Enter the appropriate parameters for your search and click Search. The dialog 
will display a list of accounts (or customers) that match the search criteria.

Click the [...] link to select the appropriate account (or customer). The field is 
automatically populated.

Note: You can only select accounts that you have been granted access to via Security 
Administration.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Specify the Events Period for the report.

You can change the dates either by typing the date manually, or by clicking the drop-down 
arrow to the right of the date field. This opens a calendar dialog that you can use to select the 
correct dates for the report.

4. Select the Events Code(s) for the report. To select all special events, check the All checkbox. 
To select events codes individually, uncheck the All checkbox, and check the specific events 
to include in the report.

5. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.
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6. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

7. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10  and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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 Top Accounts
The Top Accounts Report lists the largest customers by revenue, energy, or demand, and lets you 
see how their bills have changed from the previous year.

The report includes the following information: 

• the top n customers by revenue, energy, or demand for each bill month in the analysis period 
(where n is a value you specify), 

• each customer’s monthly value for revenue, energy, and demand, along with its value for the 
same period one year earlier (if available),

• the percentage change.

The report also totals the values for all of the customers in the system for the selected revenue 
classes in each bill month.

When setting up the report, you can specify which determinants from the Bill History Table are 
used as the measure for Revenue, Energy, and Demand.

How to run the Top Accounts report:

1. Select Billing-›Reports-›Top Accounts.

The Top Accounts screen appears.

2. Select the customers or accounts for the report.

By: Select Account or Customer from the drop-down list.

Using: Select List All, or File from the drop-down list. This indicates how you specify the 
accounts for the report.

• List: Select the list of customers or accounts for the report from the drop-down list. If 
the contents of the list have changed since the last time that the associated query was 
run, check the “Refresh list” checkbox. This updates the list for this bill and saves the 
new version of the list to the database, replacing the old version. See the Data Manager 
User’s Guide for information about creating Customer and Account lists.

• All: When this option is selected, Oracle Utilities Billing Component runs the report for 
all customers or accounts in the Oracle Utilities Data Repository.

• File: Specify a file containing a list of customer/account IDs (*.ids), a list file (*.lst), an 
account query file (*.qra), or a customer query file (*.qrc). Click the Browse button to 
find the file using the Choose File dialog. Locate the file you wish to use and click 
Open. The path and file name of the select file appear in the text field.

3. Specify the Select Period for the report.

Enter the dates by typing the dates manually.

4. Select the appropriate Options for the report. The following options are available.

• Revenue Code: Select a Revenue Code from the list. 

• Top Customer(s): Enter the number of top customers to be reported, and select one of: 
Revenue, Energy, or Demand. This option indicates whether to report on Top 
Customers by amount of revenue, by energy consumption, or by energy demand.   

• Type of Report: Select either By Revenue Code or As One Large Group. Reporting 
By Revenue Code will present the top accounts or customers per revenue code, and 
reporting As One Large Group will provide the top accounts or customers for all the 
accounts or customers included on the report.

• Sort Report By: Select one of: Revenue, Energy, Demand, or Customer Name. The 
resulting report will contain a heading reflecting your choice, and the information on the 
report will be sorted according to that choice. 
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5. Click on the Select Determinants arrow to display the determinant options. Select a 
Revenue Determinant, an Energy Determinant, and a Demand Determinant from the 
drop-down lists.

6. If you want to override your default report options for this report or add titles to the report, 
click the Options: Report button. The Report Options dialog opens. See Report Options 
in Chapter 4: General, Billing, and Report Options for more information.

7. If you want to override your default General options for this report, click the Options: 
General button. See General Options in Chapter 4: General, Billing, and Report 
Options for more information.

8. Click the Run link to run the report. Click Schedule to schedule the report. See Run 
Reports on page 2-10  and Scheduling Reports on page 2-11 for more information.

The report will appear as an item on the View Reports screen.
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Viewing Report Results
To view report results, click the appropriate link on the View Reports window. The selected 
report opens in the Report View window. When the Report View window opens, the report 
displays the first Customer or Account included in the report.

The State section above the top left corner of the report displays the state of the report, including 
the number of Errors, the number of Pages expected and ready, and the elapsed time (in seconds) 
it took for the report to run.

The From: and To: fields above the top right corner of the report show the current pages 

displayed. The From: field displays the current page. The  and  buttons and the field 
between them are used to navigate the report. The field between the buttons defines how many 
pages display in the report window at a time. The default is 1. To display more than one page at a 
time, enter the number of pages you wish to view in the field.

How to view report results: 

1. The report results for the first Customer or Account are displayed when the Report View 
window opens.

2. To view other pages (if applicable), click the ‘>>’ button. To view the previous page(s), click 
the ‘<<’ button. To skip ahead/back to a specific page, enter the page number in the From: 
field and the click the ‘<<’ or ‘>>’ button.

To view all pages of the report, click the All button. To refresh the contents of the Report 
View window, click the Refresh button.

3. Optional. To detach the report and view it in a separate Internet Explorer window, clich the 
Detach button. From this separate window you can print and/or save the report.

4. Optional. To go back to the Report List window, click the Report List button.
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Part Two
Contract Management

Part Two describes the contract management functions of Oracle Utilities Billing Component, and  
contains the following chapters:

• Chapter 11: Contract Management Overview

• Chapter 12: Setting Up Contract Terms, Contract Products, and Contract Types

• Chapter 13: Working with Contracts





Chapter 11
Contract Management Overview

This chapter provides an overview contract management functions of Oracle Utilities Billing 
Component, including:

• Working with Contract Management
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Working with Contract Management
This section describes how you work with the contract management functionality of Oracle 
Utilities Billing Component, describing a typical process for creating a contract for a list of 
accounts.

Enter Account/Customer Data
The first step in creating a contract is to enter data for the accounts and/or service points or for 
which you’re creating the contract. This is usually done by importing a file to the Oracle Utilities 
Data Repository that contains the appropriate customer and account data, including:

• Customer records

• Account records

• Service Point records

• Contact Information

Create List of Accounts for Contract
If creating contracts for accounts, the next step is to create lists of the accounts or customers to be 
included in the contract. Most Oracle Utilities Billing Component - Contract Management 
functions work with account or customer lists. See Lists on page 7-63 of the Oracle Utilities Energy 
Information Platform User’s Guide for more information.

Create Contract
The next step is create a contract for your list of accounts or customers. This process creates all 
the records necessary to create the contract in the Oracle Utilities Data Repository. 

Enter Contract Details
After creating the contract, the next step is to review the details of the contract and make any 
necessary changes. Some specific tasks to be performed at this step include:

• Reviewing basic information concerning the contract on the Basics Tab

• Reviewing details for the contract’s accounts, customer, or service points on the Items Tab

• Selecting the appropriate Terms for the contract on the Terms Tab

• Selecting the appropriate documents for the contract on the Documents Tab

• Reviewing the contract approvals (once the Contract’s Status is In Approval) on the 
Approvals Tab

• Reviewing the history of the contract on the History Tab

• Reviewing any related contracts on the Related Contracts Tab

• Viewing any events or exceptions related to the contract on the Work Queue Detail Tab

View Contract Calculations
The next (optional) step is to actually view any calculations associated with the contract. This step 
uses the contract details (products and terms) to calculate values included in the contract.
11-2 Billing Component User’s Guide



Working with Contract Management
Submit/Revise/Terminate Contract
The next step(s) is based on your specific business processes, and can include submitting, revising, 
or terminating the contract, based on internal review or other factors (changes based on review 
from the counter party, etc.).

When you submit a contract, you create a formal contract that can be sent to the counter party for 
review and approval.

Execute Contract
The last step is to execute the contract, at which point the contract has been reviewed and 
approved by both parties (the contractee and the counter party), and has been signed.
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Chapter 12
Setting Up Contract Terms, Contract Products,

and Contract Types

Contract types are contract templates used to create contracts using the Oracle Utilities Billing 
Component - Contract Management application. Setting up contract types allows you to create 
default settings for different types of contracts, including default contract terms and contract 
products. This chapter describes how to set up contract terms, contract products, and contract 
types using Oracle Utilities Billing Component - Contract Management, including:

• Contract Terms and Products

• Contract Types
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Contract Terms and Products
Contract terms are specific conditions and/or circumstance required to perform contract 
calculations. For example, a contract might require a specific margin, a minimum monthly volume 
of usage, or a date from which prices are in effect. These types of details and conditions are stored 
as Terms in the Oracle Utilities Data Repository. Contract products are pricing structures and 
rates used in contract and pricing calculations. Each account included in an offer has an associated 
product.

Setting up contract terms and products involves creating records in the following tables in the 
Oracle Utilities Data Repository:

• Contract Products

• Terms

• Term Categories

• Templates

• Term Templates

Contract Products
Records in the Contract Product table represent individual products used in contract calculations.

Searching Contract Products
You can search for existing contract products in the Oracle Utilities Data Repository.

How to search contract products:

1. Select Contracts-›Contract Setup-›Contract Products (or Pricing and Contracts-
›Contract Setup-›Contract Products).

The Contract Product screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Product ID, Description, Start Time, Stop Time, or Rate Form 
associated with the contract product.

You can use the percent sign (“%”) as a wildcard character when entering values in the 
Product ID or Description fields. For instance, if you want to search for all products whose 
ID begins with the letter G, you could enter “G%” in the Product ID field. You can use this 
wildcard before or after specified letters or numbers (i.e. you would use %t to search for all 
products whose ID end with the letter t, etc.).

Note that Product IDs are case-insensitive. For example, there is no difference between the 
“Prod_1” and “prod_1” product IDs.

3. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 in the Oracle Utilities Energy 
Information Platform User’s Guide for more information.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To clear all the search fields, click Reset. To add a new 
record, click Add.

5. The search results appear on the Contract Product screen.

The Contract Product screen displays the following information for each product:

• Product ID
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• Description

• Start Time

• Stop Time

• Rate Form

6. To sort the results by one of the columns, click the appropriate arrow on the column heading. 
For example, to sort the results in ascending order by Product ID, click the “up” arrow on the 
Product ID column heading. See Sorting Search Results on page 2-7 in the Oracle Utilities 
Energy Information Platform User’s Guide for more information.

If there is more than one page of results, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field and press the Enter key.

7. To view a product click on the Product ID. The selected record will appear in the Contract 
Product screen.

8. To perform another search, click New Search. To refresh the contents of the screen, click 
the refresh icon.

Viewing and Editing Contract Products
Individual contract products are viewed on the Contract Product screen. This screen opens when 
you select a record from the Contract Product search results screen.

How to view and edit contract products:

1. Click on the Product ID link for the product you wish to view. The selected record opens on 
the Basics tab of the Contract Product screen.

This screen displays the following information for the selected record:

• Product ID: A unique id for the product.

• Description: A description of the product.

• Start Time: The start time of the product. This is the time after which the product is 
available for use in pricing calculations.

• Stop Time: The stop time of the product. This is the time before which the product is 
available for use in pricing calculations.

• Rate Form: The rate form that defines the product, from the Rate Form table.

2. Edit data in the fields as appropriate. To restore the record to its original state (before saving), 
click Reset.

3. To save changes made to the record, click Save.

4. To delete the current record, click Delete.
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Viewing and Editing Contract Product Terms
You can also view terms associated with the contract product.

How to view and edit contract product terms:

1. Click on the Terms tab of the Contract Product screen. The terms associated with the 
contract product appear on the Terms tab of the Contract Product screen.

If there is more than one page of terms, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field and press the Enter key.

The Terms tab displays the following information for each term associated with the Contract 
Product:

• Term Type: The term type for the product term, from the Term Type table.

• Start Time: The start time of the product term. This is the time after which the product 
term is available for use in pricing calculations.

• Standard: A flag that indicates if the product term is the “standard” product term for 
the product.

• Required: A flag that indicates if the product term is required for the product.

• Calculated: A flag that indicates if the product term is calculated.

• Default Text Value: Optional. The default text value of the product term, if applicable.

• Default Numeric Value: Optional. The default numeric value of the product term, if 
applicable.

• UOM: Optional. The unit-of-measure associated with the product term, from the Unit of 
Measure table.

• Default Date Value: Optional. The default date value of the product term, if applicable.

• Default Start Time: Optional. The default start time of the product term, if applicable.

• Default Stop Time: Optional. The default stop time of the product term, if applicable.

2. To filter the terms displayed by Term Category, select the desired category from the Term 
Category drop-down list. The default is to display All Terms.

3. To change the order in which the terms are listed, click on the  area and move the term 
to the appropriate position in the list. This also determines how the terms are ordered when 
the contract product is associated with a contract item on a contract.

4. To add a new product term, select the Term Category for the term you wish to add from the 
Term Category drop-down list, select the Term Type for the term you wish to add from the 
Term Type drop-down list, and click Add Term.

5. To delete a product term(s), check the corresponding checkbox(es) and click Delete Term.

6. To save changes, click Save.

7. To edit or view a specific product term, click on the Term Type for the term. The selected 
product term will appear on the Terms tab.

The Terms tab displays the following information for the selected product term:

• Product: The contract product, from the Contract Product table.

• Term: The term, from the Terms table.

• Start Time: The start time of the product term. This is the time after which the product 
term is available for use in pricing calculations.

• Stop Time: The stop time of the product term. This is the time before which the 
product term is available for use in pricing calculations.
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• Standard: A flag that indicates if the product term is the “standard” product term for 
the product.

• Required: A flag that indicates if the product term is required for the product.

• Default Start Time: Optional. The default start time of the product term, if applicable.

• Default Stop Time: Optional. The default stop time of the product term, if applicable.

• Default Text Value: Optional. The default text value of the product term, if applicable.

• Display Sequence: A number that indicates the sequence in which the product term is 
displayed on the Terms tab list, as well as on the terms list for contract items on a 
contract.

• Default Numeric Value: Optional. The default numeric value of the product term, if 
applicable.

• Default Date Value: Optional. The default date value of the product term, if applicable.

• Calculated: A flag that indicates if the product term is calculated.

8. Edit data in the fields as appropriate. To restore the record to its original state (before saving), 
click Reset.

9. To save changes made to the record, click Save.

10. To delete the current record, click Delete.

Adding Contract Products
You can also add new contract products.

How to add contract products:

1. Click Add on the Contract Product search screen. The Create Contract Product screen opens.

2. Enter an ID for the product in the Product ID field.

3. Enter an optional description of the product in the Description field.

4. Enter the start time and stop time of the product in the Start Time and Stop Time fields.

5. Select an optional rate form for the product in the Rate Form field.

6. To clear all the fields (before saving the record), click Reset.

7. To return to the search screen without adding a record, click Cancel.

8. To save the record, click Save. The new contract product appears on the screen.

Adding Contract Product Terms
You can also add terms associated with the contract product.

How to add contract product terms:

1. Click on the Terms tab of the Contract Product screen.

2. Select the Term Category for the term you wish to add from the Term Category drop-down 
list, select the Term Type for the term you wish to add from the Term Type drop-down list, 
and click Add Term.

3. To delete a product term(s), check the corresponding checkbox(es) and click Delete Term.

4. To change the order in which the terms are listed, click on the  area and move the term 
to the appropriate position in the list. This also determines the order in which the terms are 
displayed after being added to a contract item on a contract.

5. To save the product terms, click Save.
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Terms
As described above, terms are specific conditions and/or circumstances required to perform 
contract calculations.

Searching Terms
You can search for existing terms in the Oracle Utilities Data Repository.

How to search terms:

1. Select Contracts-›Contract Setup-›Terms (or Pricing and Contracts-›Contract Setup-
›Terms).

The Term screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Start Time, Stop Time, Term Type, Term Category, Term Status, 
Default Text Value, Default Start Time, Default Stop Time, UOM Code, Default Numeric 
Value, Default Date Value, or Style.

See Searching Database Tables on page 8-7 in the Oracle Utilities Energy Information Platform 
User’s Guide for more information about searching records, including the use of operands and 
wildcards.

3. Click Search to perform the search. To reset the search fields to their previous values, click 
Reset. To clear all the search fields, click Clear. To add a new record, click Add.

4. The search results appear on the Term list screen.

The Term list screen displays the following information for each record:

• UID

• Start Time

• Stop Time

• Term Type

• Term Category

• Term Status

• Default Text Value

• Default Start Time

• Default Stop Time

• UOM Code

• Default Numeric Value

• Default Date Value

5. To sort the results by one of the columns, click the appropriate column heading. For example, 
to sort the results by Start Time, click the Start Time column heading. If there is more than 

one page of results, you can move between pages using the  and  buttons. To change 
the number of results that appears on each page, enter the number in the Rows field.

6. To view a record, click on the corresponding [...] link. The selected record will appear in the 
Term screen.

7. To perform another search, click Search. To refresh the contents of the list screen, click the 
refresh icon.

8. Optional. To delete one or more records, check the check boxes corresponding to the records 
to be deleted, and click Delete. To clear all the checkboxes, click Clear.
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Viewing and Editing Terms
Individual Terms are viewed on the Term screen. This screen opens when you select a record 
from the Term search results screen.

How to view and edit terms:

1. Click on the [...] link for the Term you wish to view. The selected record opens in the Term 
screen.

The Term screen displays the following information for the selected record:

• UID: the unique ID for the record.

• Start Time: The start time of the term. This is the time after which the term is available 
for use in calculations.

• Stop Time: The stop time of the term. This is the time before which the term is 
available for use in calculations.

• Term Type: The term type for the term, from the Term Type table.

• Standard: A flag that indicates if the term is the “standard” product term for the 
product.

• Required: A flag that indicates if the term is required for the product.

• Calculated: A flag that indicates if the term is calculated.

• Default Text Value: Optional. The default text value of the term, if applicable.

• Default Numeric Value: Optional. The default numeric value of the term, if applicable.

• UOM: The unit-of-measure associated with the term, from the Unit of Measure table.

• Default Date Value: Optional. The default date value of the term, if applicable.

• Default Start Time: Optional. The default start time of the term.

• Default Stop Time: Optional. The default stop time of the term.

2. Edit data in the fields as appropriate. See Working with Data Types on page 8-4 in the 
Oracle Utilities Energy Information Platform User’s Guide for more information about editing data 
values.

3. To save changes made to the record, click Save. To save the edited record as a new record, 
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.

4. To perform a new search, click Search.

5. To open a list of records, click List.

6. To delete the current record, click Delete.
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Adding Terms
You can also add new Terms.

How to add terms:

1. Click Add on either the Term search or list screens. A blank Term screen opens.

2. Enter the start time and stop time for the term in the Start Time and Stop Time field.

3. Select the term type for the term in the Term Type field.

4. Select an optional term category for the term in the Term Category field.

5. Select an optional term status for the term in the Term Status field.

6. Enter an optional default text value in the Default Text Value field.

7. Enter an optional default start time and default stop time for the term in the Default Start 
Time and Default Stop Time field.

8. Enter an optional default numeric value in the Default Numeric Value field.

9. Enter an optional default date value in the Default Date Value field.

10. Enter an optional XSL string to define the user interface when entering values for the term in 
the Style field. Note: If using Templates do NOT populate this field.

11. To save the record, click Save. The new Term record appears on the screen.

Term Categories
Terms categories are categories of terms (such as product terms, or contract terms).

Searching Term Categories
You can search for existing term categories in the Oracle Utilities Data Repository.

How to search term categories:

1. Select Contracts-›Contract Setup-›Term Categories (or Pricing and Contracts-
›Contract Setup-›Term Categories).

The Term Category screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Term Category Code or Description.

See Searching Database Tables on page 8-7 in the Oracle Utilities Energy Information Platform 
User’s Guide for more information about searching records, including the use of operands and 
wildcards.

3. Click Search to perform the search. To reset the search fields to their previous values, click 
Reset. To clear all the search fields, click Clear. To add a new record, click Add.

4. The search results appear on the Term Category list screen.

The Term list screen displays the following information for each record:

• Term Category Code

• Description

5. To sort the results by one of the columns, click the appropriate column heading. For example, 
to sort the results by Term Category Code click the Term Category Code column heading. If 

there is more than one page of results, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field.
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6. To view a record, click on the corresponding [...] link. The selected record will appear in the 
Term screen. 

7. To perform another search, click Search. To refresh the contents of the list screen, click the 
refresh icon.

8. Optional. To delete one or more records, check the check boxes corresponding to the records 
to be deleted, and click Delete. To clear all the checkboxes, click Clear.

Viewing and Editing Term Categories
Individual Term Categories are viewed on the Term Category screen. This screen opens when you 
select a record from the Term Category search results screen.

How to view and edit term categories:

1. Click on the [...] link for the Term Category you wish to view. The selected record opens in 
the Term Category screen.

The Term Category screen displays the following information for the selected record:

• Term Category Code: The code for the term category.

• Description: a description of the term category.

2. Edit data in the fields as appropriate. See Working with Data Types on page 8-4 in the 
Oracle Utilities Energy Information Platform User’s Guide for more information about editing data 
values.

3. To save changes made to the record, click Save. To save the edited record as a new record, 
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.

4. To perform a new search, click Search.

5. To open a list of records, click List.

6. To delete the current record, click Delete.

Adding Term Categories
You can also add new term categories.

How to add term categories:

1. Click Add on either the Term Category search or list screens. A blank Term Category screen 
opens.

2. Enter a code for the term category in the Term Category Code field.

3. Enter an optional description of the term category in the Description field.

4. To save the record, click Save. The new Term Category record appears on the screen.
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Templates
Templates define sets of attributes and properties that define the user interface when entering 
values for terms used with Oracle Utilities Billing Component - Contract Management and Oracle 
Utilities Quotations Management. For example, if the terms used in contracts require an effective 
date value (stored in the Default Date Value field), you could create a template that defines a user 
interface screen that allows users to specify the effective date using a calendar control.

Searching Templates
You can search for existing templates in the Oracle Utilities Data Repository.

How to search templates:

1. Select Contracts-›Contract Setup-›Templates (or Pricing and Contracts-›Contract 
Setup-›Templates).

The Template screen opens.

2. Enter the search criteria in the Template Name field.

You can use the percent sign (“%”) as a wildcard character when entering values the Template 
Name field. For instance, if you want to search for all templates whose name begins with the 
letter G, you could enter “G%” in the Template Name field. You can use this wildcard before 
or after specified letters or numbers (i.e. you would use %t to search for all templates whose 
ID end with the letter t, etc.).

Note that Product IDs are case-sensitive. For example, there is a difference between the 
“Temp_1” and “temp_1” template names.

3. Specify how the search results are displayed.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To add a new record, click Add.

5. The search results appear on the Template screen.

The Template screen displays the following information for each product:

• UID

• Template Name

6. If there is more than one page of results, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field and press the Enter key.

7. To view a template click on the Template Name. The selected record will appear in the 
Template screen. 

8. Optional. To delete one or more records, check the check boxes corresponding to the records 
to be deleted, and click Delete. 

9. To perform another search, click New Search. To refresh the contents of the screen, click 
the refresh icon.
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Viewing and Editing Templates
Individual templates are viewed on the Template screen. This screen opens when you select a 
record from the Template search results screen.

How to view and edit templates:

1. Click on the Template Name link for the template you wish to view. The selected record 
opens on the Template screen.

This screen displays the following information for the selected record:

• Template Name: A unique id for the template.

• Rate Code: The rate form code associated with the template.

• Operating Company: The operating company associated with the template.

• Jurisdiction: The jurisdiction associated with the template.

• Attributes Properties: The attributes and properties that define the user interface when 
entering values for the term. Each attribute is defined by the following:

• Attribute Name: The name of the column on the Terms table where the values for 
the term are stored. Can be STARTTIME, STOPTIME, VAL (Default Text Value), 
VULNUM (Default Numeric Value), or VALDATE (Default Date Value).

• Attribute Type: The type of attribute. Can be string, date, datetime, monthyear, 
long, double, boolean, lookup, or enumeration.

• Caption: The caption that appears on the user interface when entering values for 
the term.

• Properties: Click the plus (“+”) in the far left column to display specific properties 
for the attribute. 

• Script Document: A expandable text box that defines Javascript validations and/or 
business rules related to values entered for the term. Click the Script Document plus 
(“+”) sign to open the text box.

2. Edit data in the fields as appropriate. To restore the record to its original state (before saving), 
click Reset.

3. To add an attribute, click Add. Enter the attribute name in the Attribute Name column, 
select the attribute type from the Attribute Type drop-down list, and enter the label for the 
attribute in the Caption column.

4. To delete an attribute(s), check the corresponding checkbox(es) and click Delete.

5. To edit the Script Document, click the Script Document plus (“+”) sign to open the text 
box and edit the script as appropriate.

6. To save changes made to the record, click Save.

Editing Attribute Properties
The data values defined in a template are called attributes, and each can be one of the following 
types:

• String (xs:string): A string (can contain letters or numbers)

• Date (xs:date): A date (e.g. 12/19/2005)

• DateTime (xs:dateTime): A date and time (e.g. 12/19/2005 16:03:45))

• Bill Month (xs:MonthYear): A bill month (12/2005). Note: when used with a date or date 
time field, bill months are converted to the first day of the selected month.

• Long (xs:long): A long integer

• Double (xs:double): 
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• Boolean (xs:boolean): A boolean value (indicated by a checkbox on the user interface)

• Lookup (ls:lookup): A lookup value from a table in the Oracle Utilities Data Repository

• Drop-down list (ls:enumeration): A drop-down list of possible values

Term attributes correspond to one of the following columns on the Term table:

• Start Time (STARTTIME): The start time of the term. This is the time after which the term 
is available for use in calculations (Date or DateTime attribute types). 

• Stop Time (STOPTIME): The stop time of the term. This is the time before which the term 
is available for use in calculations (Date or DateTime attribute types).

• Default Text Value (VAL): The default text value of the term (String, Long, or Double 
attribute types).

• Default Numeric Value (VALNUM): The default numeric value of the term (Long or 
Double attribute types).

• Default Date Value (VALDATE): The default date value of the term (Date or DateTime 
attribute types).

Templates can contain up to five attributes (one for each of the columns in the Terms table 
described above). Templates can be used with multiple terms. For example, you might create a 
“Start_Stop” template that defines Start Time and Stop Time attributes that can be used for all 
terms that use Start Time and Stop Time values. Likewise, a “Start_Stop_Value” template could be 
used for all terms that use values for Start Time, Stop Time, and Value.

In addition to the Attribute Name, Attribute Type, and Caption, attributes also have other 
properties that can be defined. These properties help define default values for attributes, the 
values available with drop-down list attributes, and other parameters.

There are four types of attribute properties:

Common properties define some default behavior for the attribute, including:

• Default Value: The default value of the attribute. This default is overridden if a default value 
is specified for the Term. Note: Default values for Date and DateTime attributes must be in 
the “YYYY-MM-DD HH:mm:ss” format.

• Is Required: A flag that designates (Yes or No) whether or not the attribute is required.

• Is Visible: A flag that designates (Yes or No) whether or not the attribute is visible on the 
user interface.

• Is Disabled: A flag that designates (Yes or No) whether or not the attribute is accessible by 
the user from the user interface.

Event properties allow Javascript or Javascript functions to be called, and include:

• Event: The name of the event to trigger the script or call the function.

• Function Name: The name of the function called by the event.

• Script: The Javascript called by the event.

Entity properties define lookup attributes, including:

• Table Name: The name of the table in the Oracle Utilities Data Repository that is used by 
the lookup

• IsUID: A flag that designates (Yes or No) if the lookup field is a UID.

• Entity Fields: Filters applied to the lookup. To apply a filter, enter the column name in the 
left column, select the appropriate operand, and enter the filtering value in the right column.

Enumeration properties define drop-down lists.
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To add an entry to the drop-down list, click Add, enter the value in the left column, and the label 
in the right column. For example, to create a drop-down list that displays Yes (value = Y) and No 
(value = N), you would create the following entries:

To delete an entry (or entries), check the corresponding checkbox(es) and click Delete.

Adding Templates
You can also add new templates.

How to add templates:

1. Click Add on either the Template search or list screens. A blank Template screen opens.

2. Enter a name for the template in the Template field.

3. Enter an optional rate form code for the template in the Rate Code field.

4. Enter an optional operating company for the template in the Operating Company field.

5. Enter an optional jurisdiction for the template in the Jursidiction field.

6. Add attributes for the template in the Attributes Properties box. Each attribute is defined 
by the following:

• Attribute Name: The name of the column on the Terms table where the values for the 
term are stored. Can be STARTTIME, STOPTIME, VAL (Default Text Value), 
VULNUM (Default Numeric Value), or VALDATE (Default Date Value).

• Attribute Type: The type of attribute. Can be string, date, datetime, monthyear, long, 
double, boolean, lookup, or enumeration.

• Caption: The caption that appears on the  the user interface when entering values for 
the term.

• Properties: Click the plus (“+”) in the far left column to enter specific properties for the 
attribute.

7. Add an optional Javascript document for the template by clicking the Script Document plus 
(“+”) sign and entering the Javascript in the text box.

8. To save the record, click Save. The new Template record appears on the screen.

Left Column Right Column

Y Yes

N No
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Term Templates
Term templates define relationships between terms and templates. Note that a term can only be 
associated to a single template. However, templates may be associated to multiple terms.

Searching Term Templates
You can search for existing term templates in the Oracle Utilities Data Repository.

How to search term templates:

1. Select Contracts-›Contract Setup-›Term Templates (or Pricing and Contracts-
›Contract Setup-›Term Templates)

The Term GUI XSD screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Term or GUI XSD.

See Searching Database Tables on page 8-7 in the Oracle Utilities Energy Information Platform 
User’s Guide for more information about searching records, including the use of operands and 
wildcards.

3. Click Search to perform the search. To reset the search fields to their previous values, click 
Reset. To clear all the search fields, click Clear. To add a new record, click Add.

4. The search results appear on the Term GUI XSD list screen.

The Term GUI XSD list screen displays the following information for each record:

• Term

• GUI XSD (template)

5. To sort the results by one of the columns, click the appropriate column heading. For example, 
to sort the results by Term click the Term column heading. If there is more than one page of 

results, you can move between pages using the  and  buttons. To change the number of 
results that appears on each page, enter the number in the Rows field.

6. To view a record, click on the corresponding [...] link. The selected record will appear in the 
Term screen.

7. To perform another search, click Search. To refresh the contents of the list screen, click the 
refresh icon.

8. Optional. To delete one or more records, check the check boxes corresponding to the records 
to be deleted, and click Delete. To clear all the checkboxes, click Clear.

Viewing and Editing Term Templates
Individual term templates are viewed in the Term GUI XSD screen. This screen opens when you 
select a record from the Term Category search results screen.

How to view and edit term templates:

1. Click on the [...] link for the Term GUI XSD record you wish to view. The selected record 
opens in the Term GUI XSD screen.

The Term GUI XSD screen displays the following information for the selected record:

• Term: The term.

• GUI XSD: The template associated with the term..

2. Edit data in the fields as appropriate. See Working with Data Types on page 8-4 in the 
Oracle Utilities Energy Information Platform User’s Guide for more information about editing data 
values.
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3. To save changes made to the record, click Save. To save the edited record as a new record, 
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.

4. To perform a new search, click Search.

5. To open a list of records, click List.

6. To delete the current record, click Delete.

Adding Term Templates
You can also add new term templates.

How to add term templates:

1. Click Add on either the Term GUI XSD search or list screens. A blank Term GUI XSD 
screen opens.

2. Select the term for the record in the Term field.

3. Select the templates for the record in the GUI XSD field.

4. To save the record, click Save. The new Term GUI XSD record appears on the screen.
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Contract Types
Contract types are contract templates used to create contracts using the Oracle Utilities Billing 
Component - Contract Management application. Setting up contract types allows you create 
default settings for different types of contracts. This section describes how to work with contract 
types with Oracle Utilities Billing Component - Contract Management and Oracle Utilities 
Quotations Management, including:

• Searching Contract Types

• Creating Contract Types

• Viewing Contract Types

Searching Contract Types
The Contract Types option allows users to search contract types in the Oracle Utilities Data 
Repository based on user-specified search criteria.

How to search contract types:

1. Select Contracts-›Contract Setup-›Contract Types (or Pricing and Contracts-›Contract 
Setup-›Contract Types).

The Contract Type screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Contract Type, Contractee ID, Description, Contract Category, 
Start Time, Stop Time, and Work Queue Type associated with the Contract Type. To enter a 
date, click the arrow and select the date using the calendar control or enter the data manually.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
text fields. For instance, if you want to search for all contract types whose contractee ID 
begins with the letter G, you could enter “G%” in the Contractee ID field. You can use this 
wildcard before or after specified letters or numbers (i.e. you would use %t to search for all 
contract types whose contractee ID end with the letter t, etc.).

Note that Contractee IDs are case-insensitive. For example, there is no difference between 
the “Acct_1” and “acct_1” contractee IDs.

3. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 in the Oracle Utilities Energy 
Information Platform User’s Guide for more information.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To clear all the search fields, click Reset. To add a new 
contract type, click Add.

5. The search results appear on the Contract Type result screen.

The Contract Type result screen displays the following information for each contract type:

• Contractee ID

• Contract Type

• Description

• Contract Category

• Start Time

• Stop Time
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• Work Queue Type

6. If there is more than one page of results, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field. 

7. To view a contract type, click the Contract Type link. The selected contract type appears in 
the Contract Type screen.

8. To perform another search, click New Search.

Creating Contract Types
How to create a new contract type:

1. Click Add on the Contract Types screen. The Create Contract Type screen opens.

2. Enter a code for the contract type in the Contract Type Code field.

3. Select a Contractee ID using the Browse button ( ). This button opens a dialog window 

that lists all the available contractees. Click the [...] link for the appropriate contractee. The 
field is automatically populated.

4. Enter an optional description for the contract type in the Description field.

5. Select an optional Contract Category using the Browse button ( ). This button opens a 

dialog window that lists all the available categories. Click the [...] link for the appropriate 
category. The field is automatically populated.

6. Enter an optional Start Time for the contract type. To enter a date and time, enter the date 
and time manually or click the arrow and select the date using the calendar control.

7. Enter an optional Stop Time for the contract type. To enter a date and time, enter the date 
and time manually or click the arrow and select the date using the calendar control.

8. For contract types that require an approval process, enter a Work Queue Type using the 

Browse button ( ). This button opens a dialog window that lists all the available work 

queue types. Click the [...] link for the appropriate work queue type. The field is automatically 
populated.

9. Select an optional Rate Form using the Browse button ( ). This button opens a dialog 

window that lists all the available rate forms. Click the [...] link for the appropriate rate form. 
The field is automatically populated. This rate form (of type RIDER) should contain 
Contract Type-specific business logic. 

10. Click Create to create the Contract Type. To clear all the fields, click Reset. To return the 
previous screen, click Cancel.

The contract type appears in the Contract Type screen. 
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Viewing Contract Types
Contract types are viewed from the Contract Type screen. This screen opens when you select a 
contract type from the Contract Type Result screen, or when you first create an contract type. The 
Contract Type screen includes five tabs:

• Basics Tab

• Terms Tab

• Documents Tab

• Approvals Tab

• Reports Tab

Basics Tab
The Basics tab displays basic information about the contract type, including:

• Contract Type: The contract type code.

• Contractee ID: The contractee ID for the contract type.

• Description: A short description of the contract type.

• Contract Category: The contract category for the contract type.

• Start Time: The start date for the contract type.

• Stop Time: The stop date for the contract type.

• Rate Form: An optional rate form (of type RIDER) associated with the contract type that 
contains contract type-specific business logic.

You can modify any of the fields on this tab.

• To modify the Contract Type, edit the field as appropriate.

• To modify the Contractee ID, use the Browse button ( ). This button opens a dialog 

window that lists all the available contractee IDs. Click the [...] link for the appropriate 
record. The field is automatically populated.

• To modify the Description, edit the field as appropriate.

• To modify the Contract Category, use the Browse button ( ). This button opens a dialog 

window that lists all the available categories. Click the [...] link for the appropriate category. 
The field is automatically populated.

• To modify the Start Time, enter the date and time manually or click the arrow and select the 
date using the calendar control.

• To modify the Stop Time, enter the date and time manually or click the arrow and select the 
date using the calendar control.

• To modify the optional Rate Form, use the Browse button ( ). This button opens a dialog 

window that lists all the available rate form. Click the [...] link for the appropriate record. The 
field is automatically populated.

Click Save to save the changes. To delete the contract type, click Delete. To reset the contract type 
to the previously saved version, click Reset.
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Terms Tab
The Terms tab displays the following information for each term associated with the contract type:

• Term Type: The term type for the term, for this contract type.

• Start Time: The start time for the term, for this contract type.

• Standard: A flag that indicates if the term should be considered standard for the contract 
type.

• Required: A flag that indicates if the term is required for the contract type.

• Calculated: A flag that indicates if the term is calculated for the contract type.

• Summary: 

• Default Text Value: The default text value for the term, for this contract type.

• Default Numeric Value: The default numeric value for the term, for this contract type.

• UOM: The unit-of-measure associated with the product term, from the Unit of Measure 
table.

• Default Date Value: The default date value for the term, for this contract type.

• Default Start Time: The default start time for the term, for this contract type.

• Default Stop Time: The default stop time for the term, for this contract type.

How to change the order of terms:

1. Click on the  area of the term you wish to move and move the term to the appropriate 
position in the list.

2. Click Save to save your changes.

How to modify a term:

1. Click the Term Type link. The selected term type appears on the Terms tab.

2. To modify the Start Time, enter the date and time manually or click the arrow and select the 
date using the calendar control.

3. To modify the Stop Time, enter the date and time manually or click the arrow and select the 
date using the calendar control.

4. To modify the Standard, Required, or Calculated flags, select the desired value from the 
drop-down list.

5. To modify the Default Text Value, edit the value as appropriate.

6. To modify the Default Start Time, enter the date manually or click the arrow and select the 
date using the calendar control.

7. To modify the Default Stop Time, enter the date manually or click the arrow and select the 
date using the calendar control.

8. To modify the Display Sequence, change the number as appropriate.

9. To modify the Default Numeric Value, edit the value as appropriate.

10. To modify the Default Date Value, enter the date manually or click the arrow and select the 
date using the calendar control.

11. Click Save to save the modified term. To reset the term to the previously saved version, click 
Reset. To return to the list of contract type terms without saving changes, click Cancel.
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How to add a term to a contract type:

1. Select the Term Category for the term you wish to add from the Term Category drop-down 
list (from the Term Category table), select the Term Type for the term you wish to add from 
the Term Type drop-down list (from the Terms table), and click Add Term Type. The 
selected term type appears on the Terms tab.

2. To modify the term type, click the Term Type link. The term type appears on the Terms tab.

3. Click Save to save your changes.

How to delete a term from a contract type:

1. Check the checkbox in the far left column for the term type you wish to delete and click 
Delete Term Type. The term type will no longer appear on the Terms tab.

Documents Tab
The Documents tab displays the following information for each document type associated with 
the contract type:

• Document Type: The type of the document.

• Standard: A flag that indicates if the document type should be considered standard for the 
contract type.

• Required: A flag that indicates if the document type is required for the contract type.

How to modify a document type:

1. Click the Document Type link. The selected document type appears on the Documents tab.

2. To select an optional Document Category, use the Browse button ( ). This button opens 

a dialog window that lists all the available categories. Click the [...] link for the appropriate 
category. The field is automatically populated.

3. To modify the Standard flag, select the desired value from the drop-down list.

4. To modify the Start Time, enter the date manually or click the arrow and select the date 
using the calendar control.

5. To modify the Stop Time, enter the date manually or click the arrow and select the date using 
the calendar control.

6. To modify the Required flag, select the desired value from the drop-down list.

7. Click Save to save the modified document type. To reset the document type to the previously 
saved version, click Reset. To return to the list of contract type documents without saving 
changes, click Cancel.

How to add a document type to a contract type:

1. Select the document type from the Choose Document Type drop-down list (from the 
Document Type table), and click Add Document Type. The selected document type appear 
on the Documents tab.

2. To modify the document type, click the Document Type link. The document type appears 
on the Documents tab.

3. Edit the data as appropriate and click Save.

How to delete a document from a contract type:

1. Check the checkbox in the far left column for the document type you wish to delete and click 
Delete Document Type. The document type will no longer appear on the Documents tab.
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Approvals Tab
The Approvals tab displays the Work Queue Type (and related Approval Procedure) associated to 
the contract type (if any), including the following information:

• Work Queue Type: The work queue type associated to the contract type.

• Approval Process: The Approval Procedure associated with the Work Queue Type.

• Description: A description of the Approval Procedure associated with the Work Queue 
Type.

• Approval Steps: A table outlining the approval steps that comprise the approval procedure, 
including:

• Step Number: The step number for the approval step.

• Number of Approvals: The number of approval required for the approval step.

• Approval Level Code: The approval level for the approval step.

How to add a work queue type or change an existing work queue type:

1. Click the Browse button ( ). This button opens a dialog window that lists all the available 

work queue types. Click the [...] link for the appropriate record. The screen is automatically 
populated with the appropriate data.

2. Click Save to save the approval.

3. To delete the approval, click Delete.

Reports Tab
The Reports tab lists any substitute reports used when viewing calculation and/or contracts for 
contracts of this contract type, including the following information:

• Report Name: The name of the report for which a substitute report template will be used. 
Can be either ViewCalculations or ViewContract.

• Start Time: The start of the relationship between the Report Name and the Substitute 
Report Name.

• Stop Time: The stop of the relationship between the Report Name and the Substitute 
Report Name.

• Substitute Report Name: The name of the report template used as a substitute for the 
report.

How to modify a substitute report:

1. Click the Report Name link. The selected report appears on the Reports tab.

2. To modify the Report Name, select the appropriate report (ViewCalculations or 
ViewContract) from the Report Name drop-down list.

3. To modify the Start Time, enter the date manually or click the arrow and select the date 
using the calendar control.

4. To modify the Stop Time, enter the date manually or click the arrow and select the date using 
the calendar control.

5. To select a different Substitute Report Name, use the Browse button ( ). This button 

opens a dialog window that lists all the available report templates. Click the [...] link for the 
appropriate report template. The field is automatically populated.

6. Click Save to save the modified report. To reset the report to the previously saved version, 
click Reset. To return to the list of contract type reports without saving changes, click 
Cancel.
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How to add a substitute report to a contract type: 

1. Click Add on the Reports tab. A blank report screen appears on the Reports tab.

2. Select the report (ViewCalculations or ViewContract) for which a substitute report template 
will be used from the Report Name drop-down list.

3. Enter the Start Time by either entering date manually or clicking the arrow and selecting the 
date using the calendar control.

4. Enter the Stop Time by either entering date manually or clicking the arrow and selecting the 
date using the calendar control.

5. Select the Substitute Report Name by clicking the Browse button ( ). This button opens 

a dialog window that lists all the available report templates. Click the [...] link for the 
appropriate report template. The field is automatically populated.

How to delete a substitute report from a contract type:

1. Check the checkbox in the far left column for the report you wish to delete and click Delete. 
The report will no longer appear on the Reports tab.
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Chapter 13
Working with Contracts

This chapter describes how you work with and manage contracts with Oracle Utilities Billing 
Component - Contract Management, including:

• Searching Contracts

• Creating Contracts

• Viewing Contracts

• Contract Actions
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Searching Contracts
The Contracts option allows users to search for contracts in the Oracle Utilities Data Repository 
based on user-specified search criteria.

How to search contracts:

1. Select Contracts-›Contracts (or Pricing and Contracts-›Contracts).

The Contracts screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Contract ID, Contains Service Point ID (if Service Points are 
enabled) Contains Customer ID, Contract Description, Contain Account ID, Start Time, Stop 
Time, Contractee ID, Date Created, Contract Type, Date Submitted, Contract Status, Date 
Executed, Contract Category, Date Approved, Parent Contract ID, Date Terminated, 
External Contract Status, Valid Until, Margin, or Cost of Good Sold. To enter a date, click the 
arrow and select the date using the calendar control or enter the data manually.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
text fields. For instance, if you want to search for all pricing contracts whose ID begins with 
the letter G, you could enter “G%” in the Contract ID field. You can use this wildcard before 
or after specified letters or numbers (i.e. you would use %t to search for all pricing contracts 
whose ID end with the letter t, etc.).

Note that Contract IDs, Contractee IDs, and Counter Party IDs are case-insensitive. For 
example, there is no difference between the “Acct_1” and “acct_1” contract IDs.

3. Specify how the search results are displayed. 

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 in the Oracle Utilities Energy 
Information Platform User’s Guide for more information.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To clear all the search fields, click Reset.

5. The search results appear on the Contract Search Result screen.

The Contract Search Result screen displays the following information for each pricing 
contract:

• Contract ID

• Contract Description

• Contract Type

• Start Time

• Stop Time

• Contract Category

• Contract Status

• External Status

• Date Created

• Contractee ID

• Counter Party ID

• Parent Contract ID

• Date Submitted
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• Date Approved

• Date Executed

• Date Terminated

• Valid Until

• Margin

• Cost of Good Sold

6. If there is more than one page of results, you can move between pages using the  and  
buttons. To change the number of results that appears on each page, enter the number in the 
Rows field.

7. To view a contract, click Contract ID link. The selected contract appears in the Contract 
screen. 

8. To perform another search, click New Search.
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Creating Contracts
How to create a new contract:

1. Click Add on the Contracts screen. The Create Contract screen opens.

2. Enter a Contractee ID using the Browse button ( ). This button opens a dialog window 

that lists all the available contractee IDs. Click the [...] link for the appropriate contractee ID. 
The field is automatically populated.

3. Select a Counter Party ID for the contract. The counter party ID can be either an individual 
Account, Customer, or Service Point, or a list of Accounts or Customers.

Note: If using Contract Item Groups, the Counter Party ID field may be hidden.

4. Select Account, Customer, or Service Point for the counter party from the drop-down list. 
To select an account, customer, or service point, proceed with steps 5 through 12. To select a 
list of accounts or customers, skip to steps 13 through 20.

Note: Selecting a Service Point as the Counter Party is only available if the use of service 
points with contracts is enabled.

5. To select an account, customer, or service point, select ID from the drop-down list and click 

the Browse button ( ). The Accounts (or Customers or Service Points) window opens.

If there is more than one page of records, you can move between pages using the  and . 

buttons. Use the  button to return the first page, and the   button to navigate to the 
last page. To change the number of results that appears on each page, enter the number in the 
Rows field.

To search for a specific record, click Search. The dialog displays a search screen. Enter the 
appropriate parameters for your search and click Search. The dialog will display a list of 
records that match the search criteria.

6. To select an account, customer, or service point, click on the [...] link. The selected Account 
(or Customer or Service Point) ID will appear in the Counter Party field.

7. To select a list of accounts or customers, select List from the drop-down list and click the 

Browse button ( ). The Lists window opens.

If there is more than one page of records, you can move between pages using the  and . 

buttons. Use the  button to return the first page, and the   button to navigate to the 
last page. To change the number of results that appears on each page, enter the number in the 
Rows field.

To search for a specific record, click Search. The dialog displays a search screen. Enter the 
appropriate parameters for your search and click Search. The dialog will display a list of 
records that match the search criteria.

8. To select a list, click the [...] link. The selected list will appear in the Counter Party field.

9. Enter a Contract ID.

Note: If using automatic generation of contract IDs, the Contract ID field is not visible.

10. Enter a Contract Description.

11. Enter a Contract Type using the Browse button ( ). This button opens a dialog window 

that lists all the available types for the selected Contractee ID. Click the [...] link for the 
appropriate type. The field is automatically populated.

12. Select a Contract Category from the drop-down list.
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13. Enter a Start Time for the contract. To enter a date, enter the date manually or click the 
arrow and select the date using the calendar control.

14. Enter a Stop Time for the contract. To enter a date, enter the date manually or click the 
arrow and select the date using the calendar control.

15. Click Create to create the contract. The Process window appears.

When the contract has successfully been created, it appears in the Contract screen.
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Viewing Contracts
Contracts are viewed from the Contract screen. This window opens when you select a contract 
from the Contract Search Results screen, or when you first create a contract. 

The Contract window includes seven tabs:

• Basics Tab

• Items Tab

• Terms Tab

• Documents Tab

• Approvals Tab

• History Tab

• Related Contracts Tab

The Contract window also contains the following (read-only)information about the contract 
(above the tabs):

• Contract ID: The contract ID.

• Revision #: The revision number of the contract.

• Status: The current status of the contract.

Basics Tab
The Basics tab displays basic information about the contract, including:

• Contractee ID: The contractee ID. Read-only.

• Description: Description of the contract.

• Start Time: The start time of the contract.

• Stop Time: The stop time of the contract.

• Counter Party ID: The counter party ID. Read-only. The Counter Party ID is displayed 
according to the following rules:

• If the contract is based on a list of accounts/customers, the Counter Party ID is the list 
name.

• If the contract is based on a single account, customer, or service point, the Counter Party 
ID is the ID of the account, customer, or service point.

• If the contract is based on multiple accounts associated with a single customer, the 
Counter Party ID is the Customer ID.

• Date Created: The date the contract was created. Read-only. 

• Contract Type: The contract type. Read-only.

• Date Submitted: The date the contract was submitted. Read-only. 

• External Contract Status: The external status of the contract.

• Date Approved: The date the contract was approved. Read-only.

• Contract Category: The contract’s category (contract, subcontract, amendment, offer, etc.). 
Read-only.

• Date Executed: The date the contract was executed. Read-only. 

• Parent Contract ID: The ID of the contract’s parent contract, if applicable. 
13-6 Billing Component User’s Guide



Viewing Contracts
• Date Terminated: The date the contract was terminated. Read-only.

• Margin: The margin on the contract.

• Valid Until: The date the contract is valid until. This is required for calculating an contract.

• Cost of Goods Sold: The Cost of Goods Sold (COGS) for the contract.

How to modify contract basics:

You can modify the Description, External Contract Status, Parent Contract ID, Margin, and 
Cost of Goods Sold of a contract.

1. To change the Description, edit the text as appropriate.

2. To change the External Contract Status select the appropriate value from the drop-down 
list.

3. To change the Parent Contract ID, click the Browse button ( ). This button opens a 

dialog window that lists all the available contracts that can be parents to the current contract. 
Click the [...] link for the appropriate contract. The field is automatically populated.

4. To change the Margin or Cost of Good Sold, edit the field as appropriate.

5. To save changes made on this tab, select Save from the Actions drop-down list.

6. To save the changes and add comments, select Save w/Comments from the Actions drop-
down list.

The Script Prompt dialog opens.

7. Enter the comment and click OK. To close the window without saving changes, click Cancel.

The comment appears on the History Tab.

The Basics tab can only be modified when the contract’s status is In Process.
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Items Tab
The Items tab displays information about the individual accounts or service points associated with 
the contract. There are two versions of the Items tab, one that displays the individual items (Items 
View), and one that displays groupings of items (Groups View). Contract Item Groups allow users 
to apply terms common to groups of contract items (accounts or service points) rather than 
having to apply the same terms to each account or service point individually. This can save 
consider time when creating, updating, and altering contracts. The specific version of the Items 
tab that appears on the Contract screen is based on the security privileges of the user. When 
Contract Item Groups are disabled, the Items View is displayed. When Contract Item Groups are 
enabled, the Group View is displayed.

Items View
The Items View of the Items tab displays the following information for each individual account or 
service point associated with the contract:

• Service Point ID: The service point ID.

• Customer ID: The customer ID (not displayed for Service Points).

• Account ID: The account ID (not displayed for Service Points).

• Account Name: The name of the account (not displayed for Service Points).

• Commodity: The commodity (Electric, Gas, etc.) the contract is based on.

• Usage Forecast: The usage forecast used when calculating the contract (Oracle Utilities 
Quotations Management only).

• Usage Status: The status of usage stored for the contract item (Oracle Utilities Quotations 
Management only).

• Terms: A link that provides access to the terms associated with the contract item for the 
contract.

• Product: The product associated with the contract item for the contract.

• Product Terms: A link that provides access to the specific terms for the selected product.

For each contract item, you can change the Usage Forecast, Terms, Product, and Product Terms. 
You can also add and/or remove accounts or service points.

How to add contract items (accounts or service points) to a contract:

1. Click Add Account (or Add Service Point).

The Accounts (or Service Points) window opens.

Enter the search criteria and click Search. See Searching and Viewing Data on page 2-7 for 
more information about searching records.

The search results appear on the Accounts (or Service Points) window.

2. Select the accounts (or service points) you wish to add to the contract by checking the 
corresponding checkboxes.

3. Click Save.

The selected accounts (or service points) will appear on the Items tab.

How remove contract items from a contract.

1. Select the accounts (or service points) you wish to remove from the contract by checking the 
corresponding checkboxes.

2. Click Delete Item.
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How to change the usage forecast for a contract item  (Oracle Utilities Quotations 
Management only):

1. Click the Usage Forecast link for the contract item. The Forecast Options window opens.

2. Select the appropriate usage forecast from those listed under Forecast ID. The selected 
forecast will appear in the Usage Forecast column for the contract item. To close the window 
without making a select, click Cancel.

If the contract item has no forecasts associated with it, the only (default) option is Automatic. 
This means that Oracle Utilities Quotations Management will create a forecast based on the 
contract item’s usage. See Chapter 3: Working with Forecasts and Chapter 4: Validating 
Usage in the Oracle Utilities Quotations Management User’s Guide for more information about 
forecasts and usage.

Usage forecasts can only be modified when the contract’s status is In Process.

How to change the terms for a contract item:

1. Click the Terms link for the contract item. The Contract Item Terms window opens.

This window displays the specific terms for the contract item (if any), including the following 
for each:

• Term Type: The Term Type for the contract item term.

• Text Value: The text value (if any) for the contract item term.

• Numeric Value: The numeric value (if any) for the contract item term.

• UOM: The unit of measure associated with the contract item term (if applicable)

• Date Value: The date value (if any) for the contract item term.

• Status: The status of the contract item term.

2. To add a term, select the term category from the All Terms drop-down list, select the term 
type of the term to add from the Choose Term drop-down list, and click Add Term. The 
selected term appears on the Contract Item Terms window.

3. To edit an individual term, click the Term Type link.

The selected term appears in the Contract Item Terms window.

To reset the fields to their default values, click Set Default. Edit the values for the term as 
needed and click Save. To reset the fields to their default values, click Set Default. To reset 
the fields to their original values, click Reset. To close the window without saving changes, 
click Cancel.

4. To edit all contract item terms, select Contract from the All Terms dorp-down list, and click 
the Edit All.

The Contract Item Terms window displays all the current terms. This window allows users to 
edit values for multiple terms on a single screen.

To reset the fields for all terms to their default values, click Set Default. Edit the values for 
each term as needed and click Save. To reset the fields for all terms to their default values, 
click Set Default. To reset the fields for all terms to their original values, click Reset. To close 
the window without saving changes, click Cancel.

5. To delete a contract item term, select the term(s) you wish to delete by checking the 
corresponding checkboxes and click Delete Term. The term will no longer appear on the 
Contract Item Terms window.

6. To apply the selected contract items terms to this contract item, click Apply Items Terms. 
This option requires customized configuration.

7. To close the Contract Item Terms window and return to the Items tab, click Close.
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Contract Item Terms can only be modified when the contract’s status is In Process.

How to change the product for a contract item:

1. Click the Product link for the contract item. The Product Options window opens.

2. Select the appropriate product from those listed under Product. The selected product will 
appear in the Product column for the contract item. To close the window without making a 
select, click Cancel.

Products can only be modified when the contract’s status is In Process.

How to change the product terms for a contract item:

1. Click the Product Terms link for the contract item. The Contract Product Terms window 
opens.

This window displays the specific terms for the product (if any), including the following for 
each:

• Term Type: The Term Type for the contract product term.

• Text Value: The text value (if any) for the contract product term.

• Numeric Value: The numeric value (if any) for the contract product term.

• UOM: The unit of measure associated with the contract product term (if applicable)

• Date Value: The date value (if any) for the contract product term.

• Status: The status of the contract product term.

2. To add a term, select the term category from the All Terms drop-down list, select the term 
type of the term to add from the Choose Term drop-down list, and click Add Term. The 
selected term appears on the Contract Product Terms window.

3. To edit an individual term, click the Term Type link.

The selected term appears in the Contract Product Terms window.

To reset the fields to their default values, click Set Default. Edit the values for the term as 
needed and click Save. To reset the fields to their default values, click Set Default. To reset 
the fields to their original values, click Reset. To close the window without saving changes, 
click Cancel.

4. To edit all contract product terms, select Product from the All Terms dorp-down list, and 
click the Edit All.

The Contract Product Terms window displays all the current terms. This window allows users 
to edit values for multiple terms on a single screen.

To reset the fields for all terms to their default values, click Set Default. Edit the values for 
each term as needed and click Save. To reset the fields for all terms to their default values, 
click Set Default. To reset the fields for all terms to their original values, click Reset. To close 
the window without saving changes, click Cancel.

5. To delete a contract product term, select the term(s) you wish to delete by checking the 
corresponding checkboxes and click Delete Term. The term will no longer appear on the 
Contract Product Terms window.

6. To apply the selected product terms to this product for all contract items on the contract that 
have the product associated to them, click Apply Product Terms. This option requires 
customized configuration.

7. To close the Contract Product Terms window and return to the Items tab, click Close.

Contract Product Terms can only be modified when the contract’s status is In Process.

Note that there are no product terms associated with the default product.
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Group View
The Group View of the Items tab can list information about contract items by Service Point or by 
Group.

Viewing by Service Points
When viewing by service point, this tab displays the following information for each service point 
associated with the contract:

• Service Point ID: The service point ID.

• Commodity: The commodity (Electric, Gas, etc.) the contract is based on.

• Usage Forecast: The usage forecast used when calculating the contract (Oracle Utilities 
Quotations Management only).

• Usage Status: The status of usage stored for the service point (Oracle Utilities Quotations 
Management only).

• Terms: A link that provides access to the terms associated with the service point for the 
contract.

• Product: The product associated with the service point for the contract.

• Product Terms: A link that provides access to the specific terms for the selected product.

• Group ID: The ID of the group to which ths service point belongs.

For each service point, you can change the Usage Forecast, Terms, Product, and Product Terms. 
These actions are performed in the same manner as when viewing the Items tab via the Items 
View.

You can also add and/or remove service points, and move service points between groups, and 
add/remove groups.

How to add service points to a contract: group

1. Select the active group from the Active Group drop-down list.

2. Click Add to Active Group.

The Service Points window opens.

Enter the search criteria and click Search. See Searching and Viewing Data on page 2-7 for 
more information about searching records.

The search results appear on the Service Points window.

3. Select the service points you wish to add to the contract by checking the corresponding 
checkboxes.

4. Click Save.

The selected service points will appear on the Items tab.

How to move service points between groups:

1. Select the active group from the Active Group drop-down list.

2. Select the service points you wish to mov by checking the corresponding checkboxes.

3. Click Move to Active Group.

How remove contract items from a contract.

1. Select the service points you wish to remove from the contract by checking the 
corresponding checkboxes.

2. Click Delete.
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How to create a new contract group:

1. Click Add Group.

The Contract Item Group window opens.

2. Enter the Group ID and select the product from the Product ID drop-down list.

3. Click Save. To close the window without adding the new group, click Close.

How delete a contract group:

1. Select the active group from the Active Group drop-down list.

2. Click Delete Group.

Viewing by Groups
When viewing by grup, this tab displays the following information for each contract group 
associated with the contract:

• Group ID: The service point ID

• Members: The number of service points in the group

• Product: The product associated with the group for the contract.

• Terms: A link that provides access to the terms associated with the group for the contract.

For each contract group, you can specify or change the terms associated with the group, view the 
individual service points associated with the group, and add/remove groups.

How to change the terms for a contract group:

1. Click the Terms link for the contract group. The Contract Group Terms window opens.

This window displays the specific terms for the contract group (if any), including the 
following for each:

• Term Type: The Term Type for the contract group term.

• Text Value: The text value (if any) for the contract group term.

• Numeric Value: The numeric value (if any) for the contract group term.

• UOM: The unit of measure associated with the contract group term (if applicable)

• Date Value: The date value (if any) for the contract group term.

• Status: The status of the contract group term.

2. To add a term, select the term category from the All Terms drop-down list, select the term 
type of the term to add from the Choose Term drop-down list, and click Add Term. The 
selected term appears on the Contract Group Terms window.

3. To edit an individual term, click the Term Type link.

The selected term appears in the Contract Group Terms window.

To reset the fields to their default values, click Set Default. Edit the values for the term as 
needed and click Save. To reset the fields to their default values, click Set Default. To reset 
the fields to their original values, click Reset. To close the window without saving changes, 
click Cancel.

4. To edit all contract group terms, select Contract from the All Terms dorp-down list, and 
click the Edit All.

The Contract Group Terms window displays all the current terms. This window allows users 
to edit values for multiple terms on a single screen.

To reset the fields for all terms to their default values, click Set Default. Edit the values for 
each term as needed and click Save. To reset the fields for all terms to their default values, 
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click Set Default. To reset the fields for all terms to their original values, click Reset. To close 
the window without saving changes, click Cancel.

5. To delete a contract group term, select the term(s) you wish to delete by checking the 
corresponding checkboxes and click Delete Term. The term will no longer appear on the 
Contract Group Terms window.

6. To close the Contract Group Terms window and return to the Items tab, click Close.

How to view service points belonging to a contract: group

1. Click the plus sign (‘+’) for the group you wish to view.

A list of service points belonging to the group opens, displaying the following for each 
service point:

• Service Point ID: The service point ID.

• Commodity: The commodity (Electric, Gas, etc.) the contract is based on.

• Usage Forecast: The usage forecast used when calculating the contract (Oracle Utilities 
Quotations Management only).

• Usage Status: The status of usage stored for the service point (Oracle Utilities 
Quotations Management only).

• Terms: A link that provides access to the terms associated with the service point for the 
contract.

For each service point, you can change the Usage Forecast and Item Terms. These actions are 
performed in the same manner as when viewing the Items tab via the Items View.

2. To move a service point to a different group, select the service points you wish to move by 
checking the corresponding checkboxes, select the group to which you wish to move the 
service points, and click Move.

3. To delete a service point from the group, select the service points you wish to move by 
checking the corresponding checkboxes, and click Delete.

4. To add a service point to the group, click Add.

The Service Points window opens.

Enter the search criteria and click Search. See Searching and Viewing Data on page 2-7 for 
more information about searching records.

The search results appear on the Service Points window.

Select the service points you wish to add to the contract by checking the corresponding 
checkboxes.

Click Save.

The selected service points will appear on the list of service points for the group.

How to create a new contract group:

1. Click Add Group.

The Contract Item Group window opens.

2. Enter the Group ID and select the product from the Product ID drop-down list.

3. Click Save. To close the window without adding the new group, click Close.

How delete a contract group:

1. Select the groups you wish to delete by checking the corresponding checkboxes.

2. Click Delete Group.
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Terms Tab
The Terms tab displays specific terms for the contract (if any). This includes the following 
information for each term:

• Term Type: The type of the term.

• Text Value: The text value (if any) for the contract term.

• Numeric Value: The numeric value (if any) for the contract term.

• UOM: The unit of measure associated with the contract term (if applicable)

• Date Value: The date value (if any) for the contract term.

• Details: Details for the term (minimum values, dates, etc.).

• Class: The class of term (Calculated, Optional, Standard, Standard/Required).

How to add a term:

1. Select the term category from the All Terms drop-down list, select the term type of the term 
to add from the Choose Term drop-down list, and click Add Term. The selected term will 
appear.

2. To edit the details of the term, click the Term Type link.

The Edit Term window opens.

3. Edit the term values as needed and click Save. To close the window without saving changes, 
click Cancel.

The updated values will appear on the Terms tab.

4. To edit all contract terms, select Contract from the All Terms dorp-down list, and click the 
Edit All.

The Edit Term window displays all the current editable terms. This window allows users to 
edit values for multiple terms on a single screen.

To reset the fields for all terms to their default values, click Set Default. Edit the values for 
each term as needed and click Save. To reset the fields for all terms to their default values, 
click Set Default. To reset the fields for all terms to their original values, click Reset. To close 
the window without saving changes, click Cancel.

Terms can only be added when the contract’s status is In Process.

How to delete a  term:

1. Select the term(s) you wish to delete by checking the corresponding checkboxes and click 
Delete Term. The term will no longer appear on the Terms tab.

Only terms whose Source is Optional or Standard can be deleted. Calculated and Standard/
Required terms cannot be deleted.

Terms can only be deleted when the contract’s status is In Process.

How to calculate terms:

1. Select Calculate Terms from the Actions drop-down list.

This calculates (and in some cases, recalculates) and updates the values of the terms (with a 
Source of Calculated) whose values are defined by records in the Oracle Utilities Data 
Repository or by the Oracle Utilities Rules Language.

Terms can only be calculated when the contract’s status is In Process.
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Documents Tab
The Documents tab displays documents associated to the contract. This includes the following 
information for each document:

• Class: The class of the document (Optional, Standard, or Standard/Required).

• Document Type: The type of the document (from the Document Type table).

• Image: A link used to download the document.

• Document ID: The document ID.

• Document Title: The document’s title.

• Date Entered: The date the document was added to the contract. This field defaults to the 
date the contract was created, but is updated when the document is added to the contract.

How to add an Optional or an additional Standard document:

1. Select the type of document from the Choose Document Type drop-down list (from the 
Document Type table in the Oracle Utilities Data Repository), and click Add Document.

The Upload Document window opens.

2. Enter a Document ID for the document.

3. Enter a Document Title for the document.

4. Enter a Document Type using the Browse button ( ). This button opens a dialog window 

that lists all the available document types. Click the [...] link for the appropriate type. The 
field is automatically populated.

5. Enter a Document Category using the Browse button ( ). This button opens a dialog 

window that lists all the available document categories. Click the [...] link for the appropriate 
category. The field is automatically populated.

6. Enter the Current Location of the document. Clicking the Browse button opens Choose 
File dialog. Navigate to the document’s location, select the document and click Open.

The selected path and document appear in the Current Location field.

7. Click Upload to add the document to the contract.

8. The uploaded document appears on the Documents tab.

Documents can be added to the contract when it is at any Status.

How to add a document image to a Required or Standard document:

1. Click on the Document Type link of an existing document.

The Upload Document window opens.

2. Enter the Current Location of the document. Clicking the Browse button opens Choose 
File dialog. Navigate to the document’s location, select the document and click Open.

The selected path and document appear in the Current Location field.

3. Click Upload to add the document to the contract.

4. The uploaded document appears on the Documents tab.

Documents can be added to the contract when it is at any Status.

How to edit an existing document:

1. Click the Document Type link.

The Upload Document window opens.

2. Edit the Document ID for the document.
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3. Edit the Document Title for the document.

4. Change the Document Type using the Browse button ( ). This button opens a dialog 

window that lists all the available document types. Click the [...] link for the appropriate type. 
The field is automatically populated.

5. Change the Document Category using the Browse button ( ). This button opens a dialog 

window that lists all the available document categories. Click the [...] link for the appropriate 
category. The field is automatically populated.

6. Change Current Location of the document or select a new document. Clicking the Browse 
button opens Choose File dialog. Navigate to the document’s location, select the document 
and click Open.

The selected path and document appear in the Current Location field.

7. Click Upload to add the document to the contract.

8. The edited document appears on the Documents tab.

Documents can only be edited when the contract’s status is In Process.

How to delete a document:

1. Check the checkbox in the far left column for the document you wish to delete and click 
Delete Document. The document will no longer appear on the Documents tab.

Only documents whose Class is Optional or Standard can be completely deleted. If you delete a 
Standard/Required document, only the document image is deleted; the document record remains 
associated with the contract.

Documents can only be deleted when the contract’s status is In Process.

How to download a document:

1. Click the [...] link in the Image column of the document you wish to download.

The File Download dialog opens.

2. To open the file, click Open. To close the window without opening the file, click Cancel.

The file will open using an appropriate application.

3. To save the file, click Save. To close the window without saving the file, click Cancel.

The Save As dialog opens.

4. Select the destination and enter a name for the file and click Save. To close the window 
without saving the file, click Cancel.

Documents can be downloaded when the contract is at any Status.
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Approvals Tab
The Approvals tab displays approvals associated to the contract. This includes the following 
information for each approval:

• Approval Level: The approval level for the approval.

• Approval Status: The current status of the approval. This can be one of Approved, Rejected, 
or Waiting.

• Date Approved: The date the approval was approved/rejected.

• User: The user who approved/rejected the approval.

• Comments: Additional added by the user concerning the approval.

A contract’s approvals are created when the Ready for Approval action on the Actions drop-down 
list is selected. This also sets the contract’s status to In Approval.

At any one time, only one approval will have a status of Waiting, indicating that it is the approval 
to be approved or rejected.

How to approve or reject an approval:

1. To approve the approval, click Approve. To reject the approval, click Reject.

The Enter Note for Approval (or Reject) dialog opens.

2. Enter an optional note concerning the approval (or rejection) and click OK. To close the 
dialog without approving/rejecting the approval, click Cancel.

3. The status of the approval will change to Approved or Rejected, as appropriate, and the 
optional note will appear in the Comments column.

Approvals can only be approved or rejected when the contract’s status is In Approval.

History Tab
The History tab displays actions performed on the contract, such as creating, submitting, revising, 
and executing the contract. This includes the following information for each action:

• Creation Date: The date the action was performed.

• Type: The type of action performed.

• Revised By: The user who performed the action.

• Details: Details about the action.

You can also add notes to the contract on this tab.

How to add an action:

1. Click Add.

The Add Contract History window opens.

2. Enter an Action Time for the action. The Action Time defaults to the current system time. 
To enter a date, enter the date manually or click the arrow and select the date using the 
calendar control.

3. Enter an Action Type.

4. Edit the User ID (optional). This defaults to the current user ID.

5. Enter a description for the action in the Details field.

6. Click Add to save the action. To close the window without saving changes, click Cancel.

The note appears on the History tab.
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You can add notes to the contract when it is at any Status.

Related Contracts Tab
The Related Contracts tab displays a tree diagram that illustrates the relationship between the 
contract and any related contracts, such as subcontracts, amendments, or a parent contract. The 
Contract ID, Revision #, Contract Type, Description, and Start and Stop Dates are displayed for 
each contract.

Note: The Related Contracts tab is view-only.

How to view a related contract:

1. Click the ID link of the related contract you wish to view.

2. The selected contract appears on the Basics Tab.

How to add a contract relationship:

1. Click Add.

The Contracts window opens.

2. To search for an existing contract, enter the search criteria and click Search. See Searching 
Contracts for more information.

3. To add a new contract, click Add.

The Create Contract window opens.

Enter the details for the new contract. See Creating Contracts for more information.

Work Queue Detail Tab
The Work Queue Detail tab displays work queue items and approvals related to the contract. The 
Approvals section displays work queue approvals associated to the contract. The Items section 
displays work queue items associated to the contract. For each item or approval listed, the Work 
Queue Detail tab displays the following:

• UID: The unique ID of the work queue item

• Work Queue Type: The work queue type associated with the item

• Work Queue: The work queue associated with the item

• Priority: The priority of the work queue item

• Work By Time: The date by which the work queue item should be resolved/approved.

• Hints: Hints associated with the work queue item. To view a hint, click the hint link.

If there is more than one page of items, you can move between pages using the  and . 
buttons. To change the number of items that appears in each section, enter the number in the 
Rows field.

Viewing and Working with Work Queue Items and Approvals
You can view work queue items and approvals for either the current contract, or for the current 
contract and all related subcontracts. You can also view details for each work queue item.

• To filter the list of items displayed, select Current Contract or All Sub Contracts from the 
Show drop-down list.

In the Item section, you can also filter by Open or Closed items. 

• To view Hint Details and an Item History for an item, click the plus sign (+) next to the item 
you wish to view.
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• To view and edit an item, click the UID for the item. The selected item will display in the 
Work Queue Item View screen.

You can also perform other actions (such as approve/reject, resolve, close, etc.) on work queue 
items 

How to perform an action on a work queue item:

1. Check the checkbox for the approvals or items you wish to work on, or click the UID link for 
the item.

2. Click the appropriate action.

Available actions include:

• Assign

• Unassign

• Approve (Approvals only)

• Reject (Approvals only)

• Resolve (Items only)

• Close

See Chapter 10: Working with Work Queues in the Oracle Utilities Energy Information Platform 
User’s Guide for more information about working with work queue items and approvals.
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Contract Actions
The Actions drop-down list on the Contact window lists the available actions that can be 
performed on contracts, including:

• Save

• Save w/Comments

• Calculate Terms

• View Calculations

• View Contract

• Ready for Approval

• Submit Contract

• Execute Contract

• Terminate Contract

• Revise Contract

Note: The descriptions below describe the default behavior for each of the actions. The specific 
tabs on which each action is available, as well as the Statuses and External Statuses at which each 
action is permissible can be modified. Refer to the Oracle Utilities Billing Component Installation and 
Configuration Guide or Oracle Utilities Quotations Management Installation and Configuration Guide for 
more information.

Save
The Save action saves the contract and any changes made on the Basics Tab. This action is only 
available from the Basics Tab.

Save w/Comments
The Save w/Comments action saves the contract and any changes made on the Basics Tab, and 
allows the user to enter comments related to the contract. Comments appear on the History Tab. 
This action is only available from the Basics Tab.

Calculate Terms
The Calculate Terms action calculates (and in some cases, recalculates) and updates the values of 
the terms (with a Class of Calculated) whose values are defined by records in the Oracle Utilities 
Data Repository or by the Oracle Utilities Rules Language.

This action can be performed from any tab, and but only when the contract’s status is In Process.
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View Calculations
The View Calculations action performs any calculations associated with the contract and displays 
the results.

This action can be performed from any tab, and when the contract is at any Status.

When you click the View Calculation, the Process window opens. After the calculations are 
complete, the Report Generate window opens.

Contract calculations are displayed using report templates. Oracle Utilities Quotations 
Management includes a default contract calculations template that can customized to suit your 
specific needs.

When the contract calculations are complete, the contract calculations open.

View Contract
The View Contract action generates an contract based on the Items, Terms, and Documents 
specified on the Contract screen.

This action can be performed from any tab, and when the contract is at any Status.

When you select View Contract action on the Actions drop-down list, the Report Generate 
window opens.

Contracts are created using report templates. Oracle Utilities Quotations Management and Oracle 
Utilities Billing Component - Contract Management both include a default contract template that 
can customized to suit your specific needs.

When the contract generation is complete, the contract window opens.

Ready for Approval
The Ready for Approval action sets the contract’s Status to In Approval, and if applicable, 
generates work queue items for the contract’s approvals.

This action can be performed from any tab, but only when the contract’s status is In Process.

Submit Contract
The Submit Contract action sets the contract’s Status to Submitted.

This action can be performed from any tab, but only when the contract’s status is In Approval.

Execute Contract
The Execute Contract action sets the contract’s Status to Executed.

This action can be performed from any tab, but only when the contract’s status is Submitted.

Terminate Contract
The Terminate Contract action sets the contract’s Status to Terminated.

This action can be performed from any tab, but only when the contract’s status is In Process, In 
Approval, Submitted, or Executed.
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Revise Contract
The Revise Contract action creates a copy of the current contract with an updated Revision 
number (current revision number plus 1), and sets the original contract’s Status to Revised, and 
the revision contract’s Status to In Process.

This action can be performed from any tab, but only when the contract’s status is anything other 
than Revised.
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Part Three
Receivables Management - Oracle Utilities

Receivables Component

Part Three describes Oracle Utilities Receivables Component, used for the receivables 
management functions of Oracle Utilities Billing Component, and contains the following 
chapters:

• Chapter 14: Oracle Utilities Receivables Component Overview

• Chapter 15: Viewing Financial and Collections Data

• Chapter 16: Managing Financial Transactions with Oracle Utilities Receivables 
Component

• Chapter 17: Receivables Management Work Queues

• Chapter 18: Receivables Management Controls

• Chapter 19: Collections

• Chapter 20: Viewing Oracle Utilities Receivables Component Reports





Chapter 14
Oracle Utilities Receivables Component

Overview

This chapter provides a broad overview of the Oracle Utilities Receivables Component user 
interface, including:

• The Oracle Utilities Receivables Component User Interface

• Oracle Utilities Receivables Component User Interface Functions
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The Oracle Utilities Receivables Component User Interface
The Oracle Utilities Receivables Component user interface is a web-based application used to 
perform a number of functions available through the Oracle Utilities Receivables Component. 
This includes searching and viewing account/customer information, managing transactions, 
working with work queue items and controls, and viewing reports.

How the Oracle Utilities Receivables Component User Interface Is Used
The Oracle Utilities Receivables Component user interface is used through Microsoft Internet 
Explorer (Version 5.01 with Service Pack 1 or later). The application is a set of interactive web 
pages that allow access to and (in the case of some functions) manipulation of data stored in the 
Oracle Utilities Data Repository, the same data accessed and used by other Oracle Utilities 
applications such as Oracle Utilities Billing Component and Data Manager.

Later chapters in this book describe how to perform the various functions available through the 
Oracle Utilities Receivables Component user interface.
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Oracle Utilities Receivables Component User Interface Functions
The Oracle Utilities Receivables Component user interface provides a number of functions to 
users, including the following:

Account Management
The Account Management functions allow users to search and view account, customer, meter, and 
recorder data based on specified search criteria.

Transactions
The Transaction functions allow users to perform a number of account and transaction 
maintenance functions, including the following:

Installment Plans
Installment plan functions include the ability to create and cancel installment plans for accounts.

Deposits
Deposit functions include the ability to post, cancel, apply, or unapply deposits for an account and 
to post and cancel deposit interest.

Payments
Payments functions include transfer of payments between accounts and cancelling payments due 
to insufficient funds (NSF), and optionally to assess a penalty fee to the account for the cancelled 
payment.

Adjustments
Adjustments functions include the ability to post and cancel adjustment credit or charge 
transactions against an account. 

Refunds
Refunds functions include the ability to post and cancel refund charge transactions against an 
account, as well as update the status of refunds in the system. 

Write Offs
Write Off functions include the ability to post and cancel write-off credit or charge transactions 
against an account.

Balance Transfers
Balance transfers functions include the ability to transfer and return balances between accounts.

Work Queues
The Work Queues function is used to process work queue items associated with transactions.

Controls
The Controls function is used to view control items associated with transactions based on 
specified search criteria (date, control type, etc.).
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Collections
The Collections functions (accessible from the Collections menu) allow users to perform a 
number of collections-related functions, including the following:

Collections Arrangements
The Collections Arrangements function is used to create and maintain collections arrangements 
and related payment arrangements for accounts.

Collections Exemptions
The Collections Exemptions function is used to create and maintain collections exemptions for 
accounts.

Work Queue
The Work Queue function is used to view and work with work queue items associated with 
collections processes.

Manual Submission
The Manual Submission function is used to manually initiate a collections process for an account.

Reports
The Collections reports include a number of reports detailing collections-related information.

Reports List
The Reports List function allows users to view reports based on data processed by the Oracle 
Utilities Receivables Component and the Oracle Utilities Receivables Component user interface. 
These include the following:

• Payment Posting Report

• Issue Refund Report

• Account Balance Report

• AR Aging Report

• G/L Activity Report

• System Balance Report

• Market Participant Aging Report

• Performance Rating Summary Report (Collections)

• Work Queue Summary Report (Collections)

• Collection Exemption Summary Report (Collections)

• Collection Activity Summary Report (Collections)

• Process Status Report (Collections)
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Chapter 15
Viewing Financial and Collections Data

Oracle Utilities Energy Information Platform allows users to search for and view information 
about selected customers and accounts. When Oracle Utilities Billing Component (which includes 
Oracle Utilities Receivables Component) is installed, this information includes account-specific 
financial and collections data. This chapter describes how to view financial and collections data 
from the Account View, and includes the following:

• Viewing Financial Data

• Viewing Collections Data
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Viewing Financial Data

The Financials clip on the Account dashboard displays the account’s Receivable Status, Current 

Balance, Past Due Balance, and Deferred Balance.

To view more detailed financial data, click Details. The Financials screen opens.

The Financials screen displays financial information about the account on three panes: the 
Account Balance pane, the Financial Profile pane, and the Detailed View pane.

Note:  The information displayed on the Financials screen is View-only.  You 
cannot change, update, delete, or modify this data in any way.

Account Balance Pane
The Account Balance pane contains account balance information about the account, including:

• Receivable Status: the account’s receivable status, including Current, Past Due, Collections, 
Uncollectible, or Unrefundable

• Current Balance: the account’s current balance

• Past Due Balance: any past due amount

• Deferred Balance: the amount of the variance on the Budget Plan, if any.

Financial Profile Pane
The Financial Profile pane displays records associated with the account in a “tree” format. This 
includes any service plans, autopayment plans, transactions or other financial records associated 
with the account.

Each of the sections below the account (such as Service Plans) can be expanded to display specific 
records by clicking the arrow. To collapse the tree so that fewer levels of detail are shown, click the 
arrow next to individual item.

When you click on an item in the tree (Service Plans, Autopay Plans, Transactions, etc),  detailed 
information about the selected item appears in the Detailed View pane.

Detailed View Pane
The Detailed View pane displays information based on selected items in the Financial Profile 
pane. The default view is AR aging information, listing balances for different receivable types 
grouped by a number of day ranges. The specific contents of the Detailed View pane are 
determined by the item(s) selected in the Financial Profile pane, and include the following:

Aging
The Aging pane displays balances for different receivable types grouped by day ranges (0-15, 16-
30, 31-45, etc.). The information in this pane is based on the Invoice Date on the account’s 
transaction records. Transactions that have an Invoice Date of NULL are grouped in the 0-15 
range.

Service Plans
The Service Plans pane displays records identifying individual service plans from the Service Plan 
Table including:

• Type: the service plan type.

• LDC Acc: the local distribution company (LDC) account number.

• Start/Stop: the start/stop dates of the service plan. A future stop date is allowed. A blank 
Stop date indicates that there is no known date when the service plan is to terminate.

• Op. Co: the operating company associated with the service plan.
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• Juris: the jurisdiction associated with the service plan.

Service Plan
The Service Plan pane displays data concerning individual service plans, including:

• Service Type: the service plan type.

• LDC Account: the local distribution company (LDC) account number.

• Service Address: the address associated with the service plan.

• Start Date/Stop Date: the start/stop dates of the service plan. A future stop date is allowed. 
A blank Stop date indicates that there is no known date when the service plan is to terminate.

• Operating Company: the operating company associated with the service plan.

• Jurisdiction: the jurisdiction associated with the service plan.

Budget Plan
The Budget Plan section displays records from the Budget Plan Table related to the Service Plan, 
including:

• Type: the budget plan type,

• Amount: the amount associated with the budget plan,

• Variance: the variance of the budget plan,

• Start Date/Stop Date: the start/stop dates of the budget plan. A future stop date is allowed. 
A blank Stop date indicates that there is no known date when the service plan is to terminate,

• True-up Date: the date on which the next budget bill true-up transaction should occur.

Deposits
The Deposits pane displays records from the Deposits Table in the Oracle Utilities Data 
Repository, including:

• Date: the date of the deposit.

• Amount: the amount of the deposit.

• Principal Bal: the current balance of the deposit, less any accrued interest.

• Interest Bal: the amount of interest earned on the deposit.

• Last Paid Date: the last date a payment was made against the deposit

• Last Int Date: the last date interest was accrued against the deposit

• Last App Date: the last date any portion of the deposit balance was applied to the account's 
balance.

• Interest Rate: the interest rate for the deposit.

Deposit
The Deposit pane displays data concerning individual deposits, including:

• Date: the date of the deposit.

• Amount: the amount of the deposit.

• Principal Balance: the current balance of the deposit, less any accrued interest.

• Interest Balance: the amount of interest earned on the deposit.

• Interest Rate: the interest rate for the deposit.

• Last Paid Date: the last paid date of the deposit.

• Last Int Date: the last date on which interest accrued for the deposit.
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• Last App Date: the date on which the deposit was last applied.

Installment Plans
The Installment Plan pane displays records from the Installment Plans Table in the Oracle Utilities 
Data Repository, including:

• Date: the start date of the installment plan.

• Total # Insts: the total number of installments in the plan.

• Remaining # Insts: the remaining number of installments in the plan.

• Total Amt: the total amount of the installment plan.

• Remaining Amt: the remaining amount of the installment plan.

• 1st Inst Amount: the amount of the first installment in the plan (if different than the 
Installment Amount).

• Inst Amount: the amount of the installment in the plan.

Installment Plan
The Plan pane displays data concerning individual installment plans, including:

• Date: the start date of the installment plan.

• Total # Insts: the total number of installments in the plan.

• Remaining # Insts: the remaining number of installments in the plan.

• Total Amt: the total amount of the installment plan.

• Remaining Amt: the remaining amount of the installment plan.

• 1st Inst Amt: the amount of the first installment in the plan (if different than the Installment 
Amount).

• Inst Amt: the installment amount

• Stop Date: the stop date of the installment plan.

• Receivable Type: The receivable type associated with the installment plan.

• Charge Type: The charge type associated with the installment plan.

• Operating Company: The operating company associated with the installment plan.

• Jurisdiction: The jurisdiction associated with the installment plan.

AutoPay Plans
The AutoPay Plans pane displays records from the Auto Payment Plan Table including:

• Payment Method: the payment method associated with the autopayment plan.

• Institution: the name of the financial institution used for direct debit automatic payment or 
the name of the institution that issued the Visa or MasterCard being used for automatic 
payment.

• Account Name: the name on the bank or credit card account used for automatic payment.

• Acc No: the account number for the bank or credit card account used for automatic 
payment.

• Postal Code: the postal code associated with the account.

• Start Date/Stop Date: the start/stop dates of the autopayment plan. A future stop date is 
allowed. A blank Stop date indicates that there is no known date when the service plan is to 
terminate.

• Exp Date: the expiration date for credit card accounts.
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• RTN: the routing transit number used for direct debit from checking accounts.

AutoPay Plan
The AutoPay Plan pane displays data about specific automatic payment plans, including:

• Payment Method: the payment method associated with the autopayment plan.

• Institution: the name of the financial institution used for direct debit automatic payment or 
the name of the institution that issued the Visa or MasterCard being used for automatic 
payment.

• Account Name: the name on the financial institution or credit card account used for 
automatic payment.

• Account No: the account number for the financial institution or credit card account used for 
automatic payment.

• Postal Code: the postal code associated with the account.

• Start Date/Stop Date: the start/stop dates of the autopayment plan. A future stop date is 
allowed. A blank Stop date indicates that there is no known date when the autopayment plan 
is to terminate.

• Expiration Date: the expiration date for credit card accounts.

• Routing Number: the routing transit number used for direct debit from checking accounts.

• Autopayments: a listing of the automatic payments associated with the automatic payment 
plan, including: the Date, Amount, Batch No, Cancel Time, and Status of each.

Assistance Plans
The Assistance Plans pane displays records from the Assistance Plans table, including:

• Plan ID: the identifier of the assistance plan in the system.

• Start: the start date of the assistance plan.

• Stop: the stop date of the assistance plan. 

Assistance Plan
The Assistance Plan pane displays data concerning individual assistance plans, including:

• Plan ID: the identifier of the assistance plan in the system.

• Start Date: the start date of the assistance plan.

• Stop Date: the stop date of the assistance plan.

• Pledge Details: individual assistance pledges associated with the assistance plan, including: 
the Pledge Date, Pledge Amount, Received Date, and Received Amount of each

Collection Agencies
The Collection Agencies pane displays records from the Collection Agency table, including:

• Agency ID: the identifier of the collection agency in the system.

• Type: the type of collection agency.

• Start: the start date of the collection agency.

• Stop: the stop date of the collection agency. 

Collection Agency
The Collection Agency pane displays data concerning individual collection agencies, including:

• Agency ID: the identifier of the collection agency in the system.

• Type: the type of collection agency.
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• Start: the start date of the collection agency.

• Stop: the stop date of the collection agency.

• Fee: the fee, if any, associated with the collection agency.

• Comments: optional comments for the collection agency.

Collection Arrangements
The Collection Arrangements pane displays records from the Collection Arrangements table, 
including:

• Payments: the number of payments associated with the collection arrangement.

• Total Amount: the total amount of the collection arrangement.

• Status: the status of collection arrangement.

• Start: the start date of the collection arrangement.

• Stop: the stop date of the collection arrangement. 

Collection Arrangement
The Collection Arrangement pane displays data concerning individual  collection arrangements, 
including:

• Payments: the number of payments associated with the collection arrangement.

• Total Amount: the amount of the collection arrangement.

• Start Date: the start date of the collection arrangement.

• Stop Date: the stop date of the collection arrangement.

• Status: the status of collection arrangement.

• Modification Date: The date on which the collection arrangement was last modified.

• Document Date: The date on which documents regarding the collection arrangement were 
sent.

• Payment Details: individual payments associated with the collection arrangement, including: 
the Date Due and Amount Due of each.

Refunds
The Refunds pane displays records from the Refunds table, including:

• Type: the type of refund.

• Reason: the reason for the refund.

• Amount: the amount of the refund.

• Status: the status of the refund.

• Check #: the check number for the refund (if applicable).

• Routing #: the routing number for the refund (if applicable).

• Send Date: the date the refund was sent.

• Issue Date: the date the refund was issued. 

• Cashed Date: the date the check issued for the refund was cashed. 

• Void Date: the date the refund was voided.

• Check Acc #: the checking account number for the check issued for the refund.

• Institution: the name of the financial institution associated with the refund. 
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Refund
The Refund pane displays data concerning individual refunds, including:

• Type: the type of refund.

• Reason: the reason for the refund.

• Amount: the amount of the refund.

• Status: the status of the refund.

• Check #: the check number for the refund (if applicable).

• Routing #: the routing number for the refund (if applicable).

• Send Date: the date the refund was sent.

• Issue Date: the date the refund was issued. 

• Cashed Date: the date the check issued for the refund was cashed. 

• Void Date: the date the refund was voided.

• Check Acc #: the checking account number for the check issued for the refund.

• Institution: the name of the financial institution associated with the refund. 

Transactions
When you select Transactions from the Financials Tree, the Transactions window opens.

The Transactions window displays transaction records from the Transaction Table  including:

•  indicates the transaction has been cancelled.

• Date: the date the transaction was posted to the system.

• Description: an optional description of the transaction.

• Debits: the amount of the transaction for debit transactions.

• Credits: the amount of the transaction for credit transactions.

• Balance: the balance of the transaction.

• Charge Type: the charge type associated with the transaction.

• Receivable Type: the receivable type associated with the transaction.

• Due Date: the due date of the transaction (if a charge).

• Rev. Month: the revenue month associated with the transaction.

• User ID: the user ID of the user who posted the transaction.

• Invoice Id: the invoice ID associated with the transaction (optional).

• Invoice Date: the invoice date associated with the transaction (optional).

• Transfer To: The transaction to which the transaction was transferred, if applicable.

• Transfer From: The transaction from which the transaction was transferred, if applicable.

• Cancel User/Cancel Reason: the user ID of the user who cancelled the transaction (if 
applicable), and the reason the transaction was cancelled (if applicable).

How to view transaction details:

1. Click on the Date of the transaction you wish to view. The Details window opens.
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How to export the contents of the Transactions window:

You can export the contents of the Transactions window

1. Click the Export link. The File Download dialog opens.

2. Select either Open this file from its current location or Save this file to disk as 
appropriate, and click OK.

3. If you selected the Open this file from its current location option, the file will open a *.csv 
file compatible application (such as Microsoft Excel).

4. If you selected the Save this file to disk option, enter the file name and select the 
destination for the file.
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Viewing Collections Data
The Collections clip on the Account dashboard displays the account’s Collection Status, 
Collectible Balance, and Performance Score.

To view more detailed collections data, click Details. The Collections screen opens.

The Collections screen displays collections-related information about the account on three panes: 
the Collections Information pane, the Collections Profile pane, and the Detailed View pane.

Note:  The information displayed on the Collections screen is View-only.  You 
cannot change, update, delete, or modify this data in any way.

Collections Information Pane
The Collections Information pane contains collections-related information about the account, 
including:

• Receivable Status: the account’s current receivable status, including Current, Past Due, 
Collections, Inactive Collections, Uncollectible, or Unrefundable

• Collection Status: the account’s current collection status

• Active Arrangement: whether or not the account has an active collection arrangement. If 
yes, click YES to view the Collections Arrangements for the account.

• Active Exemption: whether or not the account has an active collection exemption. If yes, 
click YES to view the Collections Exemptions for the account.

• Total Balance: the account’s current balance

• Past Due Balance: any past due amount

• Performance Score: a score that represents the account’s payment behavior, based on the 
account’s past payment and collection history.

• Special Handling Code: a code that indicates if the account has required special handling

Collections Profile Pane
The Collections Profile pane displays different types of collections-related data associated with the 
account. This includes aging, Collection Agencies, and Collection History.

When you click on an item in the tree, detailed information about the selected item appears in the 
Detailed View pane.

Detailed View Pane
The Detailed View pane displays information based on selected items in the Collections Profile 
pane. The default view is AR aging information, listing balances for different receivable types 
grouped by a number of day ranges. The specific contents of the Detailed View pane are 
determined by the item(s) selected in the Collections Profile pane, and include the following:

Aging
The Aging pane displays balances for different receivable types grouped by day ranges defined in 
the Factor and Factor Value tables (ex: 0-15, 16-30, 31-45, etc.). See Factor and Factor Value 
Tables on page 9-5 in the Oracle Utilities Billing Component User’s Guide for more information about 
defining the day ranges on the Aging pane. If no day ranges are defined in the Factor and Factor 
Value tables, the default is one range labeled “0+”.

The information in this pane is based on the Invoice Date on the account’s transaction records. 
Transactions that have an Invoice Date of NULL are grouped in the first range.

Collection Agencies
The Collection Agencies pane displays collection agencies associated with the account, including:
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• Agency ID: the identifier of the collection agency in the system.

• Type: the type of collection agency.

• Start: the date the account was assigned to the collection agency.

• Stop: the date the account was removed from the collection agency. 

Collection History
The Collections History pane displays collections activities for the account, including:

• View: an icon that allows you to view details related to the activity. For collections process 
activities that created messages, this is the message payload in XML format. For other 
activities, the view displays detailed information about the activity. For example, for a 
collection arrangement, this would display the total amount of the arrangement, the 
arrangement type, and the number of payments.

Click the  icon to view the activity.

• Issued: the date the activity was issued

• Implementation: the implementation of the activity

• State: the current state of the activity. This is only populated for activities created by a 
collections process.

• Completed: whether or not the activity has been completed

• Activity: the type of activity

• Source: the source of the activity. For activities created by a collections process, this is the 
name of the process. For other types of activities, this is the type of activity, such as 
Arrangement Review Process, Exemption Review Process, etc.
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Chapter 16
Managing Financial Transactions with Oracle

Utilities Receivables Component

This chapter describes the Transactions functionality of the Oracle Utilities Receivables 
Component user interface, including: 

• Transaction Function Overview

• Working with Transactions

• Installment Plans

• Deposits

• Payments

• Adjustments

• Refunds

• Write Offs

• Balance Transfers

The use of each of these functions is described in this chapter. More information about how these 
functions are processed by the Oracle Utilities Receivables Component can be found in Chapter 
6: Billing and Chapter 8: Maintenance, in the Oracle Utilities Billing Component Installation and 
Configuration Guide. Volume 2.
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Transaction Function Overview
The Transactions functionality of the Oracle Utilities Receivables Component user interface 
includes the ability to process a variety of transaction types. Below is an overview of each.

Installment Plans

Create Installment Plan
This function creates an installment plan related to a previously posted deferred charge 
transaction. This process can alternatively occur as a single transaction if the installment plan is 
related to the deferred charge when the deferred charge is initially posted. See Create Installment 
Plan on page 16-6 for more information.

Cancel Installment Plan
This function cancels a previously created installment plan. See Cancel Installment Plan on page 
16-7 for more information.

Deposits

Post Deposit
This function posts either a non-deferred or deferred charge transaction against a specified 
account. The default is non-deferred, since a deferred deposit would typically have an installment 
plan created for it. See Post Deposit on page 16-8 for more information.

Cancel Deposit
This function cancels a previously posted deposit transaction. See Cancel Deposit on page 16-9 
for more information.

Apply Deposit
This function posts non-deferred credit transactions for a specified account representing the 
principal balance and/or interest balance associated with the deposit that is applied to the account. 
See Apply Deposit on page 16-10 for more information.

Unapply Deposit
This function cancels a previously posted deposit application transaction. See Unapply Deposit 
on page 16-10 for more information.

Post Deposit Interest
This function posts deferred credit transactions for a specified account representing an amount of 
interest accrual for an associated deposit. See Post Deposit Interest on page 16-12 for more 
information.

Cancel Deposit Interest
This function cancels a previously posted deposit interest transaction. See Cancel Deposit 
Interest on page 16-12 for more information.
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Payments

Transfer Payment
This function transfers individual payments between accounts. See Transfer Payment on page 
16-14 for more information.

Process NSF
This function cancels a payment due to insufficient funds (NSF), and optionally, to assess a 
penalty fee to the account for the cancelled payment. See Process NSF on page 16-15 for more 
information.

Adjustments

Post Adjustment
This function posts an adjustment transaction credit or charge against an account. See Post 
Adjustment on page 16-17 for more information.

Cancel Adjustment
This function cancels a previous adjustment. See Cancel Adjustment on page 16-18 for more 
information.

Refunds

Post Refund
This function posts a refund transaction charge against an account. See Post Refund on page 16-
20 for more information.

Cancel Refund
This function cancels a previous refund. See Cancel Refund on page 16-21 for more 
information.

Update Refund
This function updates the status of a refund. See Update Refund on page 16-22 for more 
information.
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Write Offs

Post Write Off
This function posts a write-off transaction credit or charge against an account. See Post Write Off 
on page 16-23 for more information.

Cancel Write Off
This function cancels a previous write-off transaction. See Cancel Write Off on page 16-24 for 
more information.

Write Off Account
This function posts a write-off transaction for each outstanding (balance > 0) transaction that has 
been previously posted for the account. See Write Off Account on page 16-25 for more 
information.

Write On Account
This function cancels all previous write-off transactions for the account. See Write On Account 
on page 16-26 for more information.

Balance Transfers

Transfer Balance
This function posts a balance transfer transaction for each outstanding transaction (balance > 0) 
that has been previously posted for the account. See Transfer Balance on page 16-27 for more 
information.

Return Balance
This function cancels all previous balance transfer transactions for the account. See Return 
Balance on page 16-28 for more information.
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Working with Transactions
This section provides general information related to working with transactions, including:

• Selecting Accounts

• Refreshing Transaction Data

Selecting Accounts
Before you can work with transactions using the Oracle Utilities Receivables Component, you 
must first select the account(s) you wish to work with. If an account has not been previously 
selected, you can select an account using the following procedure.

How to select accounts when working with transactions:

1. Click the Search Account button ( ) at the top of the transaction screen. This opens the 
Accounts window.

2. Enter the search criteria in the appropriate field.

You can search based on the customer Name, Customer ID, or an Account ID associated 
with the account. You can also search based on Account Status, Operating Company, and/or 
Jurisdiction. To search on one of these, select it from the drop-down lists. In addition, you 
can search based on contact information such as phone number, address, city/state, etc.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
fields. For instance, if you want to search for all accounts whose name begins with the letter 
G, you could enter “G%” in the Name field, and the search would retrieve all users that begin 
with the letter G. You can use this wildcard before or after specified letters or numbers (i.e. 
you would use %t to search for all accounts whose name ends with the letter t, etc.).

3. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 for more information.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To clear all the search fields, click Reset.

5. The Accounts window displays the search results.

6. Click on the Account ID of the account you wish to use. If there is more than one page of 

search results, you can move between pages using the  and  buttons. To change the 
number of results that appear on each page, enter the number in the Rows field.

7. The Account ID, Customer Name, and Current Balance for the selected account will appear 
at the top of the transaction screen.

Refreshing Transaction Data
Most of the transaction screens include a list of transactions related to the selected account(s). 
This data is retrieved from the Oracle Utilities Data Repository when the account is selected, and 
include transactions of all kinds, as well as payments. To refresh the data on transaction lists, click 

the Refresh icon ( ).
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Installment Plans
When you select the Installment Plans option from the Financials menu, the Installment Plans 
screen opens.

The Installment Plan screen includes the following functions:

• Create Installment Plan

• Cancel Installment Plan

To access one of the functions, select the appropriate tab on the Installment Plans screen.

Create Installment Plan
The Create Installment Plan function creates an installment plan related to a previously posted 
deferred charge transaction. When you select the Create tab on the Installment Plans screen, the 
Create Installment Plan screen opens.

Create Installment Plan Summary
Creating an installment plan involves the following steps:

• Select the account for the installment plan,

• Select the deferred charge transaction that the installment will be related to,

• Enter the specific data concerning the installment plan, and

• Create the installment plan.

How to Create an Installment Plan:

1. Select Financials-›Transactions-›Installment Plans and select the Create tab.

The Create Installment Plan screen opens.

2. If the account hasn’t been previously selected, select the account as described under 
Selecting Accounts on page 16-5. The Account ID, Customer Name, and Current Balance 
for the selected account will appear at the top of the screen, and a list of deferred charge 
transactions associated with the selected account will appear in the Transactions box. If there 

is more than one page of transactions, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

3. Select the transaction to which the installment plan will be related.

4. Fill in the appropriate data in the Installment Plan pane. This includes:

• Number of Installments: enter the number of installments for the installment plan,

• Installment Amount: enter the amount of each installment for the installment plan,

• First Installment Amount: enter the amount of the first installment for the installment 
plan (only necessary if different than the installment amount),

• Transaction ID: select the appropriate Transaction ID from the drop-down list,

• Receivable Type: select the appropriate receivable type for the installment plan,

• Charge Type: select the appropriate charge type for the installment plan,

• Operating Company: select the appropriate operating company for the installment 
plan, and

• Jurisdiction: select the appropriate jurisdiction for the installment plan.

5. Click Process to create the installment plan.
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6. A dialog box will appear asking you to confirm the installment plan. Verify the information 
concerning the installment plan. To confirm, click OK. To cancel, click Cancel.

7. To create additional installment plans for the same account, repeat steps 4 through 6 for each 
additional installment plan. To create additional installment plans for different accounts, 
repeat steps 1 through 6 as appropriate.

Cancel Installment Plan
The Cancel Installment Plan function cancels a previously created installment plan. When you 
select the Cancel tab on the Installment Plans screen, the Cancel Installment Plan screen opens.

Cancel Installment Plan Summary
Cancelling an Installment Plan involves the following steps:

• Select the account associated with the installment plan,

• Select the installment plan, and

• Cancel the installment plan.

How to cancel an installment plan:

1. Select Financials-›Transactions-›Installment Plans and select the Cancel tab.

The Cancel Installment Plan screen opens.

2. If the account hasn’t been previously selected, select the account as described under 
Selecting Accounts on page 16-5. The Account ID, Customer Name, and Current Balance 
for the selected account will appear at the top of the screen, and a list of installment plans 
associated with the selected account will appear in the Installment Plan box. If there is more 

than one page of installment plans, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

3. Select the installment plan to be cancelled.

4. Click Process to cancel the installment plan.

5. A dialog box will appear asking you to confirm the process. Verify the Account and 
Installment Plan on the dialog. To confirm the process, click OK. To cancel the process, click 
Cancel.

6. To cancel additional installment plans for the same account, repeat steps 3 through 5 for each 
additional installment plan. To cancel additional installment plans for different accounts, 
repeat steps 1 through 5 as appropriate.
Managing Financial Transactions with Oracle Utilities Receivables Component 16-7



Deposits
Deposits
When you select the Deposits option from the Financials Menu, the Deposits screen opens.

The Deposits screen includes the following functions:

• Post Deposit

• Cancel Deposit

• Apply Deposit

• Unapply Deposit

• Post Deposit Interest

• Cancel Deposit Interest

To access one of the functions, select the appropriate tab on the Deposits screen.

Post Deposit
The Post Deposit function posts either a non-deferred or deferred charge transaction against a 
specified account. The default is non-deferred, since a deferred deposit would typically have an 
installment plan created for it. When you select the Post tab on the Deposits screen, the Post 
Deposit screen opens.

Post Deposit Summary
Posting a refund involves the following steps:

• Select the account to which the deposit is to be posted,

• Enter the appropriate data for the deposit, and

• Post the deposit.

How to post a deposit:

1. Select Financials-›Transactions-›Deposits and select the Post tab.

The Post Deposit screen opens.

2. If the account to which the deposit is to be posted hasn’t been previously selected, select the 
account as described under Selecting Accounts on page 16-5. The Account ID, Customer 
Name, and Current Balance for the selected account will appear at the top of the screen.

3. Fill in the appropriate data for the deposit, including:

• Amount: enter the amount of the deposit, 

• Transaction ID: select the appropriate transaction ID for the deposit,

• Interest Rate (optional): enter the interest rate for the deposit,

• Receivable Type: select the appropriate receivable type for the deposit,

• Charge Type: select the appropriate charge type for the deposit,

• Installment Plan: if the deposit is related to an installment plan, check the Installment 
Plan checkbox and fill in the appropriate data to create the installment plan:

• Number of Installments: enter the number of installments for the installment 
plan,

• Installment Amount: enter the amount of each installment for the installment 
plan,

• First Installment Amount: enter the amount of the first installment for the 
installment plan (only necessary if different than the installment amount),
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• Transaction ID: select the appropriate Transaction ID from the drop-down list,

• Receivable Type: select the appropriate receivable type for the installment plan,

• Charge Type: select the appropriate charge type for the installment plan,

• Operating Company: select the appropriate operating company for the installment 
plan, and

• Jurisdiction: select the appropriate jurisdiction for the installment plan.

4. Click Process to post the deposit.

5. A dialog box will appear asking you to confirm the deposit. Verify the information for the 
deposit on the dialog. To confirm the deposit, click OK. To cancel the deposit, click Cancel.

6. To post additional deposits for the same account, repeat steps 3 through 5 for each additional 
deposit. To post additional deposits for different accounts, repeat steps 1 through 5 as 
appropriate.

Cancel Deposit
The Cancel Deposit function is used to cancel a previously posted deposit transaction. When you 
select the Cancel tab on the Deposits screen, the Cancel Deposit screen opens.

Cancel Deposit Summary
Cancelling a deposit involves the following steps:

• Select the account associated with the deposit,

• Select the deposit to cancel,

• Select a cancel reason, and

• Cancel the deposit.

How to cancel a deposit:

1. Select Financials-›Transactions-›Deposits and select the Cancel tab.

The Cancel Deposit screen opens.

2. If the account associated with the deposit hasn’t been previously selected, select the account 
as described under Selecting Accounts on page 16-5. The Account ID, Customer Name, 
and Current Balance for the selected account will appear at the top of the screen, and a list of 
deposits associated with the selected account will appear in the Deposits box. If there is more 

than one page of deposits, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

3. Select the deposit to be cancelled. A list of transactions associated with the selected deposit 
will appear in the Transactions box.

4. Select the Cancel Reason.

5. Click Process to cancel the deposit.

6. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Cancel Reason on the dialog. To confirm the process, click OK. To cancel the process, click 
Cancel.

7. To cancel additional deposits for the same account, repeat steps 4 through 6 for each 
additional deposit. To cancel additional deposits for different accounts, repeat steps 1 
through 6 as appropriate.
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Apply Deposit
The Apply Deposit function posts non-deferred credit transactions for a specified account 
representing the principal balance and/or interest balance associated with the deposit that is 
applied to the account. When you select the Apply tab on the Deposits screen, the Apply Deposit 
screen opens.

Apply Deposit Summary
Applying a deposit involves the following steps:

• Select the account associated with the deposit,

• Select the deposit to apply,

• Select a transaction ID, enter the amount, and

• Apply the deposit.

How to apply a deposit:

1. Select Financials-›Transactions-›Deposits and select the Apply tab.

The Apply Deposit screen opens.

2. If the account associated with the deposit hasn’t been previously selected, select the account 
as described under Selecting Accounts on page 16-5. The Account ID, Customer Name, 
and Current Balance for the selected account will appear at the top of the screen, and a list of 
deposits associated with the selected account will appear in the Deposits box. If there is more 

than one page of deposits, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

3. Select the deposit to apply. A list of transactions associated with the selected deposit will 
appear in the Transactions box.

4. Select the appropriate Transaction ID.

5. Enter the Amount of the deposit to be applied to the account.

6. Click Process to apply the deposit.

7. A dialog box will appear asking you to confirm the process. Verify the Account, Transaction 
ID, Amount, and Deposit on the dialog. To confirm the process, click OK. To cancel the 
process, click Cancel.

8. To apply additional amounts for the same account, repeat steps 4 through 7 for each 
additional deposit. To apply additional amounts for different accounts, repeat steps 1 through 
7 as appropriate.

Unapply Deposit
The Unapply Deposit function cancels a previously posted deposit application transaction. When 
you select the Unapply tab on the Deposits screen, the Unapply Deposit screen opens.
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Unapply Deposit Summary
Unapplying a deposit involves the following steps:

• Select the account associated with the deposit,

• Select the appropriate deposit,

• Select the previously posted Apply Deposit transaction to cancel,

• Select a cancel reason, and

• Unapply the deposit.

How to unapply a deposit:

1. Select Financials-›Transactions-›Deposits and select the Unapply tab.

The Unapply Deposit screen opens.

2. If the account associated with the deposit hasn’t been previously selected, select the account 
as described under Selecting Accounts on page 16-5. The Account ID, Customer Name, 
and Current Balance for the selected account will appear at the top of the screen, and a list of 
deposits associated with the selected account will appear in the Deposits box. If there is more 

than one page of deposits, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

3. Select the appropriate deposit. A list of transactions associated with the selected deposit will 
appear in the Transactions box.

4. Select the previously posted Apply Deposit transaction to cancel.

5. Select the appropriate Cancel Reason.

6. Click Process to unapply the deposit.

7. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Cancel Reason on the dialog. To confirm the process, click OK. To cancel the process, click 
Cancel.

8. To unapply additional deposits for the same account, repeat steps 4 through 7 for each 
additional deposit. To unapply additional deposits for different accounts, repeat steps 1 
through 7 as appropriate.
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Post Deposit Interest
The Post Deposit Interest function posts deferred credit transactions for a specified account 
representing an amount of interest accrual for an associated deposit. When you select the Post 
Interest tab on the Deposits screen, the Post Deposit Interest screen opens.

Post Deposit Interest Summary
Posting deposit interest involves the following steps:

• Select the account associated with the deposit,

• Select the deposit to apply the interest to,

• Select a transaction ID, enter the amount, and

• Post the deposit interest.

How to post deposit interest:

1. Select Financials-›Transactions-›Deposits and select the Post Interest tab.

The Post Deposit Interest screen opens.

2. If the account associated with the deposit hasn’t been previously selected, select the account 
as described under Selecting Accounts on page 16-5. The Account ID, Customer Name, 
and Current Balance for the selected account will appear at the top of the screen, and a list of 
deposits associated with the selected account will appear in the Deposits box. If there is more 

than one page of deposits, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

3. Select the deposit to post the interest to. A list of transactions associated with the selected 
deposit will appear in the Transactions box.

4. Select the appropriate Transaction ID.

5. Enter the Amount of the deposit interest.

6. Click Process to post the deposit interest.

7. A dialog box will appear asking you to confirm the process. Verify the Account, Transaction 
ID, Amount, and original deposit on the dialog. To confirm the process, click OK. To cancel 
the process, click Cancel.

8. To post additional deposit interest for the same account, repeat steps 4 through 7 for each 
additional deposit. To post additional deposit interest for different accounts, repeat steps 1 
through 7 as appropriate.

Cancel Deposit Interest
The Cancel Deposit Interest function cancels a previously posted deposit interest transaction. 
When you select the Cancel Interest tab on the Deposits screen, the Cancel Deposit Interest 
screen opens.

Cancel Deposit Interest Summary
Cancelling deposit interest involves the following steps:

• Select the account associated with the deposit interest to be cancelled,

• Select the appropriate deposit,

• Select the deposit interest transaction to cancel,

• Select a cancel reason, and

• Cancel the deposit interest.
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How to cancel deposit interest:

1. Select Financials-›Transactions-›Deposits and select the Cancel Interest tab.

The Cancel Deposit Interest screen opens.

2. If the account associated with the deposit interest to be cancelled hasn’t been previously 
selected, select the account as described under Selecting Accounts on page 16-5. The 
Account ID, Customer Name, and Current Balance for the selected account will appear at the 
top of the screen, and a list of deposits associated with the selected account will appear in the 
Deposits box. If there is more than one page of deposits, you can move between pages using 

the  and  buttons. To change the number of transactions that appear on each page, 
enter the number in the Rows field.

3. Select the appropriate deposit. A list of deposit interest transactions associated with the 
deposit account will appear in the Transactions box.

4. Select the Deposit Interest transaction to be cancelled from the list in the Transactions box.

5. Select the Cancel Reason.

6. Click Process to cancel the deposit interest.

7. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Cancel Reason on the dialog. To confirm the process, click ‘OK’. To cancel the process, click 
‘Cancel’.

8. To cancel additional deposit interest transactions for the same account, repeat steps 4 
through 7 for each additional deposit interest transaction. To cancel additional deposit 
interest transactions for different accounts, repeat steps 1 through 7 as appropriate.
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Payments
When you select the Payments option from the Financials Menu, the Payments screen opens.

The Payments screen includes the following functions:

• Transfer Payment

• Process NSF

To access one of the functions, select the appropriate tab on the Payments screen.

Transfer Payment
The Transfer Payment function transfers individual payments between accounts. When you select 
the Transfer tab on the Payments screen, the Transfer Payment screen opens.

Transfer Payment Summary
Transferring a payment from one account to another involves the following steps:

• Select the account to transfer the payment from,

• Select the payment to be transferred,

• Select the account to transfer the payment to, and

• Transfer the payment.

How to Transfer a Payment from one account to another:

1. Select Financials-›Transactions-›Payments and select the Transfer tab.

The Transfer Payment screen opens.

2. If the account to transfer the payment from hasn’t been previously selected, select the 
account as described under Selecting Accounts on page 16-5. The Account ID, Customer 
Name, and Current Balance for the selected account will appear at the top of the screen, and 
a list of payments associated with the selected account will appear in the Payments box. If 

there is more than one page of payments, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

Note: If you reached this screen by clicking the Lock & Transfer button on the Work Queue 
screen, the Payments box will only display the item selected from the Work Queue Items list.

3. Select the payment to be transferred.

4. Select the account to transfer the payment to as described under Selecting Accounts on 
page 16-5. The Account ID, Customer Name, and Current Balance for the selected account 
will appear at the top of the Account 2 pane, and a list of payments associated with the 
selected account will appear in the Payments box. If there is more than one page of payments, 

you can move between pages using the  and  buttons. To change the number of 
transactions that appear on each page, enter the number in the Rows field.

5. Click Process to transfer the payment.

6. A dialog box will appear asking you to confirm the transfer. Verify the account IDs and 
payment amount. To confirm the transfer, click OK. To cancel the transfer, click Cancel.

7. To transfer additional payments between the same accounts, repeat steps 3 through 7 
(skipping step 4) for each additional payment. To transfer additional payments between 
different accounts, repeat steps 1 through 7 as appropriate.
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Note: If you initiated the Transfer Payment by clicking the Lock & Transfer 
button on the Work Queue screen, once the transfer is completed successfully, 
the status of the Work Queue item is automatically changed to CLOSED.

Process NSF
The Process NSF function cancels payments due to insufficient funds, and optionally to assess a 
penalty fee to the account for the cancelled payment. When you select the Process NSF tab on the 
Payments screen, the Process NSF screen opens.
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Process NSF Summary
Processing an insufficient funds (NSF) payment involves the following steps:

• Select the account associated with the NSF payment,

• Select the payment to be cancelled due to NSF,

• Select the reason for the NSF,

• Check the Apply NSF Penalty? checkbox (optional), and

• Process the NSF payment.

How to Process Insufficient Funds Payments:

1. Select Financials-›Transactions-›Payments and select the Process NSF tab.

The Process NSF screen opens.

2. If the account associated with the NSF payment hasn’t been previously selected, select the 
account as described under Selecting Accounts on page 16-5. The Account ID, Customer 
Name, and Current Balance for the selected account will appear at the top of the screen, and 
a list of payments associated with the selected account will appear in the Payments box. If 

there is more than one page of payments, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

3. Select the Payment to be cancelled.

4. Select the Reason for the cancellation from the drop-down list.

5. If appropriate, check the Apply NSF Penalty? checkbox to assess a penalty fee to the 
account associated with the cancelled payment.

The ‘Apply NSF Penalty?’ box only appears if the Reason selected is NSF. When the box 
appears, its default value is “checked”. Optionally, the user may “uncheck” it. 

6. Click Process to cancel the payment.

7. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, 
Reason, and Penalty information on the dialog. To confirm the process, click OK. To cancel 
the process, click Cancel.

8. To cancel additional payments for the same account, repeat steps 4 through and 7 for each 
additional payment. To cancel additional payments for different accounts, repeat steps 1 
through 7 as appropriate.
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Adjustments
When you select the Adjustments option from the Financials Menu, the Adjustments screen 
opens.

The Adjustments screen includes the following functions:

• Post Adjustment

• Cancel Adjustment

To access one of the functions, select the appropriate tab on the Adjustments screen.

Post Adjustment
The Post Adjustment function posts an adjustment transaction credit or charge against an 
account. When you select the Post tab on the Adjustments screen, the Post Adjustment screen 
opens.

Post Adjustment Summary
Posting an adjustment involves the following steps:

• Select the appropriate account for the adjustment,

• Select the transaction to be adjusted (optional),

• Provide the necessary data to process the adjustment, and

• Post the adjustment.

How to post an adjustment:

1. Select Financials-›Transactions-›Adjustments and select the Post tab.

The Post Adjustment screen opens.

2. If the account hasn’t been previously selected, select the account as described under 
Selecting Accounts on page 16-5. The Account ID, Customer Name, and Current Balance 
for the selected account will appear at the top of the screen, and a list of transactions 
associated with the selected account will appear in the Transactions box. If there is more than 

one page of transactions, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

3. If the adjustment is to be related to an existing transaction, select the transaction from the list.

4. Fill in the appropriate data for the Adjustment, including:

• Amount: enter the amount of the adjustment. If the adjustment is related to an existing 
transaction, the system automatically adjusts the balance by the amount of the 
transaction (though the Amount field is not populated). Optionally, the user may enter 
an amount to override the amount of the related transaction.

• Budget Plan (drop-down list): select the appropriate budget plan for the adjustment. 
If a Budget Plan is selected, the resulting adjustment is automatically DEFERRED. If the 
adjustment is related to a transaction (see Step 3) that is related to an existing Budget 
Plan, this drop-down list defaults to the related Budget Plan.

• Adjustment Type (drop-down list): select the appropriate Adjustment Type.

• Receivable Type (drop-down list): select the appropriate receivable type for the 
adjustment. If the adjustment is related to an existing transaction, this defaults to the 
receivable type of the selected transaction.
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• Credit or Charge (drop-down list): select whether the adjustment is to be a Charge or 
Credit transaction. If the adjustment is related to an existing transaction, this defaults to 
the Reverse of the selected transaction.

• Charge Type (drop-down list): select the appropriate charge type for the adjustment. 
If the adjustment is related to an existing transaction, this defaults to the charge type of 
the selected transaction.

• Application Method (drop-down list): select the appropriate application method for 
the adjustment. Available methods include:

• Related: relates the adjustment to the selected transaction. Checking this may 
populate other fields on the Post Adjustment screen, based on the related 
transaction. Available only if the Charge or Credit field is set to Charge.

• Defer Balance: defers the account balance. Available only if the Charge or Credit 
field is set to Charge.

• Invoice ID: applies the adjustment to a specified Invoice ID. Selecting this method 
causes the Invoice ID field to appear on the Post Adjustment screen.

• Deferred Credit: places an unapplied credit on the account.

• Immediate: applies the adjustment against any outstanding charges.

• Invoice ID (drop-down list): select the appropriate invoice ID. Note that this field only 
appears if Invoice ID is selected from the Application Method drop-down list.

5. Click Process to post the adjustment. Click Reset to reset all the values on the screen.

6. A dialog box will appear asking you to confirm the process. Verify the information on the 
dialog. To confirm the adjustment, click OK. To cancel the adjustment, click Cancel.

7. To process additional adjustments for the same account, repeat steps 3 through 6 for each 
additional payment. To process additional adjustments for different accounts, repeat steps 1 
through 6 as appropriate.

Cancel Adjustment
The Cancel Adjustment function cancels a previous adjustment. When you select the Cancel tab 
on the Adjustments screen, the Cancel Adjustment screen opens.

Cancel Adjustment Summary
Cancelling an adjustment involves the following steps:

• Select the account associated with the adjustment,

• Select the adjustment,

• Select a cancel reason, and

• Cancel the adjustment.

How to cancel an adjustment:

1. Select Financials-›Transactions-›Adjustments and select the Cancel tab.

The Cancel Adjustment screen opens.

2. If the account associated with the adjustment hasn’t been previously selected, select the 
account as described under Selecting Accounts on page 16-5. The Account ID, Customer 
Name, and Current Balance for the selected account will appear at the top of the screen, and 
a list of adjustment transactions associated with the selected account will appear in the 
Transactions box. If there is more than one page of transactions, you can move between 

pages using the  and  buttons. To change the number of transactions that appear on 
each page, enter the number in the Rows field.
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3. Select the Adjustment to be cancelled.

4. Select the Cancel Reason.

5. Click Process to cancel the adjustment. Click Reset to reset all the values on the screen.

6. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Reason on the dialog. To confirm the process, click OK. To cancel the process, click Cancel.

7. To cancel additional adjustments for the same account, repeat steps 3 through 6 for each 
additional adjustment. To cancel additional adjustments for different accounts, repeat steps 1 
through 6 as appropriate.
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Refunds
When you select the Refunds option from the Left Menu, the Refunds screen opens.

The Refunds screen includes the following functions:

• Post Refund

• Cancel Refund

• Update Refund

To access one of the functions, select the appropriate tab on the Refunds screen.

Post Refund
The Post Refund function posts a refund transaction charge against an account. When you select 
the Post tab on the Refunds screen, the Post Refund screen opens.

Post Refund Summary
Posting a refund involves the following steps:

• Select the account associated with the refund to be posted,

• Select the refund type and refund reason,

• Enter the amount of the refund,

• Select an optional credit transaction, and

• Post the refund.

How to post a refund:

1. Select Financials-›Transactions-›Refunds and select the Post tab.

The Post Refund screen opens.

2. If the account associated with the refund to be posted hasn’t been previously selected, select 
the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of payment, credit adjustment, and other refund transactions associated with 
the selected account will appear in the Transactions box. If there is more than one page of 

transactions, you can move between pages using the  and  buttons. To change the 
number of transactions that appear on each page, enter the number in the Rows field.

3. Enter the amount of the refund in the Amount field or select a credit transaction from the 
Transactions list. The Amount is automatically populated with the amount of the credit 
transaction.

Note: Selecting transactions on this window is restricted. To enable this functionality, select 
the “Allow Transaction Selection” permission on the Roles screen in the Security 
Administration user interface for all applicable Roles.

4. Select the Refund Reason from the drop-down.

5. Select the Refund Type from the drop-down list.

6. Click Process to post the refund. Click Reset to reset all the values on the screen.

7. A dialog box will appear asking you to confirm the refund. Verify the Account ID, the 
Amount of the refund, and the Refund Type on the dialog. To confirm the refund, click OK. 
To cancel the refund, click Cancel.

8. To post additional refunds for the same account, repeat steps 3 through 7 for each additional 
refund. To post additional refunds for different accounts, repeat steps 1 through 7 as 
appropriate.
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Cancel Refund
The Cancel Refund function cancels a previous refund. When you select the Cancel tab on the 
Refunds screen, the Cancel Refund screen opens.

Cancel Refund Summary
Cancelling a refund involves the following steps:

• Select the account associated with the refund to be cancelled,

• Select the refund transaction to cancel,

• Select a cancel reason, and

• Cancel the refund.

How to cancel a refund:

1. Select Financials-›Transactions-›Refunds and select the Cancel tab.

The Cancel Refunds screen opens.

2. If the account associated with the refund to be cancelled hasn’t been previously selected, 
select the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of refund transactions associated with the selected account will appear in the 
Transactions box. If there is more than one page of transactions, you can move between 

pages using the  and  buttons. To change the number of transactions that appear on 
each page, enter the number in the Rows field.

3. Select the Refund to be cancelled.

4. Select the Cancel Reason from the drop-down list.

5. Click Process to cancel the refund. Click Reset to reset all the values on the screen.

6. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Reason on the dialog. To confirm the process, click OK. To cancel the process, click Cancel.

7. To cancel additional refunds for the same account, repeat steps 3 through 6 for each 
additional refund. To cancel additional refunds for different accounts, repeat steps 1 through 
7 as appropriate.
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Update Refund
The Update Refund function updates a refund’s status. When you select the Update tab on the 
Refunds screen, the Update Refund screen opens.

Update Refund Summary
Update a refund’s status involves the following steps:

• Select the account associated with the refund to be updated,

• Select the refund transaction to update,

• Select the status you wish to update the refund to, and

• Update the refund.

How to update a refund:

1. Select Financials-›Transactions-›Refunds and select the Update tab.

The Update Refunds screen opens.

2. If the account associated with the refund to be updated hasn’t been previously selected, select 
the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of refund transactions associated with the selected account will appear in the 
Transactions box. If there is more than one page of transactions, you can move between 

pages using the  and  buttons. To change the number of transactions that appear on 
each page, enter the number in the Rows field.

3. Select the Refund to be updated.

4. Select the Refund Status from the drop down list. Note that it is an error if the selected 
status is inappropriate for the selected transaction. Also note that the drop down list will 
appear blank if there is no appropriate status to update the selected refund to.

5. Click Process to update the refund. Click Reset to reset all the values on the screen.

6. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Reason on the dialog. To confirm the process, click OK. To cancel the process, click Cancel.

7. To update additional refunds for the same account, repeat steps 4 through 6 for each 
additional refund. To update additional refunds for different accounts, repeat steps 1 through 
6 as appropriate.
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Write Offs
When you select the Writeoffs option from the Financials Menu, the Writeoffs screen opens.

The Writeoffs screen includes the following functions:

• Post Write Off

• Cancel Write Off

• Write Off Account

• Write On Account

To access one of the functions, select the appropriate tab on the Writeoffs screen.

Post Write Off
The Post Write Off function posts a write-off transaction credit or charge against an account. 
When you select the Post tab on the Writeoffs screen, the Post Writeoff screen opens.

Post Write Off Summary
Posting a write off involves the following steps:

• Select the appropriate account for the transaction to be written off,

• Select the transaction to be written off,

• Select the reason for the write off, and

• Post the write off.

How to post a write off:

1. Select Financials-›Transactions-›Writeoffs and select the Post tab.

The Post Writeoff screen opens.

2. If the account for the transaction to be written off hasn’t been previously selected, select the 
account as described under Selecting Accounts on page 16-5. The Account ID, Customer 
Name, and Current Balance for the selected account will appear at the top of the screen, and 
a list of transactions with a non-zero balance associated with the selected account will appear 
in the Transactions box. If there is more than one page of transactions, you can move 

between pages using the  and  buttons. To change the number of transactions that 
appear on each page, enter the number in the Rows field.

3. Select the Transaction to be written off.

4. Select the Transaction ID for the write off from the drop-down list.

5. Click Process to post the write off.

6. A dialog box will appear asking you to confirm the write off. Verify the Account ID, 
Transaction ID, and Balance for the transaction being written off on the dialog. To confirm 
the write off, click OK. To cancel the write off, click Cancel.

7. To process additional write offs for different transactions for the same account, repeat steps 3 
through 6 for each additional write off. To process additional write offs for different 
accounts, repeat steps 1 through 6 as appropriate.
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Cancel Write Off
The Cancel Write Off function cancels a previous write-off transaction. When you select the 
Cancel tab on the Writeoffs screen, the Cancel Writeoff screen opens.

Cancel Write Off Summary
Cancelling a write off involves the following steps:

• Select the account associated with the write off transaction,

• Select the write-off transaction to cancel,

• Select a Cancel Reason, and

• Cancel the write off.

How to cancel a write off:

1. Select Financials-›Transactions-›Writeoffs and select the Cancel tab.

The Cancel Writeoff screen opens.

2. If the account associated with the write off transaction hasn’t been previously selected, select 
the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of write off transactions associated with the selected account will appear in 
the Transactions box. If there is more than one page of transactions, you can move between 

pages using the  and  buttons. To change the number of transactions that appear on 
each page, enter the number in the Rows field.

3. Select the write-off Transaction to be cancelled.

4. Select the Cancel Reason from the drop-down list.

5. Click Process to cancel the write off.

6. A dialog box will appear asking you to confirm the process. Verify the Account, Amount, and 
Reason on the dialog. To confirm the process, click OK. To cancel the process, click Cancel.

7. To cancel additional write offs for the same account, repeat steps 3 through 6 for each 
additional write off. To cancel additional write offs for different accounts, repeat steps 1 
through 6 as appropriate.
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Write Off Account
The Write Off Account function posts a write-off transaction for each outstanding (balance > 0) 
transaction that has been previously posted for the account. When you select the Writeoff 
Account tab on the Writeoffs screen, the Writeoff Account screen opens.

Write Off Account Summary
Writing off an account involves the following steps:

• Select the appropriate account to be written off,

• Select the Transaction ID and reason for the write off, and

• Write off the account.

How to write off an account:

1. Select Financials-›Transactions-›Writeoffs and select the Writeoff Account tab.

The Writeoff Account screen opens.

2. If the account to be written off hasn’t been previously selected, select the account as 
described under Selecting Accounts on page 16-5. The Account ID, Customer Name, and 
Current Balance for the selected account will appear at the top of the screen, and a list of 
transactions associated with the selected account will appear in the Transactions box. If there 

is more than one page of transactions, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

3. Select the appropriate Transaction ID for the write off.

4. Select the Writeoff Reason for the write off from the drop-down list.

5. Click Process to write off the account.

6. A dialog box will appear asking you to confirm the write off. Verify the Account, Transaction 
ID, Balance, and Writeoff Reason on the dialog. To confirm the write off, click OK. To cancel 
the write off, click Cancel.

7. To write off other accounts, repeat steps 1 through 8 as appropriate.
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Write On Account
The Write On Account function cancels all previous write-off transactions for the account. When 
you select the Writeon Account tab on the Writeoffs screen, the Writeon Account screen opens.

Write On Account Summary
Writing on an account involves the following steps:

• Select the appropriate account to be written on,

• Select the Transaction ID, Cancel Reason, and Receivable Status for the account, and

• Write on the account.

How to write on an account:

1. Select Financials-›Transactions-›Writeoffs and select the Writeon Account tab.

The Writeon Account screen opens.

2. If the account to be written on hasn’t been previously selected, select the account as described 
under Selecting Accounts on page 16-5. The Account ID, Customer Name, and Current 
Balance for the selected account will appear at the top of the screen, and a list of write off 
transactions associated with the selected account will appear in the Transactions box. If there 

is more than one page of transactions, you can move between pages using the  and  
buttons. To change the number of transactions that appear on each page, enter the number in 
the Rows field.

3. Select the Cancel Reason for the write on from the drop-down list.

4. Select the new Receivable Status for the Account.

5. Click Process to write on the account.

6. A dialog box will appear asking you to confirm the write on. Verify the Account, Cancel 
Reason, and Receivable Status on the dialog. To confirm the write on, click OK. To cancel the 
write on, click Cancel.

7. To write on other accounts, repeat steps 1 through 9 as appropriate.
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Balance Transfers
When you select the Balance Transfers option from the Financials Menu, the Balance Transfers 
screen opens.

The Balance Transfers screen includes the following functions:

• Transfer Balance

• Return Balance

To access one of the functions, select the appropriate tab on the Balance Transfers screen.

Transfer Balance
The Transfer Balance function posts a balance transfer transaction for each outstanding 
transaction (balance > 0) that has been previously posted for the account. When you select the 
Transfer Balance tab on the Balance Transfers screen, the Transfer Balance screen opens.

Transfer Balance Summary
Transferring a balance involves the following steps:

• Select the account from which the balance is to be transferred,

• Select the target account to which the balance will be transferred,

• Transfer the balance.

How to transfer a balance:

1. Select Financials-›Transactions-›Balance Transfers and select the Transfer Balance tab.

The Transfer Balance screen opens.

2. If the account from which the balance is to be transferred hasn’t been previously selected, 
select the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of write off transactions associated with the selected account will appear in 
the Transactions box. If there is more than one page of transactions, you can move between 

pages using the  and  buttons. To change the number of transactions that appear on 
each page, enter the number in the Rows field.

3. Select the account to transfer the balance to as described under Selecting Accounts on page 
16-5. The Account ID, Customer Name, and Current Balance for the selected account will 
appear at the top of the Target pane, and a list of transactions with a balance greater than zero 
associated with the selected account will appear in the Transactions box. If there is more than 

one page of transactions, you can move between pages using the  and  buttons. To 
change the number of transactions that appear on each page, enter the number in the Rows 
field.

4. Select the Application Method from the drop-down box. Balance transfers can be either 
“Unapplied” (the default), or “Immediate.”

5. Click Process to transfer the balance.

6. A dialog box will appear asking you to confirm the transfer. Verify the information 
concerning the transfer. To confirm, click OK. To cancel, click Cancel.

7. To transfer additional balances for different accounts, repeat steps 1 through 5 as appropriate.
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Return Balance
The Return Balance function cancels all previous balance transfer transactions for the account. 
When you select the Return Balance tab on the Balance Transfers screen, the Return Balance 
screen opens.

Return Balance Summary
Returning a balance involves the following steps:

• Select the account associated with the balance to be returned, and

• Return the balance.

How to return a balance:

1. Select Financials-›Transactions-›Balance Transfers and select the Return Balance tab.

The Return Balance screen opens.

2. If the account associated with the balance to be returned hasn’t been previously selected, 
select the account as described under Selecting Accounts on page 16-5. The Account ID, 
Customer Name, and Current Balance for the selected account will appear at the top of the 
screen, and a list of previously transferred transactions associated with the selected account 
will appear in the Transactions box. If there is more than one page of transactions, you can 

move between pages using the  and  buttons. To change the number of transactions 
that appear on each page, enter the number in the Rows field.

3. Click Process to return the balance.

4. A dialog box will appear asking you to confirm the process. Verify the Account on the dialog. 
To confirm the process, click OK. To cancel the process, click Cancel.

5. To return additional balances for different accounts, repeat steps 1 through 4 as appropriate.
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Chapter 17
Receivables Management Work Queues

This chapter describes how users work with work queues in the Oracle Utilities Receivables 
Component user interface. Work queue items represent transactions, including charges, payments 
and other transactions, that for some reason need to be processed by a user manually (usually 
through one or more of the functions of the Oracle Utilities Receivables Component user 
interface).

More information about work queues can be found in Appendix C: Messaging in the Oracle 
Utilities Billing Component Installation and Configuration Guide. Volume 2.
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Working with Work Queues
The Work Queues function is used to process work queue items associated with transactions. 
When you select the Work Queue option from the Financials Menu, the Work Queue screen 
opens.

There are four main work queue functions available through the Work Queue screen, some of 
which correspond to messaging functions described in Appendix C: Messaging in the Oracle 
Utilities Billing Component Installation and Configuration Guide. Volume 2, including:

• Lock: locks the work queue item to prevent other users from working with it (this 
corresponds to the Hold Message function),

• Unlock: unlocks a previously locked work queue item to allow other users to work with it 
(this corresponds to the Release Message function),

• Close: closes the work queue item (this corresponds to the Close Message function), and

• Lock & Transfer: locks the work queue item to prevent other users from working with it (as 
above), and triggers the Transfer Payment function. See Transfer Payment on page 16-3 for 
more information.

Work Queue Summary
Working with work queues involves the following steps:

• Select the function you wish to perform (Lock, Unlock, Close, or Lock & Transfer),

• Search for the work queue items to be processed, based on specific criteria,

• View details of work queue (if necessary or desired),

• Select the work queue item to process.

How to work with Work Queue items:

1. Select Financials-›Work Queue.

The Work Queue screen opens.

2. In the lower pane of the Work Queue screen, select the tab for the function you wish to 
perform. There are four choices:

• Lock: locks the work queue item to prevent other users from working with it, and 
changes the status of the item to ‘Locked’.

• Unlock: unlocks a previously locked work queue item to allow other users to work with 
it, and restores the status to ‘Open’.

• Close: closes the work queue item, and changes the status to ‘Closed’.

• Lock & Transfer: locks the work queue item to prevent other users from working with 
it, changes the status of the item to ‘Locked’ (as above), and triggers the Transfer 
Payment function. See Transfer Payment on page 16-3 for more information.

3. In the top pane of the Work Queue screen, enter the search criteria for the work queue items 
you wish to work with.

You can search by the following criteria:
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• Account ID: the account ID associated with the work queue item(s) (see Selecting 
Accounts on page 16-5 for more information about searching accounts),

• Date: the date of the work queue item(s),

• Proc. by User ID: the User ID of the user who closed the work queue item(s), or who 
currently has the item(s) locked.

• Work Queue Type: the type of work queues you want to work with (such as 
UNPOSTABLE_PAYMENT),

• Market: the market (operating company) associated with the work queue item(s).

You can enter search criteria in any or all of the above fields. To clear the data in the pane, 
click the Reset link.

To start the search based on the entered criteria, click the Search link.

4. A list of work queue items based on the search criteria will appear in the lower pane. If there 

is more than one page of search results, you can move between pages using the  and  
buttons. To change the number of work queue items that appear on each page, enter the 
number in the Rows field.

The results displayed are filtered based on the tab (function) selected. The Lock tab displays 
only Open items. The Unlock tab displays only Locked items. The Close and Lock and 
Transfer tabs display Open and Locked items.

5. To view the details of the transaction associated with the work queue item, click the icon at 
the far left of the line on which the work queue item appears. The Details window opens, 
displaying data related to the transaction.

6. Click the Message ID link for the work queue item you wish to process. If the Message ID 
link is not active, you can’t process the item. For example, users can’t Unlock items that were 
previously locked by a different user.

7. To process additional work queue items based on the same search criteria, repeat steps 4 
through 6 for each additional work queue item. To process additional work queue items based 
on different criteria, repeat steps 2 through 6 as appropriate.
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Chapter 18
Receivables Management Controls

This chapter describes how users work with controls in the Oracle Utilities Receivables 
Component user interface. Control items are messages generated by the various functions of the 
Oracle Utilities Receivables Component related to specific transactions. These can include 
messages confirming the posting of a charge or credit transaction, or the cancellation or transfer 
of a payment, or other transactions processed by Oracle Utilities Receivables Component. The 
Controls functionality of the Oracle Utilities Receivables Component user interface allows users to 
view control messages based on specified search criteria.

More information about controls and control messages can be found in Appendix C: Messaging 
in the Oracle Utilities Billing Component Installation and Configuration Guide. Volume 2.
Receivables Management Controls 18-1



Working with Controls
Working with Controls
The Controls function is used to view control items associated with transactions based on 
specified search criteria (date, control type, etc.). When you select the Controls option from the 
Financials Menu, the Controls screen opens.

Controls Summary
Working with controls involves the following steps:

• Search for the controls items to be viewed, based on specific criteria,

• Select the control item to view, and

• View details of the control item

How to view Control items:

1. Select Financials-›Controls.

The Controls screen opens.

2. In the Search Controls pane, enter the search criteria for the control items you wish to view.

You can search by the following criteria:

• Account ID: the account ID associated with the work queue item(s) (see Selecting 
Accounts on page 16-5 for more information about searching accounts),

• Posted Date: the date of the work queue item(s),

• User ID: the User ID of the user who closed the work queue item(s), or who currently 
has the item(s) locked.

• Control Type: the type of control messages you want to work with (such as 
SRVCHG_TXACTION_POSTED),

• Market: the market (operating company) associated with the work queue item(s).

• Amount: the amount of the transaction associated with the control item(s).

You can enter search criteria in any or all of the above fields. To clear the data in the pane, 
click the Reset link.

To start the search based on the entered criteria, click the Search link.

3. A list of control items based on the search criteria will appear in the Items box. If there is 

more than one page of search results, you can move between pages using the  and  
buttons.

4. Select the control item you wish to view.

5. To view the details of the transaction associated with the control item, click the icon at the far 
left of the line on which the control item appears. The Details window opens, displaying data 
related to the transaction.

6. To view additional control items based on the same search criteria, repeat steps 4 through 5 
for each additional work queue item. To view additional control items based on different 
criteria, repeat steps 2 through 5 as appropriate.
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Chapter 19
Collections

This chapter describes how users work with collections functions in the Oracle Utilities 
Receivables Component user interface, including:

• Collections Functions Overview

• Working with Collections Functions

• Collection Arrangements

• Collections Exemptions

• Work Queue

• Manual Submission

• Collections Reports

More information about collections functions can be found in Chapter 9: Collections in the 
Oracle Utilities Billing Component Installation and Configuration Guide. Volume 2.
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Collections Functions Overview
The collections functionality of the Oracle Utilities Receivables Component includes the ability to 
perform a variety of collections-related tasks types, including:

• Collection Arrangements: functionality allows the user to view, create, and edit collection 
arrangements and related payment arrangements for accounts.

• Collections Exemptions: allows the user to view, create, and edit collection exemptions for 
accounts.

• Work Queue: functionality allows the user to view and work with work queue items 
generated from collection processes.

• Manual Submission: allows the user to manually initiate a collections process for a selected 
account. This process can be initiated at any point in the process.

• Collections Reports: include a number of reports detailing collections-related information. 
These reports include:

• Performance Rating Summary Report: provides a summary of the overall credit 
worthiness of the customer base based on the customer’s collection process and payment 
history.

• Work Queue Summary Report: provides a summary of the total number of items in 
the Collections work queue.

• Collection Exemption Summary Report: lists the overall number of accounts that 
have Collection Exemptions by exemption status.

• Collection Activity Summary Report: provides overall totals of the collections 
activities executed between a user-specified Start and Stop time.

• Process Status Report: lists collections processes based on Operating Company, 
Jurisdiction, Process Name, Account ID, and Process State.
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Working with Collections Functions
This section provides general information related to working with collections functions, including:

• Selecting Accounts

Selecting Accounts
Before you can work with most of the collections functions using the Oracle Utilities Receivables 
Component, you must first select the account(s) you wish to work with. If an account has not 
been previously selected, you can select an account using the following procedure.

How to select accounts when working with collections functions:

1. Click the Search Account button ( ) at the top of the screen. This opens the Accounts 
window.

2. Enter the search criteria in the appropriate field.

You can search based on the customer Name, Customer ID, or an Account ID associated 
with the account. You can also search based on Account Status, Operating Company, and/or 
Jurisdiction. To search on one of these, select it from the drop-down lists. In addition, you 
can search based on contact information such as phone number, address, city/state, etc.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the 
fields. For instance, if you want to search for all accounts whose name begins with the letter 
G, you could enter “G%” in the Name field, and the search would retrieve all users that begin 
with the letter G. You can use this wildcard before or after specified letters or numbers (i.e. 
you would use %t to search for all accounts whose name ends with the letter t, etc.).

3. Specify how the search results are displayed.

• Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign. 
See Specifying How Results are Sorted on page 2-7 for more information.

• Specify how many results should appear on each page in the Page Length field.

4. Click Search to perform the search. To clear all the search fields, click Reset.

5. The Accounts window displays the search results.

6. Click on the Account ID of the account you wish to use. If there is more than one page of 

search results, you can move between pages using the  and  buttons. To change the 
number of results that appear on each page, enter the number in the Rows field.

7. The Account ID and Customer Name for the selected account will appear at the top of the 
screen.
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Collection Arrangements
The Collection Arrangements functions are used to view, create, and edit collection arrangements 
and related payment arrangements for accounts.

Collection Arrangements Summary
Working with collection arrangements involves the following steps:

• Select the appropriate account (see Selecting Accounts on page 19-3),

• Select the collection arrangement to view/edit, and

• View/edit details of the collection arrangement and related payment arrangements.

How to view Collection Arrangements for an account:

1. Select Financials-›Collections-›Arrangements.

The Collection Arrangements screen opens.

If you haven’t yet selected an account, click the Search Account button ( ) at the top of the 
screen to select the account you wish to view. See Selecting Accounts on page 19-3 for more 
information.

2. A list of collection arrangements for the selected account will appear on the Collection 
Arrangements screen.

How to view or edit Collection Arrangements details:

1. Click the Edit Record icon ( )for the collection arrangement you wish to view or edit.

The Collection Arrangement screen opens displaying details of the arrangement and a list of 
related payment arrangements beneath it. If there is more than one page of payment 

arrangements, you can move between pages using the  and  buttons. To change the 
number of records that appear on each page, enter the number in the Rows field.

2. To edit the collection arrangement record, click Modify in the Collection Arrangement box.

The Collection Arrangement screen opens as an edit screen.

3. Modify the record as appropriate:

• To change the Start Date, click the arrow and select the date using the calendar control 
or type the date manually.

• Edit the No. of Payments as appropriate.

• Edit the Total Amount as appropriate.

• To change the First Payment Due Date, click the arrow and select the date using the 
calendar control or type the date manually.

• Change Collection Arrangement Type using the Browse button ( ). This button 

opens a dialog window that lists all the available types. Click the [...] link for the 
appropriate type. The field is automatically populated.

4. Click Save to save the changes made to the collection arrangement. To close this screen 
without saving changes, click Cancel.

If you made changes to either the No. of Payments or the Total Amount, the values of the 
related payments arrangements are adjusted accordingly. The Total Amount is distributed 
evenly among the payments.
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How to delete a Collection Arrangement:

1. Click the Delete Record icon ( )for the collection arrangement you wish to delete.

The Delete Arrangement Record dialog opens.

2. Click OK to delete the collection arrangement. To close the dialog without deleting the 
collection arrangement, click Cancel.

The deleted collection arrangement no longer appears on the Collection Arrangements 
screen.

How to add a Collection Arrangement:

1. Click Add on the Collections Arrangements screen.

The Collection Arrangement screen opens as an edit screen.

2. Enter the Start Date by clicking the arrow and selecting the date using the calendar control 
or by typing the date manually.

3. Enter the No. of Payments for the collection arrangement

4. Enter the Total Amount for the collection arrangement.

5. Enter the First Payment Due Date by clicking the arrow and selecting the date using the 
calendar control or by typing the date manually.

6. Select the Collection Arrangement Type for the collection arrangement using the Browse 

button ( ). This button opens a dialog window that lists all the available types. Click the [...] 

link for the appropriate type. The field is automatically populated.

7. Click Save to save the collection arrangement. To close this screen without saving the 
collection arrangement, click Cancel.

The collection arrangement appears on the Collection Arrangement screen, along with a list 
of related payment arrangements, based on the Total Amount and the No. of Payments of 
the collection arrangement. By default, payments are scheduled as due monthly starting one 
month after the Start Date of the collection arrangement. The amount of each payment is 
equal to the Total Amount divided by the No. of Payments.

When a collection arrangement is created, the system automatically creates a collection 
exemption of type 'Arrangement Exemption' for the total amount of the arrangement. When 
the arrangement is completed or defaulted, the status of the exemption is set to EXPIRED. 
Deleting a collection arrangement also deletes the associated collection exemption for that 
arrangement.

In addition, when a collection arrangement is created, the status of any collections processes 
running for the account are set to SUSPENDED.

How to edit a Payment Arrangement related to a Collection Arrangement:

1. Click the Edit Record icon ( )for the payment arrangement you wish to edit.

The Collection Arrangement screen opens as an edit screen.

2. Modify the record as appropriate:

• To change the Due Date, click the arrow and select the date using the calendar control 
or type the date manually.

• Edit the Due Amount as appropriate.

3. Click Save to save the changes made to the payment arrangement. To close this screen 
without saving changes, click Cancel.

If you changed the Due Amount, the Total Value of the Collection Arrangement is adjusted 
accordingly.
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How to delete a related Payment Arrangement:

1. Click the Delete Record icon ( )for the payment arrangement you wish to delete.

The Delete Payment Record dialog opens.

2. Click OK to delete the payment arrangement. To close the dialog without deleting the 
payment arrangement, click Cancel.

The deleted payment arrangement no longer appears in the Payment Arrangements list, and 
the Total Value of the collection arrangement is adjusted accordingly.

How to add a related Payment Arrangement:

1. Click Add in the Payment Arrangements box.

The Collection Arrangement screen opens as an edit screen.

2. Enter the Due Date by clicking the arrow and selecting the date using the calendar control or 
by typing the date manually.

3. Enter the Due Amount as appropriate.

4. Click Save to save the payment arrangement. To close this screen without saving the payment 
arrangement, click Cancel.

The payment arrangement appears in the Payment Arrangements list, and the Total Value of 
the collection arrangement is adjusted accordingly.
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Collections Exemptions
The Collections Exemptions functions are used to view, create, and edit collection exemptions for 
accounts.

Collection Exemptions Summary
Working with collection exemptions involves the following steps:

• Select the appropriate account (see Selecting Accounts on page 19-3),

• Select the collection exemption to edit, and

• Edit details of the collection exemption as appropriate.

How to view Collection Exemptions for an account:

1. Select Financials-›Collections-›Exemptions.

The Collection Exemptions screen opens.

If you haven’t yet selected an account, click the Search Account button ( ) at the top of the 
screen to select the account you wish to view. See Selecting Accounts on page 19-3 for more 
information.

2. A list of exemptions for the selected account will appear on the Collection Exemptions 
screen.

How to edit a Collection Exemption:

1. Click the Edit Record icon ( )for the exemption you wish to view or edit.

The Collection Exemption screen opens as an edit screen.

2. Modify the record as appropriate:

• Change Collection Exemption Type using the Browse button ( ). This button 

opens a dialog window that lists all the available types. Click the [...] link for the 
appropriate type. The field is automatically populated.

• To change the Start Date, click the arrow and select the date using the calendar control 
or type the date manually.

• To change the Stop Date, click the arrow and select the date using the calendar control 
or type the date manually.

• Edit the Exemption Amount as appropriate.

• Edit (or enter) an optional Note.

• Select the appropriate Status (Current or Expired) from the drop-down list.

3. Click Save to save the changes made to the exemption. To close this screen without saving 
changes, click Cancel.

How to delete a Collection Exemption:

1. Click the Delete Record icon ( )for the exemption you wish to delete.

The Delete Exemption Record dialog opens.

2. Click OK to delete the collection exemption. To close the dialog without deleting the 
collection exemption, click Cancel.

The deleted exemption no longer appears on the Collection Exemptions screen.
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How to add a Collection Exemption:

1. Click Add on the Collections Exemptions screen.

The Collection Exemption screen opens as an edit screen.

2. Select the Collection Exemption Type using the Browse button ( ). This button opens a 

dialog window that lists all the available types. Click the [...] link for the appropriate type. The 
field is automatically populated.

3. Enter the Start Date by clicking the arrow and selecting the date using the calendar control 
or by typing the date manually.

4. Enter the Stop Date by clicking the arrow and selecting the date using the calendar control or 
by typing the date manually.

If you don’t enter a Stop Date, the collection exemption remains in effect indefinitely. The 
only exception to this rule is in the case of collection exemptions that are created 
automatically by creating a collection arrangement. These exemptions do not have a Stop 
Date when they are initially created, but after the arrangement is completed or expired, the 
Stop Date will be populated with the date that the arrangement was completed or expired.

5. Enter the Exemption Amount as appropriate.

Leaving the amount blank exempts the entire account. In this case, regardless of what the 
past due balance is on the account, the account will never go into collections.

6. Enter an optional Note.

7. Click Save to save the exemption. To close this screen without saving the exemption, click 
Cancel.

The exemption appears on the Collection Exemption screen.
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Work Queue
The Work Queue function is used to process work queue items associated with collections 
processes.

Working with the work queue involves the following steps:

• Search for work queue items based on specific criteria,

• View details of work queue (if necessary or desired),

• Select the work queue item(s) to process.

• Select the function you wish to perform (Lock, Unlock, Update, or Close)

Work Queue Functions
There are four main work queue functions available through the Work Queue screen. Some of 
these functions correspond to messaging functions described in Appendix C: Messaging in the 
Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2, including:

• Lock: locks the work queue item to prevent other users from working with it (this 
corresponds to the Hold Message function).

• Unlock: unlocks a previously locked work queue item to allow other users to work with it 
(this corresponds to the Release Message function).

• Update: updates the data associated with the work queue item. This is useful when the 
context of the activity represented by the item must be updated. 

• Close: closes the work queue item (this corresponds to the Close Message function).

How to search for work queue items:

1. Select Financials-›Collections-›Work Queue.

The Work Queue screen opens.

2. Enter the search criteria for the work queue items you wish to work with.

You can search by the following criteria:

• Account ID: the account ID associated with the work queue item(s), and

• Work Queue Type: the type of work queues you want to work with,

• Juris: the jurisdiction associated with the work queue item(s),

• Locked User: the User ID of the user closed the work queue item(s), or who currently 
has the item(s) locked.

• Opco: the operating company associated with the work queue item(s),

You can enter search criteria in any or all of the above fields. To start the search based on the 
entered criteria, click Search. To reset the fields, click Reset.

3. A list of work queue items based on the search criteria will appear.

How to work with work queue items:

1. Select the work queue item you wish to work with using the radio buttons in the far left 
column. The activity context of the selected item will appear in the Message Data box. If 
there is a note associated with the item, it will be displayed in the Note box.

To select multiple work queue items, check the checkbox on each item to be selected. To 
select all the work queue items, check the top checkbox, located in the row of headings. If you 
select multiple items, the Data and Note boxes will be blank.

To view a work queue, click the Type link. The Work Queue Item dialog opens displaying the 
selected item.
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2. Click the appropriate function based what you wish to do with the item(s). There are four 
choices:

• Lock: locks the work queue item to prevent other users from working with it, and 
changes the status of the item to ‘Locked’.

• Unlock: unlocks a previously locked work queue item to allow other users to work with 
it, and restores the status to ‘Open’.

• Update: updates the work queue item based on changes made to either the Data or 
Note associated with the work queue item. This function cannot be used with multiple 
work queue items.

• Close: closes the work queue item, and changes the status to ‘Closed’. If the Approved 
checkbox is checked, this function also inserts the Approved attribute into the 
CONTEXT element of the activity context, the value of which is set to TRUE 
(Approved=“TRUE”). The work queue item disappears from the list once it has been 
closed. This function also triggers the Activity Finished function.

3. To process additional work queue items based on the same search criteria, repeat steps 1 and 
2 for each additional work queue item. To process additional work queue items based on 
different criteria, repeat the steps outlined under How to search for work queue items: on 
page 19-9 and repeat steps 1 and 2 above as appropriate.
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Manual Submission
The Manual Submission functions are used to manually initiate collection processes for accounts.

Manual Submission Summary
Working with manual submission involves the following steps:

• Select the appropriate account (see Selecting Accounts on page 19-3),

• Select the process you wish to initiate and the activity at which point you wish to start the 
process,

• Enter details required by the process/activity as appropriate.

How to manually initiate a collections process for an account:

1. Select Financials-›Collections-›Manual Submission.

The Manual Submission screen opens.

If you haven’t yet selected an account, click the Search Account button ( ) at the top of the 
screen to select the account you wish to view. See Selecting Accounts on page 19-3 for more 
information.

2. Select the process you wish to initiate for the account from the Process drop-down list. The 
processes in this list are those where the Manual Submission flag is set to yes on the Processes 
screen of the workflow management application. See Manual Submission Flag on page 24-
2 of the Oracle Utilities Billing Component User’s Guide for more information.

The activities associated with the selected process appear in the box below the Process drop-
down list.

3. Select the activity at which point you wish to start the collections process. Unavailable 
activities appear in light grey type and cannot be selected. The process activities in this list are 
those where the Recommended Starting Point flag is set to yes on the Process Activities 
screen of the workflow management application. See Recommended Starting Point Flag 
on page 25-4 of the Oracle Utilities Billing Component User’s Guide for more information.

The Transition Condition and Process Context (if any) associated with the selected activity 
below the activities list box.
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4. Enter the appropriate value for the Transition Condition or Process Context in the 
Transition Condition or Value field(s) as appropriate.

5. Click Start Process to initiate the process.
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Collections Reports
The Collections Reports are used to create collections-related reports, including:

• Performance Rating Summary Report

• Work Queue Summary Report

• Collection Exemption Summary Report

• Collection Activity Summary Report

• Process Status Report

Collections Reports Summary
Working with collections reports involves the following steps:

• Select the report you wish to run from the Run Reports screen,

• Enter the appropriate parameters for the report,

• View the report results in the View Reports screen.

Performance Rating Summary Report
The Performance Rating Summary report provides a summary of the overall credit worthiness of 
the customer base based on the customer’s collection process and payment history.

How to run the Performance Rating Summary report:

1. Select Financials-›Run Reports.

2. Select Performance Score Rate from the Run Reports screen.

The Enter Report Parameters screen opens.

3. Enter the Report Start Time for the report. To enter a date, enter the date manually or click 
the arrow and select the date using the calendar control. To enter the time, type in the time 
manually.

4. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

5. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports on page 2-11 for more information).

The Report Generate screen opens.

6. When the contract generation is complete, the contract window opens in a report viewer.
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Work Queue Summary Report
The Work Queue Summary report provides a summary of the total number of items in the 
Collections work queue.

How to run the Work Queue Summary report:

1. Select Financials-›Run Reports.

2. Select Work Queue Summary from the Run Reports screen.

The Enter Report Parameters screen opens.

3. Enter the Report Start Time and Report Stop Time for the report. To enter a date, enter 
the date manually or click the arrow and select the date using the calendar control. To enter 
the time, type in the time manually.

4. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

5. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports on page 2-11 for more information).

The Report Generate screen opens.

6. When the contract generation is complete, the contract window opens in a report viewer.
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Collection Exemption Summary Report
The Collection Exemption Summary report lists the overall number of accounts that have 
Collection Exemptions by exemption status.

How to run the Collection Exemption Summary report:

1. Select Financials-›Run Reports.

2. Select Collection Exemption Summary from the Run Reports screen.

The Enter Report Parameters screen opens.

3. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

4. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports on page 2-11 for more information).

The Report Generate screen opens.

5. When the contract generation is complete, the contract window opens in a report viewer.

Collection Activity Summary Report
The Collection Activity Summary report provides overall totals of the collections activities 
executed between a user-specified Start and Stop time.

How to run the Collection Activity Summary report:

1. Select Financials-›Run Reports.

2. Select Collection Activity Summary from the Run Reports screen.

The Enter Report Parameters screen opens.

3. Enter the Report Start Time and Report Stop Time for the report. To enter a date, enter 
the date manually or click the arrow and select the date using the calendar control. To enter 
the time, type in the time manually.

4. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

5. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports on page 2-11 for more information).

The Report Generate screen opens.

6. When the contract generation is complete, the contract window opens in a report viewer.

Process Status Report
The Process Status report lists collections processes based on Operating Company, Jurisdiction, 
Process Name, Account ID, and Process State.

How to run the Process Status report:

1. Select Financials-›Run Reports.

2. Select Process Status Report from the Run Reports screen.

The Enter Report Parameters screen opens.

3. Enter the Report Start Time and Report Stop Time for the report. To enter a date, enter 
the date manually or click the arrow and select the date using the calendar control. To enter 
the time, type in the time manually.

4. Enter the OPCO (Operating Company) Code for the report (optional).
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5. Enter the JURIS (Jurisdiction) Code for the report (optional).

6. Enter the Process Name for the report (optional).

7. Enter the Account ID for the report (optional).

8. Select the Process Type for the report from the drop-down list (optional).

9. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If 
you leave this checkbox checked, the report results will be available to all users.

10. Click Run to run the report. Click Schedule Report to schedule the report using the 
Schedule Process screen (see Scheduling Reports on page 2-11 for more information).

The Report Generate screen opens.

11. When the contract generation is complete, the contract window opens in a report viewer.
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Chapter 20
Viewing Oracle Utilities Receivables Component

Reports

This chapter describes how users can view Oracle Utilities Receivables Component reports, 
including:

• Oracle Utilities Receivables Component Reports Overview

• Payment Posting Report

• Issue Refund Report

• Account Balance Report

• AR Aging Report

• G/L Activity Report

• System Balance Report

• Market Participant Aging Report

Oracle Utilities Receivables Component reports are generated using the LSReports.EXE 
command line program (described in Chapter 10: Reports in the Oracle Utilities Billing Component 
Installation and Configuration Guide, Volume 2). Once a report has been generated, it can be viewed via 
the View Reports screen.
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Oracle Utilities Receivables Component Reports Overview
Descriptions of each of the reports available through the Oracle Utilities Receivables Component 
are provided below. For more information, see Chapter Eight: Reports in the Oracle Utilities 
Billing Component Installation and Configuration Guide, Volume 2.

Payment Posting Report
The Payment Posting report tracks the number of payments processed each night. This report is 
broken down by payment file processed, and it is assumed that each payment source will be 
processed in a separate file. See Payment Posting Report on page 10-4 in the Oracle Utilities 
Billing Component Installation and Configuration Guide, Volume 2 for more information about this 
report.

Issue Refund Report
The Issue Refund report details the refunds issued by the system by refund type. This report lists 
the number of refunds and the total amount of refunds processed by the Post Refund function. 
See Issue Refund Report on page 10-6 in the Oracle Utilities Billing Component Installation and 
Configuration Guide, Volume 2 for more information about this report.

Account Balance Report
Each night, a particular segment of the bill accounts are checked to ensure they are “in balance” 
(the term “balance” refers to the charges, credits, and payments being captured on the database). 
The Account Balance report details the number of accounts balanced and the number of accounts 
that were “out-of-balance”, along with necessary details. See Account Balance Report on page 
10-8 in the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2 for more 
information about this report.

AR Aging Report
The AR Aging report details aging for accounts receivables in the database. Accounts receivables 
represents those sales that have not yet been collected, and aging refers to the classification of 
receivable items into different groups based on the length of time that an item has been 
outstanding. The AR Aging report format breaks down AR items by Market, then by Rate. See AR 
Aging Report on page 10-10 in the Oracle Utilities Billing Component Installation and Configuration 
Guide, Volume 2 for more information about this report.

G/L Activity Report
At scheduled intervals, the records in the Journal Transaction Table are balanced against records in 
the Transaction Table and the Credit Application Table. The G/L Activity report details this 
process. This report displays the total number of financial records balanced, and sum of the 
amounts for these transactions. It also displays the total number of journal transactions that 
resulted, and the sum of the amounts for these transactions. See G/L Activity Report on page 
10-12 in the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2 for more 
information about this report.

System Balance Report
As transactions are posted to Oracle Utilities Receivables Component, the AR Engine creates 
records in both the Transaction and Journal Transaction tables. At the end of each day, the 
subledger rollup is performed, updating each entry in the Journal Transaction table with a rolled 
up date, and the Subledger Account table is updated accordingly. The total of the balances on the 
Journal Transaction records are added to the BALANCE column for the given Subledger 
Account/Cost Center/Revenue Month. If the record does not already exist, it is created. The 
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Running Balance is set equal to the previous Revenue Month's Running Balance plus the current 
month's Balance.

The System Balance report compares the Subledger Balances for those Journal Accounts that have 
a Type of either A/R or DEFERRED A/R with the net of the sum of the debit and credit 
balances posted to the Transaction table. There is a separate line on the report for each Type/
Journal Account ID/Cost Center combination. The Subledger Balance, Transaction Balance and 
any difference between the two is reported.

See System Balance Report on page 10-14 in the Oracle Utilities Billing Component Installation and 
Configuration Guide, Volume 2 for more information about this report.

Market Participant Aging Report
The Market Participant Aging report details aging for accounts receivables in the database based 
on individual accounts. Accounts receivables represents those sales that have not yet been 
collected, and aging refers to the classification of receivable items into different groups based on 
the length of time that each item has been outstanding. 

See Market Participant Aging Report on page 10-16 in the Oracle Utilities Billing Component 
Installation and Configuration Guide, Volume 2 for more information about this report.
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Part Four
Workflow Management

Part Four describes the workflow management functions of Oracle Utilities Billing Component, 
and contains the following chapters:

• Chapter 21: Oracle Utilities Billing Component - Workflow Management Overview

• Chapter 22: Working with Workflow Management

• Chapter 23: Workflow Activity Implementations

• Chapter 24: Workflow Processes and Process Versions

• Chapter 25: Workflow Process Activities

• Chapter 26: Workflow Management Work Queues

• Chapter 27: Workflow Management Process Controls





Chapter 21
Oracle Utilities Billing Component - Workflow

Management Overview

This chapter provides an overview of the workflow management functionality of Oracle Utilities 
Billing Component (referred to hereafter as Workflow Management), including:

• What Workflow Management Does

• How Workflow Management Is Used
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What Workflow Management Does
Workflow Management is used to create, run, and maintain processes (a process is defined as a 
series of activities performed in a predetermined sequence relating to a specific operation). 
Processes are represented in Workflow Management through process models that associate 
specific activities to a specific process. Workflow management provides tools used both in the 
design and creation of processes and activities, as well as in the running maintenance of processes 
and activities. Chapter 22: Working with Workflow Management provides more detailed 
information about how Workflow Management is used.

The Workflow Management Database
The individual records that comprise the processes and activities used with Workflow 
Management are stored in a set of database tables in the Oracle Utilities Data Repository. These 
tables store records detailing processes, activities, and the relationships between process and 
activities.

The Workflow Management Messaging System
Workflow management also includes a messaging system, designed to support external interfacing, 
control activities, work queues, and internal messages. The messaging system is described in 
Appendix C: Messaging in the Oracle Utilities Billing Component Installation and Configuration Guide, 
Volume 2.
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How Workflow Management Is Used
Workflow management allows users to design, create, run, and maintain processes and related 
activities.

Several Workflow Management functions operate “behind the scenes;” functions are triggered 
automatically when certain operations are performed by external systems interfaced with 
Workflow Management through one of the workflow interfaces. Refer to Chapter 13: The 
Workflow Engine in the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 
2 for more information about how workflow management engine performs certain functions.

In addition, a number of Workflow Management functions can also be performed through the 
Oracle Utilities Billing Component user interface, a web-enabled interface that allows users to 
create processes and activities and process work queue items and process controls.
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Chapter 22
Working with Workflow Management

This chapter provides an overview of how you work with Oracle Utilities Billing Component - 
Workflow Management, including:

• Designing Processes with Workflow Management

• Running Processes with Workflow Management
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Designing Processes with Workflow Management
Designing processes with Workflow Management involves the following steps:

• Step One: Define the Process

• Step Two: Define the specific activities that take place within the process

• Step Three: Define the possible paths between activities within the process

• Step Four: Create Message and Event Types as required

• Step Five: Create Activity Implementations

• Step Six: Create Process and Process Version

• Step Seven: Create Process Activities in Workflow Management

Steps 1, 2, and 3 identify and define business activities and events. Steps 4 through 7 translate 
those activities and events into Workflow Management. Each step is described in detail below. 
Definitions and descriptions of terms and concepts used by the Workflow Management are 
highlighted in bold-faced type.

Step One: Define the Process
The first step is to define the process to be run. A process is a series of activities performed in a 
defined sequence relating to a specific operation. A process model is a representation of a 
process in Workflow Management.

This can be an existing business process, such as performing collections in an accounts receivable 
system, or a sales process.

Step Two: Define the specific activities that take place within the process
The next step is to define the specific activities within the process. An activity is a single task or 
step involved in a process. Each process can have any number of activities, one for each of the 
possible tasks associated with a process. Each activity can be implemented in one of several ways. 
An activity can invoke a function of a COM object, wait for an external event, post a message, 
start another process, execute a Oracle Utilities Rules Language rate form, resume a process, 
suspend a process, terminate a process, or end a process.

Step Three: Define the possible paths between activities within the process
The next step is to define the possible paths between activities within the process. A path 
establishes a connection between individual activities within a process. Each path has a source 
activity, a transition condition, and a target activity. The source activity is the specific activity 
from which a given path originates. The transition condition determines which path the process 
follows upon exiting a given activity. The target activity is the specific activity to which a given 
path leads.

Step Four: Create Message and Event Types as required
The next step is to create message and event types required by the activities in the process. You 
must create a record in the Message Type table for each message type created, and a record in the 
Event Type table for each event type created. 
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Step Five: Create Activity Implementations
The next step is to create activity implementations that can be used to perform the specific 
activities defined in Step 2. An activity implementation is how a specific type of activity is 
implemented. There are ten types of Activity Implementations: COMOBJECT, EVENT, 
MESSAGE, PROCESS, RATEFORM. RESUME, SUSPEND, TERMINATE, WAIT, and END. 
You must create an Activity Implementation record for each activity implementation. More 
information about creating activity implementations can be found in Chapter 23: Workflow 
Activity Implementations.

Step Six: Create Process and Process Version
The next step is to create the process within Workflow Management. A process is a series of 
activities performed in a defined sequence relating to a specific operation. A process model is a 
representation of a process in Workflow Management. A process version is a specific version of 
a process. This includes both the process itself, and a specific version of the process. You must 
create Process and Process Version records for each process and process version (respectively). 
More information about creating processes and process versions can be found in Chapter 24: 
Workflow Processes and Process Versions.

Step Seven: Create Process Activities in Workflow Management
The last step is to create process activities for the process. A process activity is a specific activity 
associated with a process. Creating process activities involves creating Process activity records for 
each process activity that link specific activities and activity implementations, and activities and 
process versions. This determines which specific activities (each of a specified activity 
implementation type) are performed within a specific process version. More information about 
creating process activities can be found in Chapter 25: Workflow Process Activities.
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Running Processes with Workflow Management
This section outlines how processes are run using Workflow Management, including:

• Workflow Management Run Time Components

• How Workflow Management Runs Processes

Workflow Management Run Time Components
Workflow Management uses run time components in the running of processes. These 
components work together to provide the services necessary to execute and maintain process 
instances.

Workflow Engine
The Workflow Engine is the core component in Workflow Management. It creates and navigates 
process and activity instances, evaluates activity start, exit, and transition conditions, transfers data 
between process and activity contexts, handles process events, and archives process and activity 
instances. More information about the Workflow Engine can be found in Chapter 13: The 
Workflow Engine in the Workflow Management Installation and Configuration Guide.

Scheduler
The Scheduler provides message scheduling services based on business days and calendars. More 
information about the Scheduler can be found in Chapter 14: The Workflow Scheduler in the 
Workflow Management Installation and Configuration Guide.

Rules Language Engine
The Rules Language Execution Engine executes Rules Language activities. More information 
about the Rules Language Execution Engine can be found in Chapter 15: The Rules Language 
Engine in the Workflow Management Installation and Configuration Guide.

Work Queue
The Workflow Management Work Queue provides interfaces for processing work queue message 
activities. More information about the Workflow Management Work Queue can be found in 
Chapter 26: Workflow Management Work Queues.

Process Controls
The Workflow Management Process Controls provides interfaces to view and manipulate process 
and activity instances. More information about the Workflow Management Process Controls can 
be found in Chapter 27: Workflow Management Process Controls.
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How Workflow Management Runs Processes
Workflow Management runs processes by evaluating specific data associated with the process and 
the activities belonging to that processes. Workflow Management uses the context of the process, 
the Start/Exit Conditions of each activity, the paths between activities, and the context of each 
activity within the process to navigate from the start to end of each process.

Most activities within a process require some user-intervention or action. This is often the action 
represented by the activity (such as placing a phone call to a customer, or sending appropriate 
information to a prospective client). Once the user action has been completed, the user indicates 
that the activity has been finished via an interface or application (such as a CRM application) 
which triggers the continuation of the process in Workflow Management.

Processes Step-by-Step
The steps below outline the general method used by Workflow Management.

1. A user initiates the process using the Start Process function of the Workflow Engine via an 
interface or using the PROCESS START Rules Language statement.

2. A message is posted to the Workflow Engine Queue. The Workflow Engine picks up the 
message and creates a process instance based on the specified process version. A process 
instance is a current started instance of a process version.  The Workflow Engine then sets 
the process instance’s State to RUNNING, and initializes the process context as specified. If 
the process is specified to start at a later time, the process instance’s state is set to 
SUSPENDED, and a scheduled message is posted.

3. The Workflow Engine creates an activity instance for each activity in the process, and sets the 
Activity State of each to INACTIVE. An activity instance is a current started instance of a 
given process activity. The Workflow Engine evaluates the Input Path of each inactive activity 
instance to determine which to determine which should be started and evaluates the start 
condition of each. If the start condition evaluates to TRUE, the Workflow Engine sets the 
activity instance’s State to RUNNING. If the start condition evaluates to FALSE, the 
Workflow Engine sets the activity instance’s State to SKIPPED.

4. The next step depends on the Activity Implementation of the activity instance.

• If the activity implementation is COMOBJECT, the Workflow Engine invokes the 
specified method of the COM Object.

• If the activity implementation is EVENT, the Workflow Engine registers the activity 
event, and waits for the specified event to occur. An activity event is a specific instance 
of an event related to an activity instance.

• If the activity implementation is MESSAGE, a message of the appropriate Message Type 
is placed into the appropriate message queue (based on the Message Type). Depending 
the specific message type, the message is picked up by either an external system or the 
Workflow Work Queue and the appropriate action indicated by the message is 
performed.

• If the activity implementation is PROCESS, a message is posted to the Workflow Engine 
Queue. The Workflow Engine picks up the message and creates a process instance for 
the process and sets the process instance’s State to RUNNING.

• If the activity implementation is RATEFORM, the Workflow Engine posts a message in 
the Rules Language Engine Queue. The Rules Language Execution Engine picks up the 
message and runs the rate form specified by the activity.

• If the activity implementation is RESUME, a message is posted to the Workflow Engine 
Queue. The Workflow Engine picks up the message and resumes the process and sets 
the process instance’s State to RUNNING.
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• If the activity implementation is SUSPEND, a message is posted to the Workflow 
Engine Queue. The Workflow Engine picks up the message and suspends the process 
and sets the process instance’s State to SUSPENDED.

• If the activity implementation is TERMINATE, a message is posted to the Workflow 
Engine Queue. The Workflow Engine picks up the message and terminates the process 
and sets the process instance’s State to TERMINATED.

• If the activity implementation is WAIT, a message is posted to the Workflow Engine 
Queue with a scheduled expiration time. The Workflow Engine picks up the message, 
and when the scheduled time expires, the process continues. The WAIT activity does not 
change the process instance’s State.

• If the activity implementation is END, a message is posted to the Workflow Engine 
Queue. The Workflow Engine picks up the message and ends the process and sets the 
process instance’s State to COMPLETED.

If there is an error when running the activity, the Workflow Engine triggers the Activity 
InError function and sets the activity instance’s state to INERROR.

If the activity instance’s Wait For Flag if set to TRUE and the expiration time elapses, the 
Workflow Engine triggers the Activity Expired function and sets the activity instance’s state 
to EXPIRED. The Workflow Engine then evaluates the Exit/Error parameter of the 
expiration time and triggers the Activity Finished or Activity InError function as appropriate, 
changing the activity instance’s state to either FINISHED or INERROR.

5. After the activity has been successfully resolved, the Activity Finished function is sets the 
activity instance’s State to FINISHED, and updates the activity instance’s context as specified. 
The Workflow Engine then evaluates the activity instance’s Exit Condition. If the exit 
condition evaluates to TRUE, the Workflow Engine sets the activity instance’s State to 
COMPLETED, and proceeds to the next activity in the process.
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Chapter 23
Workflow Activity Implementations

This chapter explains how to create activity implementations using Workflow Management, 
including:

• Understanding Activity Implementations

• Working with Activity Implementations

• Activity Implementation API
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Understanding Activity Implementations
An activity implementation is how a specific activity is performed in Workflow Management. This 
section includes:

• Activity Implementation Data

• Creating Activity Implementations

Activity Implementation Data
Activity Implementations are defined by the following data.

Name
The name of the activity implementation. The name can be no longer that 64 characters.

Description
An optional description of the activity implementation. The description can be no longer that 254 
characters.

Type
There are ten Activity Implementation types:

• COMOBJECT: The activity invokes a function of a COM interface. COM objects and the 
functions available from each must be configured in the COM Object Type and COM Object 
tables in the Oracle Utilities Data Repository See Chapter 12: Setting Up Workflow 
Management Database Tables in the Workflow Management Installation and Configuration Guide 
for more information about setting up these tables.

• EVENT: The activity registers a specific type of event.

• MESSAGE: The activity posts a specific type of message to the appropriate message queue.

• PROCESS: The activity starts another specified process

• RATEFORM: The activity runs a specified rate form.

• RESUME: The activity resumes a suspended process.

• SUSPEND: The activity suspends a process.

• TERMINATE: The activity terminates a process.

• WAIT: The activity posts a message to a message queue with a scheduled expiration time. 
When the scheduled time expires, the process continues.

• END: The activity ends a process.

Type Code
Most activity implementations requires a type code that specifies the particular COM object, 
event, message, process, or rate form that is associated with the activity implementation record. 
The Resume, Suspend, Terminate, Wait, and End activity implementations do not require type 
codes. The format for each of the different type codes is described below.

COM Object
The type code for COM Object activity implementations is the COM Object function from the 
COM Object table.

Event
The type code for Event activity implementations is the Event Code from the Event Type table.
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Message
The type code for Message activity implementations is the Message Code from the Message Type 
table.

Process
The type code for Process activity implementations is the Process Name from the Process table. If 
the process is associated with a specific Operating Company and Jurisdiction, the appropriate 
Operating Company Jurisdiction codes should be appended to the Process name, separated by 
commas.

To create a Process activity implementation that started a Process named WORKQUEUE_MSG 
(Work Queue Message):

• If the Process is associated with a specific Operating Company and Jurisdiction (GECO and 
CA, respectively), the Process name should appear in the activity implementation record as: 
WORKQUEUE_MSG,GECO,CA. 

• If the Process is not associated with a specific Operating Company and Jurisdiction, the 
Process name should appear in the activity implementation record as: 
WORKQUEUE_MSG. 

Rate Form
The type code for Rate Form activity implementations is the Rate Form code from the Rate Form 
table. If the rate form is associated with a specific Operating Company and Jurisdiction, the 
appropriate Operating Company and Jurisdiction codes should precede the Rate Form code, 
separated by colons.

To create a Rate Form activity implementation that ran a Rate Form named DEPAPP (Post 
Deposit Application):

• If the Rate Form is associated with a specific Operating Company and Jurisdiction (AGL and 
GA, respectively), the Rate Form name should appear in the activity implementation record 
as: AGL:GA:DEPAPP. 

• If the Rate Form is not associated with a specific Operating Company and Jurisdiction, the 
Process name should appear in the activity implementation record as: DEPAPP.

Product Code
A code that indicates the product associated with the activity implementation, from the 
LODESTAR Product table.

Context Schema
An Activity Implementation’s Context Schema is an optional XML structure that defines the data 
context in which the activity is executed. The context itself contains all the actual data needed to 
perform the activity. 

There are two primary uses of activity implementation context schemas. Context schemas define:

• Data required by activities (Required Data)

• Data needed to evaluate an activity’s Exit Condition (Evaluation Data)

Required Data
Required data is data needed to perform the activity, based on the activity implementation. For 
example, if an activity involves contacting a customer, required data for that activity includes some 
means of identifying the customer, such as an Account ID or unique ID of the Account in the 
Data Repository (UIDACCOUNT).

Where possible, we recommend that context schemas define the minimal amount of data 
needed for the activity to be performed, and if possible, data that is not likely to change over time. 
This practice reduces the amount of data moving through Workflow Management and reduces the 
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need to alter data used by a process once it’s running. For example, rather than include numerous 
types of contact information for an account or customer such as the account name, ID, telephone 
number, address, etc., it’s preferable to include only the Account ID, since the Account ID can be 
used to locate other account-related data, and it’s unlikely that an account’s ID will change.

Evaluation Data
Evaluation data is specific data used to evaluate the activity’s Exit Condition. An activity’s exit 
condition indicates the conditions under which the activity is completed (i.e. the activity’s State is 
set to “Completed”).

Evaluation data is needed only if there are specific conditions or data that determine the 
conditions under which the activity is completed. This can occur with activities that have more 
than one possible outcome, such as determining the current status of an account or determining if 
an account is eligible for service shut-off. In this case, the activity’s exit condition is evaluated 
against data in the activity context (as defined by the activity implementation context schema) to 
determine if the exit condition has been met. For instance, if an activity’s exit condition requires 
that the activity is completed only if the customer is eligible for service shut-off, the context 
schema must define data that can be used to determine if the customer is eligible or not.

Many activities will not require evaluation data. The activity’s exit condition might simply be 
TRUE, indicating that once the activity has been performed, that activity is completed, and the 
process automatically moves on to the next activity.

More information about Exit Conditions can be found in Chapter 25: Workflow Process 
Activities.

Context Schema Format
Context schemas are implemented as XML schemas using Microsoft’s XML-Data Reduced 
(XDR) schema format. These schemas define how the XML data is used by the activities.

Note: Refer to the Microsoft Developer Network website
 (http://msdn.microsoft.com) for information about the format of XDR schemas. 

Creating Activity Implementations
Creating activity implementations using Workflow Management involves four steps.

Step One: Determine the activity implementations to be created.
First, determine the activity implementations that need to be created. This should be based on the 
activities that take place within the specific processes you plan to model using Workflow 
Management. For example, if one or more of your processes involves contacting a customer by 
telephone, you should create an activity implementation for this type of activity.

You should create an activity implementation for each specific type of activity that takes place in a 
process or processes. Activity implementations should be made to be as generic and reusable as 
possible. If a process involves making three different phone calls to a customer, rather than create 
three ‘Phone Call’ activity implementations (one for each phone call), create a single ‘Phone Call’ 
activity implementation that can be used for all three. The type of phone call can be specified in 
the activity implementation context schema.

At this point you must determine the activity implementation type for each activity 
implementation. Each must be either a Message, an Event, a Process, or a Rate Form. Each type is 
used to perform a different operation.

• COMOBJECT: COM Object activities trigger functions within COM interfaces. COM 
Objects are used when a process must trigger a specific function available through a COM 
interface. In a financial collections process, a COM Object might be the creation of a letter to 
a customer concerning an outstanding past due balance.
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• EVENT: Event activities register events of specified types. Events are used when a process 
must wait for an external event before proceeding. In a financial collections process, an event 
might be the receipt of payment from a customer whose account is currently past due.

• MESSAGE: Message activities post specific types of messages to appropriate message 
queue(s). Messages can be used to send data to a Customer Relationship Management (CRM) 
system or other external system to alert users to perform specific tasks related to the activity 
and process being performed. Messages can also be used to post items in a work queue for 
later processing. Most activity implementations will be messages.

• PROCESS: Process activities start other processes. Process activity implementations are used 
most often when activities within a process initiate other related processes. Determining if a 
customer is eligible for service shut-off might be a single activity in a process, but the actual 
shutting-off of the customer’s service might be a completely separate process. 

• RATEFORM: Rate form activities run specified rate forms. Rate form activity 
implementations are used when a process requires a specific Rules Language rate form be 
run.

• RESUME: Resume activities resume suspended processes.

• SUSPEND: Suspend activities suspend processes. 

• TERMINATE: Terminate activities terminate processes.

• WAIT: Wait activities cause a process to wait for pre-defined amount of time, after which 
time the process resumes.

• END: End activities end processes.

Step Two: Assign the specific type of COM Object, Event, Message, Process, or Rate Form 
to each activity implementation.

The next step is to assign the specific COM Object, Event Type, Message Type, Event Type, 
Process or Rate Form to each activity implementation. The Resume, Suspend, Terminate, Wait, 
and End activity implementations do not require type codes. COM Object, Event, Message, 
Process, and Rate Form activity implementations must have a specific type code:

• COM Object: COM Object function from the COM Object table.

• EVENT: Event Code from the Event Type table.

• MESSAGE: Message Code from the Message Type table.

• PROCESS: Name (and unique ID) of the Process to be run from the Process table.

• RATEFORM: Rate Form code (and unique ID) of the rate form to be run from the Rate 
Form table.

Step Three: Determine the data to be defined in the context schema for each activity 
implementation.

Next, determine the data required in the context schema of each activity implementation. This can 
include virtually any information, but must include any Required Data and Evaluation Data 
needed by the activity. See Context Schema on page 23-3 for more information.

Step Four: Create the actual activity implementation record.
Finally, create the actual activity implementation records in the Oracle Utilities Data Repository. 
These include:

• Name: Name of the activity implementation

• Description: An optional description of the activity implementation

• Type: COM Object, Event, Message, Process, Rate Form, Resume, Suspend, Terminate, 
Wait, or End
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• Type Code: A code that designates the specific COM Object, Event, Message, Process, or 
Rate Form associated with the activity implementation.

• Product Code: A code that designates the specific Oracle Utilities product associated with 
the activity implementation.

• Context Schema: An optional XML schema that defines the data required by the activity 
implementation.

Example: Phone Call
If a process includes a number of activities that involve placing a phone call to the customer, these 
could all use a single activity implementation, a message. The following example steps through 
creating this activity implementation.

1. Enter a name for the activity implementation.

Name: Phone Call to Customer

2. Enter an optional description for the activity implementation.

Description: Place a phone call to customer.

3. Select the activity implementation type

Type: MESSAGE

4. Select the appropriate type code for the selected activity implementation type. In this case, the 
appropriate Message Code from the Message Type table.

Message Type: PHONE_CALL

5. Create the context schema used by the activity implementation. The context schema needs to 
define the Account ID (which in turn will be used to obtain other contact information such 
as the customer’s telephone number) and the Type of phone call (i.e. notification of past due 
amount, arrange payment, shut-off warning, etc.). Keep the data as minimal as possible.

Context Schema:

<?xml version="1.0" encoding="UTF-8"?>
<Schema name="phone_call_act_impl" xmlns="urn:schemas-microsoft-com:xml-data" 
xmlns:dt="urn:schemas-microsoft-com:datatypes">
<ElementType name="ACCOUNTID" model="closed" content="textOnly" dt:type="i1"/

>
<ElementType name="TYPE" model="closed" content="textOnly" dt:type="string"/>

</Schema>
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Working with Activity Implementations
You work with activity implementations via the Workflow Management user interface, accessed 
from the Oracle Utilities Energy Information Platform framework. 

How to select and view and/or edit Activity Implementations: 

1. Select Financials-›Work Flow-›Activity Types.

The Activity Implementation screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the Activity Name or Type.

You can use the percent sign (“%”) as a wildcard character when entering values in the 
Activity Name field. The Activity Name field automatically appends a wildcard character to 
the end of any search criteria you enter. For example, if you want to search for all activity 
implementations that begin with the letter G, you could simply enter “G” in the Activity 
Name field.

If you want to search for all users that contain the letter G, you could enter “%G” in the 
Activity Name field, and the search would retrieve all activity implementations that contain 
the letter G.

Note that Activity Names are case-sensitive. For example, there is a difference between the 
“Calc_Payment” and “calc_payment” activity names.

3. Click Search.

4. A list of all activity implementation records that match the search criteria appear on the 
Activity Implementations screen.

5. Click the Activity Name link for the record you wish to view from the list. The selected 
record appears in the Activity Implementations screen.

6. Optional. Change the activity implementation type on the Type drop-down list.

7. Optional. Change the Type Code for the activity implementation from the drop-down list, 
based on the Activity Implementation Type.

8. Optional. Change the product code from the Product Code drop-down list.

9. Optional. Enter or edit an optional Description for the activity implementation.

10. Optional. Enter or edit an optional Context Schema for the activity implementation.

11. Click Save to save the changes. Click Delete to delete the activity implementation. Click List 
Activities to list all the activity implementation records in the system.

How to create a new Activity Implementation: 

1. Select Financials-›Work Flow-›Activity Types.

The Activity Implementation screen opens.

2. Click Add Activity.

The Activity Implementation screen displays the Name and Type fields.

3. Enter the Name of the activity implementation.

4. Select the activity implementation type from the Type drop-down list.

5. Click Continue.

An activity implementation record appears in the Activity Implementations screen, with the 
entered Name and Type.
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6. Select a Type Code for the activity implementation from the drop-down list, based on the 
Activity Implementation Type.

7. Select a product code from the Product Code drop-down list.

8. Enter an optional Description for the activity implementation.

9. Enter an optional Context Schema for the activity implementation.

10. Click Save to save the record. Click Delete to delete the activity implementation. Click List 
Activities to list all the activity implementation records in the system.
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Activity Implementation API
Workflow Management also provides access to a number of functions for working with activity 
implementations from external systems such as a Customer Relationship Management (CRM) 
application. These functions require the following data:

• An XML file that contains data source connection data (user id, password, datasource, and 
qualifier), and

• An XML file that specifies the activity implementation data itself, as described under Activity 
Implementation Data on page 23-2.

The Workflow Management user interface automatically supplies this data. When used from an 
external system, the data must be supplied.

Insert  Activity Implementation
Creates a new activity implementation record and inserts it into the Activity Implementation table 
in the Oracle Utilities Data Repository.

Update Activity Implementation
Updates an existing activity implementation record. 

Delete Activity Implementation
Delete an existing activity implementation record. 

List Activity Implementations
Provides a list of activity implementation records from the Data Repository. This function is most 
often employed through a user-interface (such as the Workflow Management user interface).

Select Activity Implementation
Selects a specific activity implementation record in the Data Repository. This function is most 
often employed through a user-interface (such as the Workflow Management user interface), and 
in conjunction with the Update and Delete functions.

See Chapter 22: Workflow Management Activity Implementations Interface in the Oracle 
Utilities Billing Component Installation and Configuration Guide, Volume 2 for more information about 
using the Activity Implementation API.
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Chapter 24
Workflow Processes and Process Versions

This chapter describes how to work with processes and process versions using Workflow 
Management, including:

• Understanding Processes and Process Versions

• Working with Processes

• Working with Process Versions

• Process Versions API
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Understanding Processes and Process Versions
A process is a series of activities performed in a defined sequence relating to a specific operation. 
A process version is a specific version of a process. A process instance is a current started instance 
of a process version. Whenever a process is initiated, a new process instance of the appropriate 
process version is created. This section includes:

• Process Data

• Process Version Data

• Creating Processes and Process Versions

Process Data
Processes are defined by the following data.

Name
The name of the process. The name can be no longer that 64 characters, and must be unique 
within the related Operating Company and Jurisdiction.

Operating Company
Operating company associated with the process (optional).

Jurisdiction
Jurisdiction associated with the process (optional).

Description
Description of the process. The description can be no longer that 254 characters (optional).

Manual Submission Flag
A flag that indicates if the process can be initiated manually.

Process Version Data
Process versions are defined by the following data.

Process
The process on which the process version is based. This is taken from the Process table.

Major/Minor Version
Process versions are defined by major and minor version numbers. The major version is the 
number before the decimal point. The minor version is the number after the decimal point. For 
example, process version 1.4 would have a major version number of 1, and a minor version 
number of 4.

Important Note: Do not change the major or minor version numbers once a process version has 
been used by Workflow Management (i.e. a process instance based on that version number has 
been run or is currently running). Create a new version of the process (with appropriate major/
minor version numbers) if changes are required.

Note
An optional note about the process version.
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Validated Flag
A flag that indicates whether or not the process version has been validated by Workflow 
Management. Process versions must be validated (VALIDATED=“Y”) before they can be run in 
Workflow Management.

Context Schema
A Context Schema is an optional XML structure that defines the data used by a process. The 
context itself contains all the actual data needed to perform the process. 

Process version context schemas define:

• Data required by processes (Required Data)

• Data needed to evaluate an activity’s Transition Condition (Evaluation Data)

Required Data
Required data is needed to perform the process. For example, if a process involves contacting a 
customer, required data for that process includes some means of identifying the customer, such as 
an Account ID or unique ID of the Account in the Data Repository (UIDACCOUNT).

Where possible, we recommend that context schemas define the minimal amount of data 
needed for the process to run, and if possible, data that is not likely to change. This practice 
reduces the amount of data moving through Workflow Management and reduces the need to alter 
data used by a process once it’s running. For example, rather than include numerous types of 
contact information for an account or customer such as the account name, ID, telephone number, 
address, etc., include only the Account ID, since the Account ID can be used to locate other 
account-related data, and it’s unlikely that an account’s ID will change.

Evaluation Data
Evaluation data is used to evaluate the Transition Conditions of the input paths of activities within 
the process. Transition conditions determine which path a process follows after exiting an activity.

Evaluation data is needed if there are specific conditions or data that determine whether the 
process follows one path or another. This will occur in processes that include activities with more 
than one possible outcome. The transition condition is evaluated against data defined by the 
process version context schema to determine if the transition condition has been met.

Many processes will not require evaluation data. A transition condition of TRUE indicates that 
once the activity has been performed and completed, the process automatically moves to the next 
activity. A linear process that moves from one activity to the next without branching doesn’t 
require transition conditions because there is only one possible path between activities.

More information about Exit Conditions can be found in Chapter 25: Workflow Process 
Activities.

Context Schema Format
Context schemas are implemented as XML schemas using Microsoft’s XML-Data Reduced 
(XDR) schema format. These schemas define how the XML data is used.

Note: Refer to the Microsoft Developer Network website
 (http://msdn.microsoft.com) for information about the format of XDR 
schemas. 
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Creating Processes and Process Versions
Creating processes and process versions involves four steps.

Step One: Create the process record.
First, create a process record in the Oracle Utilities Data Repository. This includes the following:

• Name: Name of the process.

• Operating Company: Optional operating company associated with the process.

• Jurisdiction: Optional jurisdiction associated with the process.

• Description: Optional description of the process.

Step Two: Determine the Version number (major and minor).
Determine the version number (major version and minor version). The first process version for 
any process should be 1.0. The major version should be changed whenever significant changes are 
made, such as the addition or removal or one or more activities or substantial changes to the 
process version context schema. The minor version should be changed whenever minor changes 
are made, such as changes to one or more activities and activity implementations, or minor 
changes to the process version context schema.

Important Note: Do not change the major or minor version numbers once a 
process version has been used by Workflow Management (i.e. a process 
instance based on that version number has been run or is currently running). 
Create a new version of the process (with appropriate major/minor version 
numbers) if changes are required.

Step Three: Determine the data to be defined in the context schema.
Determine the data that needs to be defined in the context schema of the process version. This 
can include virtually any information, but must include any Required Data and Evaluation Data 
needed by the process (see Context Schema on page 24-3 for more information).

Step Four: Create the process version record.
Create the actual process version record in the Oracle Utilities Data Repository. This includes the 
following:

• Process: The process upon which the process version is based, from the Process table.

• Major Version: The major version number of the process version.

• Minor Version: The minor version number of the process version.

• Note: An optional note about the process version.

• Validated Flag: A flag that indicates whether or not the process version has been validated 
by Workflow Management.

Note: The Validated flag is a display value only. It is automatically updated 
when the process version has been validated.

• Context Schema: An XML schema that defines the data required by the process.
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Example: Collections
Suppose a process includes a number of activities related to performing collections procedures for 
past due customers. The following example demonstrates how to create this process.

Process Record
1. Enter a name for the process.

Name: Collections

2. Enter an optional Operating Company and Jurisdiction for the process.

Operating Company: LSE

Jurisdiction: GA.

3. Enter an optional description for the process.

Description: Collections of past due accounts.

Process Version Record
1. Select the Process to create the process version

Process: Collections

2. Enter the version number of the process version

Major Version: 1 (new version)

Minor Version: 0 (new version)

3. Enter an optional note for the process version.

Description: Initial version of collections process.

4. Create the context schema for the process version. Use the minimum data required. The 
Account ID, used to obtain other contact information such as the customer’s telephone 
number.

Context Schema:

<?xml version="1.0" encoding="UTF-8"?>
<Schema name="collections_process" xmlns="urn:schemas-microsoft-com:xml-data" 

xmlns:dt="urn:schemas-microsoft-com:datatypes">
<ElementType name="ACCT_ID" model="closed" content="textOnly" dt:type="i1"/>

</Schema>
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Working with Processes
You work with processes using the Workflow Management user interface, accessed from the 
Oracle Utilities Energy Information Platform framework.

How to select and view Process records:

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to view from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

How to create a new Process record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Enter a name for the process in the Name field.

3. Optional. Select the operating company for the process from Operating Company drop-
down list.

4. Optional. Select the jurisdiction for the process from Jurisdiction drop-down list.

5. Optional. Select the receivable status for the process from Receivable Status drop-down list.

6. If the process can be initiated manually, check the Allow Manual Submissions checkbox.

7. Optional. Enter a description for the process in the Description field.

8. Click Create to create the process record.

9. The new process record appears on the Processes screen.

How to create a new Process Record based on an existing record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to use as the basis for the new process from the list by checking 
the radio button in the far left column. The process data for the selected record will be 
displayed.

3. Enter the name for the new process or edit the existing name in the Name field.

4. Optional. Select the operating company for the new process from Operating Company drop-
down list.

5. Optional. Select the jurisdiction for the new process from Jurisdiction drop-down list.

6. Optional. Select the receivable status for the new process from Receivable Status drop-down 
list.

7. If the new process can be initiated manually, check the Allow Manual Submissions 
checkbox.

8. Optional. Enter a description for the new process or edit the existing description in the 
Description field.

9. Click Create to create the new process record.

10. The new process record appears on the Processes screen.
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How to create a new Process (including all related process activities) based on an 
existing version of the process: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Enter the name for the new process (or edit the existing name) in the Name field.

3. Click Create from Version.

The Create from Version dialog opens.

4. Select the process you wish to use as the basis for the new record from the Process drop-
down list.

5. Select the version of the process you wish to use as the basis for the new record from the 
Version drop-down list.

6. Click OK. To close the dialog with saving your selections, click Cancel.

7. The new process record appears on the Processes screen.

Note: Creating a new process using this procedure includes all process activities 
related to the process version selected on the Create from Version dialog. See 
Chapter 25: Workflow Process Activities for more information about 
process activities.

How to edit an existing Process record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to edit from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Enter the name for the new process or edit the existing name in the Name field.

4. Optional. Select the operating company for the new process from Operating Company drop-
down list.

5. Optional. Select the jurisdiction for the new process from Jurisdiction drop-down list.

6. Optional. Select the receivable status for the new process from Receivable Status drop-down 
list.

7. If the new process can be initiated manually, check the Allow Manual Submissions 
checkbox.

8. Optional. Enter a description for the new process or edit the existing description in the 
Description field.

9. Click Update to save the changes to the record.

10. The updated process record appears on the Processes screen.

How to delete an existing Process record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to delete from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Click Delete.

4. The deleted process record no longer appears on the Processes screen.
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Working with Process Versions
You work with process versions using the Workflow Management user interface, accessed from 
the Oracle Utilities Energy Information Platform framework.

How to select and view Process Version records: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to view from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens listing all the process versions for the selected 
process.

4. Select the process version you wish to view from the list by checking the radio button in the 
far left column. The process version data for the selected record will be displayed.

How to create a new Process Version record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to create a new version for from the list by checking the radio 
button in the far left column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens.

4. Enter the major version number in the Major Version field.

5. Enter the minor version number in the Minor Version field.

6. Optional. Enter a note for the new version in the Note field.

7. Optional. Enter a context schema for the new version in the Context Schema box.

8. Click Create.

9. The new process version record appears on the Build Process Versions screen.

How to create a new Process Version record based on an existing record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to create a new version for from the list by checking the radio 
button in the far left column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens.

Select the process version you wish to base the new version on.

4. Enter the major version number in the Major Version field.

5. Enter the minor version number in the Minor Version field.

6. Click Copy.

7. The new process version record appears on the Build Process Versions screen. The minor 
version number of the process version will increment by 1.
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How to edit an existing Process Version record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to view from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens listing all the process versions for the selected 
process.

4. Select the process version you wish to view from the list by checking the radio button in the 
far left column. The process version data for the selected record will be displayed.

5. Edit the major version number in the Major Version field as appropriate.

6. Edit the minor version number in the Minor Version field as appropriate.

7. Optional. Edit the note for the new version in the Note field as appropriate.

8. Optional. Edit a context schema for the new version in the Context Schema box as 
appropriate.

9. Click Update.

10. The updated process version record appears on the Build Process Versions screen.

How to delete an existing Process Version record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to view from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens listing all the process versions for the selected 
process.

4. Select the process version you wish to delete from the list by checking the radio button in the 
far left column. The process version data for the selected record will be displayed.

5. Click Delete.

6. The deleted process version record no longer appears on the Build Process Versions 
screen.

How to validate an existing Process Version record: 

1. Select Financials-›Work Flow-›Process Versions.

The Processes screen opens listing all the process records in the system.

2. Select the process you wish to view from the list by checking the radio button in the far left 
column. The process data for the selected record will be displayed.

3. Click Versions.

The Build Process Versions screen opens listing all the process versions for the selected 
process.

4. Select the process version you wish to validate from the list by checking the radio button in 
the far left column. The process version data for the selected record will be displayed.

5. Click Validate.
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Process Versions API
Workflow Management also provides a number of functions for working with processes and 
process versions from external systems such as a Customer Relationship Management (CRM) 
application. These functions require the following data:

• An XML file that contains data source connection data (user id, password, datasource, and 
qualifier), and

• An XML file that specifies the process or process version data itself, as described under 
Process Data and Process Version Data on page 24-2.

The Workflow Management user interface automatically supplies this data. When used from an 
external system, the data must be supplied.

Insert Process
Creates a new process record and inserts it into the Process table in the Oracle Utilities Data 
Repository.

Update Process
Updates an existing process record. 

Delete Process
Deletes an existing process record. 

List Process
Provides a list of process records in the Data Repository. This function is most often employed 
through a user-interface (such as the Workflow Management user interface).

Select Process
Selects a specific process record from the Data Repository. This function is most often employed 
through a user-interface (such as the Workflow Management user interface), in conjunction with 
the Update and Delete functions.

Insert Process Version
Creates a new process version record and inserts it into the Process Version table in the Oracle 
Utilities Data Repository.

Update Process Version
Updates an existing process version record. 

Delete Process Version
Deletes an existing process version record. 

Copy Process Version
Copies an existing process version record from the database, along with all its child process 
activity records, and inserts the copies into the database.

Validate Process Version
Validates a process version record.
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List Process Versions
Provides a list of process version records from those in the Data Repository. This function is most 
often employed through a user-interface (such as the Workflow Management user interface).

Select Process Version
Selects a specific process version record from those in the Data Repository. This function is most 
often employed through a user-interface (such as the Workflow Management user interface), and 
in conjunction with the Update and Delete functions.

See Chapter 23: Workflow Management Process Versions Interface in the Oracle Utilities 
Billing Component Installation and Configuration Guide, Volume 2 for more information about using the 
Process Version API.
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Chapter 25
Workflow Process Activities

This chapter describes how to create process activities using Workflow Management, including:

• Understanding Process Activities

• Working with Process Activities

• Process Activity API
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Understanding Process Activities
Process activities are activities associated with a process. An activity instance is a current started 
instance of a process activity. Whenever an activity is initiated, a new activity instance of the 
appropriate process activity is created. This section includes:

• Process Activity Data

• Creating Process Activities

Process Activity Data
Process activities are defined by the following data.

Process Version
The process version to which the process activity belongs, from the Process Version table. This 
data includes the Process Name, Operating Company, Jurisdiction, Major Version number, and 
Minor Version number.

ID
A unique ID of the process activity within the process version.

Activity Implementation
The activity implementation associated with the process activity, from the Activity 
Implementation table. Note that this does not mean only the activity implementation type, but the 
actual activity implementation record associated with the activity.

Start Condition
The condition under which the activity is started. A process activity’s Start Condition is either 
“ALL” or “ANY”.

• ALL indicates that all Input Path Transition Conditions must evaluate to TRUE for the 
activity to start. This is the default Start Condition. “ALL” should be used if there is only one 
input path to the activity, or when multiple input paths have Transition Conditions that all 
must evaluate to TRUE.

• ANY indicates that one or more Input Path Transition Conditions must evaluate to TRUE 
for the activity to start. “ANY” should be used if there is more than possible input path. If the 
Transition Condition of any of the input paths evaluates to TRUE, the activity starts.

Exit Condition
The condition under which the activity exits and the process moves to the next activity. Exit 
conditions are either XPath expressions that are evaluated against the Evaluation Data of the 
activity implementation context (see Evaluation Data on page 23-4), or are the literal value 
TRUE (the default exit condition if a specific condition is not provided).

Exit conditions are evaluated when an activity instance’s state is set to Finished (usually through 
the Activity Finished function of the Workflow Engine, see Chapter Eight: The Workflow 
Engine). Exit conditions specify conditions that must be met for an activity instance’s state to 
change from Finished to Completed.

An exit condition of TRUE indicates that once the activity has been performed, that activity is 
completed and the process automatically moves to the next activity.
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Exit Conditions Format
Common formats for exit condition xPath formats:

<DATA_ELEMENT>[@<ATTRIBUTE><EXPRESSION><VALUE>]

or

<DATA_ELEMENT><EXPRESSION><VALUE>

Where:

• DATA_ELEMENT is a specific data element defined in the activity implementation context 
schema. If the data element is nested beneath other data elements, it is notated:

<DATA_ELEMENT1>\<DATA_ELEMENT2>... 
In this case, DATA_ELEMENT2 is nested beneath DATA_ELEMENT1.

• ATTRIBUTE is a specific attribute of the data element defined in the activity implementation 
context schema. Attributes are proceeded by the @ symbol.

• EXPRESSION is a mathematical expression. This must be one of:

• = (equals)

• > (less than)

• < (greater than)

• >= (greater than or equal to) 

• <= (less than or equal to)

• != (not equal to)

• VALUE is a string that contains the value against which the exit condition evaluates the 
corresponding value in the activity implementation context.

Note: Exit Condition XPath expressions should be written relative to the 
CONTEXT (root) element in the activity implementation context.

Example:
An activity in a typical collections process might involve contacting a customer concerning a Past 
Due balance. This activity is completed only after the customer has been contacted. The exit 
condition for this activity might be: 

CUSTOMER[@CONTACT = TRUE]

If the CONTACT attribute of the CUSTOMER data element is TRUE, the exit condition is 
TRUE, and the process would move on to the next activity. If the activity implementation context 
for this activity was:

<CONTEXT>
<CUSTOMER CONTACT=‘TRUE’/>

</CONTEXT>

the exit condition would evaluate to TRUE. If the value of the CONTACT attribute was FALSE, 
the exit condition would evaluate to FALSE, and the activity instance’s state would change from 
Finished to Running.

Refer to the Microsoft Developer Network website
 (http://msdn.microsoft.com) for additional information about XPath and valid XPath 
expressions.
Workflow Process Activities 25-3



Understanding Process Activities
Wait For Flag
A flag that indicates an activity is waiting for a defined duration or condition. The default value for 
the Wait For Flag is TRUE. There are two values associated with the Wait For flag:

• Expiration Time is the amount of time the process waits before expiring, at which time the 
activity instance’s state will be set to Expired. The Expiration Time can be either an absolute 
date, or a duration relative to the date the activity instance was started. Relative expiration 
times can be configured to use business days (defined in the Business Calendar and Business 
Day tables) or all days. Expiration time is optional.

• Exit/Error indicates whether the activity instance’s state will change from Expired to 
Finished (Exit) or InError (Error) when the Expiration Time elapses. The default value is 
Error.

Recommended Starting Point Flag
A flag that indicates if the process activity can be used as the starting point for a manually initiated 
process.

Input Paths
The input path or paths to the process activity. A process activity can have zero or more input 
paths. An input path includes a source activity and transition condition.

Source Activity
An input path’s source activity is the proceeding activity in the process.

Transition Condition
An input path’s transition condition is the condition under which the activity can move from its 
source activity. Transition conditions are evaluated when an activity instance’s state is Inactive and 
its source activity instance’s state is Completed. Transition conditions are used to specify 
conditions that must be met for an activity instance’s state to change from Inactive to Running.

Transition conditions are XPath expressions that are evaluated against the Evaluation Data of the 
process version context (see Evaluation Data on page 23-4), or are the literal value TRUE (which 
is the default exit condition). A transition condition of TRUE indicates that once an activity has 
been performed, the process automatically moves to the next activity. For instance, a linear 
process that simply moves from one activity to the next with no branching will not require specific 
transition conditions because there is only one possible path between activities.

Transition Condition Format
Common formats for transition conditions are as follows:

<DATA_ELEMENT>[@<ATTRIBUTE><EXPRESSION><VALUE>]

or

<DATA_ELEMENT><EXPRESSION><VALUE>

Where:

• DATA_ELEMENT is a specific data element defined in the process version context schema. 
If the data element is nested beneath other data elements, it is notated as:

<DATA_ELEMENT1>\<DATA_ELEMENT2>... 
where DATA_ELEMENT2 is nested beneath DATA_ELEMENT1.

• ATTRIBUTE is a specific attribute of the data element defined in the process version context 
schema. Attributes are proceeded by the @ symbol.

• EXPRESSION is a mathematical expression. This must be one of:

• = (equals)
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• > (less than)

• < (greater than)

• >= (greater than or equal to) 

• <= (less than or equal to)

• != (not equal to)

• VALUE is the value against which the transition condition evaluates the corresponding value 
in the process version context.

Note: Transition Condition XPath expressions should be written relative to the 
CONTEXT (root) element in the activity implementation context.

Example:
The first activity in a typical collections process might involve reviewing the current status of the 
customer to determine whether or not the customer is Past Due on their account. If the customer 
is past due, the process moves to the Contact Customer activity. The transition condition for the 
input path to this activity might be as follows:

BILL[@PastDue > 50.00]

If the PastDue attribute of the BILL data element is greater than $50.00, the transition condition is 
TRUE, and the process would start this activity (contact customer). If the process version context 
for the process was as follows:

<CONTEXT Approved=“TRUE”>
<BILL PastDue=‘90.00’/>

</CONTEXT>

the transition condition would evaluate to TRUE. If the value of the PastDue attribute was less 
than $50.00, the transition condition would evaluate to FALSE.

Refer to the Microsoft Developer Network website
 (http://msdn.microsoft.com) for additional information about XPath and valid XPath 
expressions.

Context Maps
Context Maps are optional data mappings between the contexts of activities and processes. These 
determine how data is passed from the context of a process to the individual activities within that 
process, and from the individual activities to the process.

There are two types of context maps, input maps and output maps.

Input Maps
Input maps plot data from the process context to the activity context. Each input map consists of 
one or more items, each of which has FROM and TO expressions.

• FROM: The FROM expression should be either an XPath expression that defines a data 
element or attribute defined in the process version context schema or a literal value enclosed 
in quotes.

• TO: The TO expression should be an XPath expression that defines a data element or 
attribute defined in the activity implementation context schema.

Output Maps
Output maps plot data from the activity context to the process context. Each output map consists 
of one or more items, each of which has FROM and TO expressions.

• FROM: The FROM expression should be either an XPath expression that defines a data 
element or attribute defined in the activity implementation context schema or a literal value 
enclosed in quotes.
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• TO: The TO expression should be an XPath expression that defines a data element or 
attribute defined in the process version context schema.

We recommend that context maps plot the minimal amount of data needed for the process and 
activity, and data that is not likely to change over time. This practice reduces the amount of data 
moving through Workflow Management and reduces the need to alter data used by a process once 
it’s running.

For example, it’s preferable to map only the Account ID, since the Account ID can be used to 
locate other account-related data, and it’s unlikely that an account’s ID will change.

Context Maps Data Types
FROM and TO expressions in both input and output maps can define three types of data: Data 
Elements, Attributes, and Strings. The Data Type Names and examples of how each data type 
might appear in an XML context are provided below.

There are six possible FROM>TO combinations of these three data types. Each combination 
results in a unique data map between contexts, as shown on the table below.

Data Type Data Type Name Example

Data Element Element Text Node Value <ACCOUNTID>123</ACCOUNTID>

Attribute Value <ACCOUNT Id=‘123’/>

String String Value “123”

FROM>TO Combination Data Mapping

Data Element>Data Element The Element Text Node Value (ETNV) of 
the FROM data element becomes the 
ETNV of the TO data element.

Data Element>Attribute The ETNV of the FROM data element 
becomes the value of the TO attribute.

Attribute>Data Element The value of the FROM attribute becomes 
the ETNV of the TO data element.

Attribute>Attribute The value of the FROM attribute becomes 
the value of the TO attribute.

String>Data Element The string value of the FROM string 
becomes the ETNV of the TO data 
element.

String>Attribute The string value of the FROM string 
becomes the value of the TO attribute.
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Context Map Format
Context map expressions can be constructed in any one of the following six formats:

FROM: <DATA_ELEMENT>TO: <DATA_ELEMENT>
FROM: <DATA_ELEMENT>TO: <DATA_ELEMENT>/@<ATTRIBUTE>
FROM: <DATA_ELEMENT>/@<ATTRIBUTE>TO: <DATA_ELEMENT>
FROM: <<DATA_ELEMENT>/@ATTRIBUTE>TO: <DATA_ELEMENT>/@<ATTRIBUTE>
FROM: <STRING>TO: <DATA_ELEMENT>
FROM: <STRING>TO: <DATA_ELEMENT>/@<ATTRIBUTE>

Where:

• DATA_ELEMENT is a specific data element defined in the activity implementation and/or 
process version context schema. If the data element is nested beneath other data elements, it 
is notated as:

<DATA_ELEMENT1>\<DATA_ELEMENT2>... 
where DATA_ELEMENT2 is nested beneath DATA_ELEMENT1.

• ATTRIBUTE is a specific attribute of the data element defined in the activity implementation 
and/or process version context schema. Attributes are proceeded by the appropriate data 
element, followed by a slash (/) and the @ symbol.

• STRING is a literal string value. Note that strings are always enclosed by double quotes (“ ”).

Note: Context Map XPath expressions should be written relative to the 
CONTEXT (root) element in the activity implementation context.

Example
A process activity requires that the Account ID, Past Due Amount, and Arrangement values be 
mapped from the following process context:

<CONTEXT>
<ACCOUNTID>123</ACCOUNTID>
<BILL Amount=‘200.00’ PastDue=‘90.00’/>

</CONTEXT>

to the following activity context.

<CONTEXT>
<ACCOUNT Id=‘123’/>
<PASTDUEAMT>90.00</PASTDUEAMT>
<OTHER Arrangement=‘TRUE’/>

</CONTEXT>

The Account ID is a data element in the process context and an attribute in the activity context, 
the Past Due Amount is an attribute in the process context and a data element in the activity 
context, and Arrangement doesn’t exist in the process context. The following context map could 
be used to properly map the data as required.

FROM: ATTRIBUTEIDTO: ACCOUNT/@ID
FROM: BILL/@PastDueTO: PASTDUEAMNT
FROM: “TRUE”TO: OTHER/@Arrangement

Refer to the Microsoft Developer Network website
 (http://msdn.microsoft.com) for additional information about XPath and valid XPath 
expressions.
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Creating Process Activities
Creating process activities involves five steps.

Step One: Determine the appropriate activity implementation for the process activity.
Determine the appropriate activity implementation for the process activity. Since activity 
implementations are based on specific activities that occur within the process, this involves 
matching the activity in the process with the appropriate activity implementation.

Step Two: Determine the Start Condition, Exit Condition, (optionally) Wait For Flag, and 
Recommended Starting Point Flag for the process activity.

Determine the appropriate Start and Exit Conditions for the activity, if appropriate the specifics of 
the Wait For Flag, and if the activity should be used as a starting point for the process when 
initiated manually.

• Start Condition: The condition under which the activity is started. Should be “ALL” if there 
is only one input path to the activity (or if in the case of multiple input paths, that their 
Transition Conditions must all evaluate to TRUE), and should be “ANY” if there is more 
than one possible input path to the activity (in this case, if the Transition Condition of any of 
the input paths evaluates to TRUE, the activity is started). See Start Condition on page 25-2 
for more information.

• Exit Condition: The condition under which the activity exits and the process moves to the 
next activity. Should be either an XPath expression that can be evaluated against the activity 
context or the literal value TRUE (indicating that once the activity has been performed, that 
activity is completed and the process automatically moves on to the next activity). See Exit 
Condition on page 25-2 for more information.

• Wait For Flag: Should only be set to TRUE if the activity is waiting for a pre-determined 
duration or condition. If set to TRUE, an appropriate Exit/Error value must be supplied. See 
Wait For Flag on page 25-4 for more information.

• Recommended Starting Point Flag: Should only checked if the activity is to be used as the 
starting point for the process when manually initiated.

Step Three: Determine the Input Path(s) for the process activity.
The next step is to determine the appropriate input path (or paths) for the process activity. A 
process activity can have zero or more input paths. An input path includes a source activity and 
transition condition.

• Source Activity: The proceeding activity in the process.

• Transition Condition: The condition under which the activity can transition from the 
source activity to this activity. Should be either an XPath expression that can be evaluated 
against the process context or are the literal value TRUE (indicating that once the activity has 
been performed the process automatically moves on to the next activity). See Input Paths 
Transition Condition on page 25-4 for more information.

Step Four: Create the Context Maps for the process activity.
The next step is to create the context maps for the process activity. These should be based on the 
Required and Evaluation data (see Evaluation Data on page 23-4) needed by the process and 
activities to run properly. Data to be mapped from the process to the activity should be defined in 
the Input Map. Data to be mapped from the activity to the process should be defined in the 
Output Map. See Context Maps on page 25-5 for more information.

Step Five: Create the actual process activity record.
The last step is to create the actual process activity record in the Oracle Utilities Data Repository. 
As described under Process Activity Data on page 25-2, this includes the following:

• Process Version: The process version to which the process activity belongs, from the 
Process Version table.
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• ID: A unique ID of the process activity within the process version.

• Implementation:  The activity implementation associated with the process activity, from the 
Activity Implementation table.

• Start Condition:  The condition under which the activity is started.

• Exit Condition: The condition under which the activity exits and the process moves to the 
next activity.

• Wait For Flag: A flag that indicates that the activity is waiting for a pre-determined duration 
or condition.

• Recommended Starting Point Flag: A flag that indicates that the activity can be used as a 
starting point when the process is manually initiated.

• Input Paths: The input path or paths to the process activity.

• Context Maps: Optional data mappings between the contexts of activities and processes that 
determine how data is passed from the context of a process to the individual activities within 
that process, and from the activities to the process.

Example: Phone Call
Suppose a process includes an activity that involve placing a phone call to the customer to arrange 
a payment for past due charges. The following step-by-step example demonstrates how this 
process activity might be created.

1. Select the appropriate activity implementation for the activity.

Implementation: Phone Call to Customer

2. Select the Start Condition for the activity.

Start Condition: ALL

3. Optional. Set the Wait For Flag as appropriate for the activity.

Wait For Flag: FALSE

4. Optional. Set the Recommend Starting Point as appropriate for the activity.

Recommended Starting Point Flag: FALSE

5. Enter the Exit Condition for the activity.

Exit Condition: CUSTOMER[@Contact= ‘TRUE’]

6. Enter the input path for the activity.

Source Activity: Review Status

Transition Condition: ACCOUNT[@PastDue=‘TRUE’]

7. Create the context maps used by the activity. Keeping to the minimum data required for the 
process and activity, the context maps need to map the Account ID (which in turn will be 
used to obtain other contact information such as the customer’s telephone number) from the 
process to the activity,  and the ‘Contact’ attribute of the CUSTOMER element and the 
‘PastDue’ attribute of the ACCOUNT element from the activity to the process.

Input Map:

FROM: ATTRIBUTEIDTO: ATTRIBUTEID

Output Map:

FROM: CUSTOMER/@ContactTO: CUSTOMER/@Contact
FROM: ACCOUNT/@PastDueTO: ACCOUNT/@PastDue
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Working with Process Activities
You work with process activities using the Workflow Management user interface, accessed from 
the Oracle Utilities Energy Information Platform framework.

How to select and view Process Activity records: 

1. Click Activities on the Build Process Versions screen.

The Process Activities screen opens, displaying the ID and activity implementation of each 
process activity associated with the Process Version.

2. Select the process activity you wish to view from the list. The process activity data for the 
selected record will be displayed.

3. To validate the process version, click Validate. To return the Processes screen, click Process 
Versions.

How to create a new Process Activity record: 

1. Click Activities on the Build Process Versions screen.

The Process Activities screen opens, displaying the ID and activity implementation of each 
process activity associated with the Process Version. If there are no process activities for the 
process version, the screen is blank.

2. Select the activity implementation for the new process activity from the Activity 
Implementations drop-down list.

3. Select the Start Condition for the process activity (All or Any). See Start Condition on page 
25-2 for more information.

4. Enter the Exit Condition for the process activity. See Exit Condition on page 25-2 for 
more information.

5. Optional. Set the Wait For flag for the process activity. See Wait For Flag on page 25-4 for 
more information.

6. Set the Recommended Starting Point flag for the process activity. See Recommended 
Starting Point Flag on page 25-4 for more information.

7. Click New.

The new record appears in the Process Activities window.

8. Enter the Input Path, Input Map, and Output Map for the process activity. Note: This 
step can only be performed if there are two or more process activities.

Input Paths

To add a new input path, click Modify in the Input Paths portion of the screen.

The Input Paths screen opens.

Select the Source Activity Implementation and enter the Transition Condition for 
the input path.

To add another input path to the process activity, click Insert. The new path appears on 
the Input Path screen. Select the Source Activity Implementation and enter the 
Transition Condition for the next input path.

To delete an existing input path, select the input path to delete and click Delete.
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Click Update to save the input paths for the process activity.

See Input Paths on page 25-4 for more information about input paths.

Input/Output Maps

To add a new input/output map, click Modify in the Input Map or Output Map portion 
of the screen (as appropriate).

The Input (or Output) Map screen opens.

Enter a From and To value for the input/output map.

To add another input or output map, click Insert. A new row appears. Enter a From and 
To value for the new map.

To delete an existing input or output map, select the map to delete and click Delete.

Click Update to save the input/output maps for the process activity.

See Context Maps on page 25-5 for more information about input and output maps.

9. Click Update to save the process activity.

10. To validate the process version, click Validate. To return the Processes screen, click Process 
Versions.

How to create a new Process Activity record based on an existing record: 

1. Click Activities on the Build Process Versions screen.

The Process Activities screen opens, displaying the ID and activity implementation of each 
process activity associated with the Process Version.

2. Select the process activity you wish to use as the basis for the new process activity from the 
list. The process activity data for the selected record will be displayed.

3. Click Copy.

The new process activity appears in the Process Activities window.

4. Select the activity implementation for the new process activity from the Activity 
Implementations drop-down list.

5. Select the Start Condition for the new process activity (All or Any). See Start Condition on 
page 25-2 for more information.

6. Enter the Exit Condition for the new process activity. See Exit Condition on page 25-2 for 
more information.

7. Optional. Set the Wait For flag for the new process activity. See Wait For Flag on page 25-4 
for more information.

8. Set the Recommended Starting Point flag for the new process activity. See 
Recommended Starting Point Flag on page 25-4 for more information.

9. Enter the Input Path, Input Map, and Output Map for the new process activity. See How 
to create a new Process Activity Record, p. 5-10 for information about creating and 
deleting Input Paths and Input/Output Maps. 

Note: This step can only be performed if there are two or more process activities.
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10. Click Update.

The new process activity appears in the Process Activities window.

11. To validate the process version, click Validate. To return the Processes screen, click Process 
Versions.

How to update an existing Process Activity record: 

1. Click Activities on the Build Process Versions screen.

The Process Activities screen opens, displaying the ID and activity implementation of each 
process activity associated with the Process Version.

2. Select the process activity you wish to update from the list. The process activity data for the 
selected record will be displayed.

3. Select the appropriate activity implementation for the process activity from the Activity 
Implementations drop-down list.

4. Change the appropriate Start Condition as appropriate for the process activity (All or Any). 
See Start Condition on page 25-2 for more information.

5. Change the appropriate Exit Condition as appropriate for the process activity. See Exit 
Condition on page 25-2 for more information.

6. Optional. Change the Wait For flag as appropriate for the process activity. See Wait For Flag 
on page 25-4 for more information.

7. Set the appropriate Recommended Starting Point flag for the process activity. See 
Recommended Starting Point Flag on page 25-4 for more information.

8. Edit the Input Path, Input Map, and Output Map for the process activity as appropriate. 
See How to create a new Process Activity Record, p. 5-10 for information about creating 
and deleting Input Paths and Input/Output Maps. 

Note: This step can only be performed if there are two or more process activities.

9. Click Update.

The updated process activity appears in the Process Activities window.

10. To validate the process version, click Validate. To return the Processes screen, click Process 
Versions.

How to delete an existing Process Activity record: 

1. Click Activities on the Build Process Versions screen.

The Process Activities screen opens, displaying the ID and activity implementation of each 
process activity associated with the Process Version.

2. Select the process activity you wish to delete from the list. The process activity data for the 
selected record will be displayed.

3. Click Delete.

The deleted process activity no longer appears in the Process Activities window.

4. To validate the process version, click Validate. To return the Processes screen, click Process 
Versions.
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Process Activity API
Workflow Management also provides functions for working with process activities from external 
systems such as a Customer Relationship Management (CRM) application. These functions 
require the following data:

• An XML file that contains data source connection data (user id, password, datasource, and 
qualifier), and

• An XML file that specifies the process activity data itself, as described under Process 
Activity Data on page 25-2.

The Workflow Management user interface automatically supplies this data. When used from an 
external system, the data must be supplied.

Insert  Activity
Creates a new process activity record and inserts it into the Process Activity table in the Oracle 
Utilities Data Repository.

Update Activity
Updates an existing process activity record. 

Delete Activity
Deletes an existing process activity record. 

List Activity
Provides a list of process activity records from those in the Data Repository. This function is most 
often employed through a user-interface (such as the Workflow Management user interface).

Select Activity
Selects a specific process activity record from the Oracle Utilities Data Repository. This function is 
most often employed through a user-interface (such as the Workflow Management user interface), 
and in conjunction with the Update and Delete functions.

See Chapter 24: Workflow Management Process Instance Interface in the Oracle Utilities 
Billing Component Installation and Configuration Guide, Volume 2 for more information about using the 
Process Activity API.
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Chapter 26
Workflow Management Work Queues

This chapter describes how to work with the Workflow Management work queue, including:

• Purpose of the Workflow Management Work Queue

• Working with Work Queues

• Workflow Management Work Queue Message Queue

The Workflow Management Work Queue uses the same messaging system used by Oracle Utilities 
Receivables Component. For more information about the messaging system, refer to Appendix 
C: Messaging in the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2.
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Purpose of the Workflow Management Work Queue
As processes and activities are run by Workflow Management, the system creates messages for a 
number of reasons, such as notifying external systems that a given activity has been performed, 
logging activities for control purposes, or maintaining work queues. These messages are sent to 
specific message queues (based on the specific message type).

The Workflow Management Work Queue can support multiple types of message queues. Message 
queues can be thought of as containers for types of messages related to specific uses, such as input 
messages, output messages, control messages, etc. The system can support any number of 
message queues, but includes a number of default queues as part of the system’s basic 
functionality.
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Working with Work Queues
As noted above, the Work Queues function is used to process work queue items associated with 
processes running in Workflow Management.

Working with the work queue involves the following steps:

• Search for work queue items based on specific criteria,

• View details of work queue (if necessary or desired),

• Select the work queue item(s) to process.

• Select the function you wish to perform (Lock, Unlock, Update, or Close)

Work Queue Functions
There are four main work queue functions available through the Work Queue screen. Some of 
these functions correspond to messaging functions described in Appendix C: Messaging in the 
Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2., including:

• Lock: locks the work queue item to prevent other users from working with it (this 
corresponds to the Hold Message function).

• Unlock: unlocks a previously locked work queue item to allow other users to work with it 
(this corresponds to the Release Message function).

• Update: updates the data associated with the work queue item. This is useful when the 
context of the activity represented by the item must be updated. 

• Close: closes the work queue item (this corresponds to the Close Message function).

How to search for work queue items:

1. Select Financials-›Work Flow-›Work Queue.

The Work Queue screen opens.

2. Enter the search criteria for the work queue items you wish to work with.

You can search by the following criteria:

• Account ID: the account ID associated with the work queue item(s), and

• Work Queue Type: the type of work queues you want to work with,

• Juris: the jurisdiction associated with the work queue item(s),

• Locked User: the User ID of the user closed the work queue item(s), or who currently 
has the item(s) locked.

• Opco: the operating company associated with the work queue item(s),

You can enter search criteria in any or all of the above fields. To start the search based on the 
entered criteria, click Search. To reset the fields, click Reset.

3. A list of work queue items based on the search criteria will appear.

How to work with work queue items:

1. Select the work queue item you wish to work with using the radio buttons in the far left 
column. The activity context of the selected item will appear in the Message Data box. If 
there is a note associated with the item, it will be displayed in the Note box.

To select multiple work queue items, check the checkbox on each item to be selected. To 
select all the work queue items, check the top checkbox, located in the row of headings. If you 
select multiple items, the Data and Note boxes will be blank.

To view a work queue, click the Type link. The Work Queue Item dialog opens displaying the 
selected item.
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2. Click the appropriate function based what you wish to do with the item(s). There are four 
choices:

• Lock: locks the work queue item to prevent other users from working with it, and 
changes the status of the item to ‘Locked’.

• Unlock: unlocks a previously locked work queue item to allow other users to work with 
it, and restores the status to ‘Open’.

• Update: updates the work queue item based on changes made to either the Data or 
Note associated with the work queue item. This function cannot be used with multiple 
work queue items.

• Close: closes the work queue item, and changes the status to ‘Closed’. If the Approved 
checkbox is checked, this function also inserts the Approved attribute into the 
CONTEXT element of the activity context, the value of which is set to TRUE 
(Approved=“TRUE”). The work queue item disappears from the list once it has been 
closed. This function also triggers the Activity Finished function.

3. To process additional work queue items based on the same search criteria, repeat steps 1 and 
2 for each additional work queue item. To process additional work queue items based on 
different criteria, repeat the steps outlined under How to search for work queue items: on 
page 26-3 and repeat steps 1 and 2 above as appropriate.
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Messaging API
Workflow Management uses the Messaging API to provide a number of functions for working 
with work queue items from external systems. These functions require the following data:

• An XML file that contains data source connection data (user id, password, data source, and 
qualifier), and

• An XML file that specifies the work queue item data itself (see Appendix C: Messaging in 
the Oracle Utilities Billing Component Installation and Configuration Guide, Volume 2 for more 
information).

The Workflow Management user interface automatically supplies this data. When used from an 
external system, the data must be supplied.

List Messages
Retrieves a list of messages of a single message type or all the message types associated with the 
LSWFWQ message queue.

Peek Message
Retrieves a single message from a single message queue.

Hold and Release Message
The Hold and Release Message functions support special message functionality required for work 
queues. A user “holds” a message in a work queue to indicate that the work queue item is currently 
being investigated. This prevents two or more people from accidentally working on the same work 
queue item at the same time. A held message can be subsequently “released”.

Update Message
Updates an existing message in a single message queue. This function can only be used on 
message that have been held via the Hold Message function.

Remove Message
This function is identical to the Peek function described above, except that it will also remove the 
returned message from the message queue. This function can only be used on message that has 
been held via the Hold Message function.

See Chapter 21: Messaging Interface in the Oracle Utilities Billing Component Installation and 
Configuration Guide, Volume 2 for more information about using the Messaging API.
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Workflow Management Work Queue Message Queue
The Workflow Management Message Queue is the message queue used by the Workflow 
Management Work Queue. As messages are posted to this queue, they become available to the 
Workflow Management Work Queue.

In order for the Workflow Management Work Queue Message Queue to function properly, a 
number of records must be created in the Message Queue, Message Type, and Message Type 
Queue tables in the Oracle Utilities Data Repository. The specifics of these records are provided 
below.

Message Queue Table
The single record in the Message Queue table specifies the code, type, and name of the Workflow 
Management Work Queue Message Queue. These should be as follows:

• Code: LSWFWQ

• Type: LSDBWF

• Name: WFWQMSG

Message Type Table
Records in the Message Type table define specific message types used by the Workflow 
Management Work Queue. These message types can be user-defined, based on the Activity 
Implementations used in the process. An example record might be as follows:

• Code: PHONE_CALL

• Description: Place phone call to customer

• File Path: Optional

Message Type Queue Table
A record in the Message Type Queue table associates the specific message types used by the 
Workflow Management Work Queue with the Workflow Management Work Queue Message 
Queue. An example record might be as follows:

• Message Type: PHONE_CALL

• Message Queue: LSWFWQ
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Chapter 27
Workflow Management Process Controls

This chapter describes how to work with the Workflow Management process controls including:

• The Purpose of the Workflow Management Process Controls

• Working with Process Controls

• Process Controls API
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The Purpose of the Workflow Management Process Controls
As processes and activities are run by Workflow Management, it may become necessary for users 
to perform a number of functions on specific process and activity instances. For example, a 
process that has been suspended could be resumed or terminated. The Workflow Management 
process controls provide a number of functions that allow users to monitor and maintain process 
and activity instances in Workflow Management, such as:

• List and Select Process Instances,

• Suspend, Resume, Terminate, or Repair Process Instances,

• List, Select, and Repair Activity Instances
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Working with Process Controls
The process controls function is used to monitor and maintain process and activity instances in 
Workflow Management.

The following outlines a number of typical tasks performed using the Workflow Management 
Process Controls. All of these functions are performed using the Workflow Management Process 
Controls user interface.

• Retrieve a list of process instances.

• Select and view specific process instances.

• If a selected process instance is either SUSPENDED or INERROR, users can update the 
process context and Repair the process instance using the Workflow Management Process 
Controls user interface.

• Suspend, Resume, or Terminate process instances as necessary.

• Retrieve a list of activity instances associated with the process instance and select one to work 
on.

• If the activity instance is INERROR, users can update the activity context and Repair the 
activity instance and set its state to INACTIVE using the Workflow Management Process 
Controls user interface. 

Process Controls Functions
There are four main process controls functions available through the Process Controls screen:

• Suspend: used to suspend an existing running process instance.

• Repair: used to update the context of an existing suspended or in error process instance.

• Resume: used to resume an existing suspended process instance.

• Terminate: used to terminate an existing running, suspended or in error process instance.

In addition, the Process Controls screen also provides the following function for use with activity 
instances.

• Repair: used to update the state (to INACTIVE) and context of an existing in error activity 
instance.

How to search for process instances:

1. Select Financials-›Work Flow-›Process Control.

The Process Controls screen opens.

2. Enter the search criteria for the process instance you wish to work with.

You can search by the following criteria:

• Name: Select the name of process instance(s) from the drop-down list.

• Juris: Select the jurisdiction associated with the process instance(s) by clicking the 

Browse button ( ).

• Opco: Select the operating company associated with the process instance(s) by clicking 

the Browse button ( ).

• State: Select the State (RUNNING, SUSPENDED, etc.) of the process instance(s) from 
the drop-down list.

• Major Version: Enter the major version number of the process instance(s).

• Minor Version: Enter the major version number of the process instance(s).
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• Account ID: Enter the account ID associated with the process instance(s) or click the 

Browse button ( ) to search for an account ID.

• To search archived process instances, check the Search Archive checkbox.

You can enter search criteria in any or all of the above fields. See Process Data on page 24-2 
and Process Version Data on page 24-2 for more information about the above data.

3. Click Search. To reset the fields, click Reset.

A list of process instances based on the search criteria will appear on the screen.

How to work with process and activity instances:

1. Select the process instance you wish to work with.

The process context of the selected item will appear in the Process Context box. If there is a 
note associated with the item, it will be displayed in the Note box.

2. Do one of the following, based on the selected process instance:

a. Click Suspend to suspend an existing running process instance.

b. If needed, edit the process context or note, and click Repair to update the context 
of an existing suspended or in error process instance.

c. Click Resume to resume an existing suspended process instance.

d. Click Terminate to terminate an existing running, suspended or in error process 
instance.

5. To view the activity instances associated with the selected process instance, click Details.

The Activity screen opens.

6. Select the activity instance you wish to view, its activity Context, Start Time, and Stop Time 
will appear in the Activity Information box. If necessary or appropriate, make any necessary 
updates/corrections to the activity context.

7. Click Repair to update the activity context based on the changes.
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Process Controls API
Workflow Management also provides a number of functions for working with processes and 
activities from external systems. They require the following data:

• An XML file that contains data source connection data (user id, password, data source, and 
qualifier), and

• An XML file that specifies the process or activity data itself.

The Workflow Management user interface automatically supplies this data. When used from an 
external system, the data must be supplied.

List Process Instances
Provides a list of zero or more process instances in Workflow Management.

Select Process Instance
Selects a specific process instance from those in Workflow Management. This function is most 
often employed through a user-interface (such as the Workflow Management user interface) and in 
conjunction with the Suspend, Resume, Repair and Terminate functions.

Suspend Process Instance
Suspends an existing running process instance.

Resume Process Instance
Resumes an existing suspended process instance.

Terminate Process Instance
Terminates an existing running, suspended or in error process instance.

Repair Process Instance
Updates the context of an existing suspended or in error process instance.This function is most 
often employed through a user-interface (such as the Workflow Management user interface).

List Activity Instances
Provides a list of zero or more activity instances. This function is most often employed through a 
user-interface (such as the Workflow Management user interface).

Select Activity Instance
Selects a specific activity instance. This function is most often employed through a user-interface 
(such as the Workflow Management user interface).

Repair Activity Instance 
Updates the state (to INACTIVE) and context of an existing in error activity instance.

See Chapter 24: Workflow Management Process Instance Interface in the Oracle Utilities 
Billing Component Installation and Configuration Guide, Volume 2 for more information about using the 
Process Controls API.
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